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Foreword

 

How to Start Your Genealogy Project

 

Get the Facts First

 

In compiling your genealogy, you are looking for information—names, dates, relationships and places. You 
can be sure that you had a great-great grandmother, and that she was born and died on specific days. The 
facts are out there. The challenge of genealogy lies in finding them.

There are literally hundreds of sources of genealogical information which can assist you in your 
search, and the facts you discover can lead to exciting, and often unexpected revelations. Sometimes trivial 
details mask profound events which are disclosed by persistent investigation.

 

Now Consider the Source

 

Genealogy engages you in a struggle between the need for uncompromising accuracy and the natural urge 
for unrestrained imagination. Both imagination and accuracy are essential: without imagination, enthusiasm 
wanes; without accuracy, the search flounders on false leads.

It helps to keep one distinction in mind while searching. There are at least two sides to everyone’s per-
sonality—a public and a private side. The private side encompasses life in the home—marriage, family, hob-
bies, reflections, domestic concerns. The public side emerges outside, where everyone wears a slightly 
different face and clothing. Sometimes records of the private and public sides of an ancestor may seem to 
conflict. Together they represent a whole person.

When you cease to be an eye-witness to an event, you must rely heavily on the word of others. The 
people on whose word you rely may not have been eye-witnesses either. The greater the distance between 
you and the information you seek—whether the distance is measured in miles or generations—the greater 
the need to rely on the word of someone else. In each transfer of information lies the opportunity for misin-
terpretation—a typographical error, a conscious exaggeration, an inadvertent slip of the tongue. Always look 
for the possibility of error in any source. Many were never meant to be used for historical research.

Be aware of biases or what a person might want to gain by telling a story one way or another. When 
you spend time interviewing relatives, you need to know what to believe and what not to believe. You are 
asking a member of the family about another member of the family, living or dead. Consider the relationship 
between the two. Wishful thinking or resentment or a failure of memory could color the story. Sometimes 
what is omitted can be of great significance. Family misunderstandings of a deeply-rooted nature can lead to 
the expulsion of an individual from living memory. The tenacity of a genealogical researcher can reestablish 
the presence of these “black sheep” and restore them to the family tree.

Cross check with as many sources as possible. Some written records are more reliable than others, but 
on the surface, this might not be easy to assess. Both public and private sources need to be carefully and crit-
ically evaluated. With written sources, it is important to ask the same questions you would with a living 
source. What were the authors’ motivations? What did they have to gain by writing this story? How did they 
obtain the story in the first place?
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In the case of public records—military records, court records, real estate documents—the person com-
piling them probably had no stake in the information contained therein. Accuracy may not have been the first 
concern. Often, the same is true for local history books. Amateur circuit-riding historians would arrive in a 
community and offer to write a local history. Some are accurate, others aren’t. It is the wise and prudent 
researcher who approaches public documents and historical accounts with a certain degree of caution.

 

A Note on the Slipperiness of Language

 

Whether listening to a story in person or consulting written texts, you are using a continually changing lan-
guage. A word that looks familiar may have a completely different meaning in a 200-year-old document. 
Some words are no longer used. Others have acquired a new meaning. Great care must be exercised to avoid 
misinterpretation.

Remember too, that your family name may have changed with prevailing spelling conventions. The 
name 

 

Smith

 

 may have been spelled 

 

Smyth

 

, 

 

Smythe

 

, 

 

Smeeth

 

, 

 

Smithson

 

, or 

 

Smithington

 

. Ancestors may have 
changed their names to avoid persecution. Quite frequently, the keepers of early church records took liberties 
with spellings, and there was no one to argue with the only literate person within miles.

 

Start With Yourself

 

Compiling your genealogy begins with you. Sit down and list what you know about yourself: name, date of 
birth, names of parents, your place of residence, the important events of your life. Then see what you know 
about your ancestry, Seek every last bit of information about where you have come from and who has pre-
ceded you.

To make sure from the outset that nothing is lost, write everything down. Write it all down. You don’t 
know when you may need it again. Note the source of your information so that if you ever want to go back 
and check a fact, you can check the source at the same time.

 

Home Sources

 

Once you have exhausted the supply of the most readily available information, there will still be holes in the 
pedigree chart and family group sheets. You can take two directions at this point and it doesn’t matter which 
you choose first. You can look for evidence of ancestors in written records and also in the memories of living 
relatives. Shuttle back and forth between the written and the oral, seeking the most—and most accurate—
information available.

The list of possible sources at home is endless. Look for family histories, family bibles, journals, dia-
ries, letters, yearbook and scrapbooks. Other sources include legal papers, financial papers, photographs, and 
even household items.
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Conducting an Interview

 

After picking your brain for facts and while searching your home and the homes of others looking for writ-
ten sources of information, you have an opportunity to sit down and talk with people about the past. In this 
most rewarding part of the genealogical search, you can find out directly from relatives what their life has 
been like and how other people have figured in it.

You are looking for the five Ws—Who, What, Where, When and Why—but you can come back with 
far more. Find out names, dates, places and relationships, and then probe. What familial traditions have dis-
appeared over the years? What do members of the family talk about when they gather for reunions? Be 
patient and resist any temptation to dispute or pass judgment upon anything said.

To record your conversation, take notes or use a tape recorder. Tape is preferable as long as our inter-
viewee doesn’t object, but take along a notebook to record non-verbal messages that may not show up on the 
tape.

 

Moving Out With the Search

 

The resources to draw upon next are genealogical and official records in libraries, archives and repositories 
scattered throughout the world. Start with your public library. There you will find genealogy reference 
books, directories and guides, information about local genealogical and historical societies and other 
research assistance.

The largest genealogical collections are found in libraries maintained by The Church of Jesus Christ of 
Latter-day Saints (LDS Church). While the Family History Library in Salt Lake City, UT is the largest, 
check your telephone directory for a local branch.

 

Enjoy Your Genealogical Pursuit

 

Start with the known and seek the unknown. The methods of the genealogical search are much like those of 
any search. First, you define exactly what you want to know, then design a method for carrying out the 
search. You search, return with data, and then assess whether it is accurate. Once verified, it can fit into the 
framework of what you already know and inspire new searches.

You are looking for as much information about your family as you can find, in as many places as you 
can find it. In the process, you’ll encounter pitfalls and dead-ends, but care and accuracy will decrease the 
number of detours. Sometimes picking a path through the past may sound like traipsing through a berry 
patch. That is in fact exactly what it is: a sticky search with steady rewards along the way.
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Welcome to Ultimate Family Tree™ and the exciting world of multimedia genealogy. Genealogy is th
suit of knowledge about our past. It’s a way to look at our families in order to better understand ourse
With Ultimate Family Tree, you can view the past in ways never dreamed possible by your ancestors

You can store and display video and audio recordings, pictures, drawings, and scans of importa
uments. You can create and organize slide shows with descriptions and music, and play them back o
computer screen. You can even scan your own photos directly into Ultimate Family Tree, edit, and m
them. Taking advantage of Object Linking and Embedding (OLE), Ultimate Family Tree provides nea
limitless possibilities for multimedia presentations.

Ultimate Family Tree’s easy-to-use data entry screens, Instant Web Page Publisher, spell check
online capabilities are firsts for any genealogy software. Using Ultimate Family Tree, you can docum
events in each individual’s life by drawing from a library of approximately 200 predefined events or by
ating your own. Fundamental information for each person is entered through Ultimate Family Tree’s p
ful Individual Record window.

The online functions provided by Ultimate Family Tree are its most exciting feature. It’s possible
connect directly to the program’s exclusive website and converse with research experts, download us
genealogical information, and upload your own family history web page.

Soon you will be entering your own information, creating beautiful journals, and experiencing th
voices and pictures of loved family members.
1
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Help is Always at your Fingertips

 

Ultimate Family Tree provides the following help:

• The 

 

Ultimate Family Tree User’s Guide

 

• The Ultimate Family Tree Web Site 

 

http://www.uftree.com

 

• Online Help—an online reference guide that includes context sensitive help, extensive cross referenc-
ing, troubleshooting assistance, a guide to error messages, answers to frequently asked questions, and 
a glossary.

If you have questions about any aspects of the program, follow these steps:

1. Check the Table of Contents or the Index of the 

 

Ultimate Family Tree User’s Guide

 

 for the subject you 
need help with, or from the Ultimate Family Tree menu, choose Help followed by Help Topics. In the 
resulting window, locate on-screen information about your topic.

2. See “Troubleshooting” in Appendix A and online Help for answers to common problems.

If you need assistance with Windows, please contact Microsoft Corporation or consult your 

 

Microsoft 
Windows User’s Guide

 

.
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Getting Ready to Install

 

System Requirements

 

Ultimate Family Tree is a Windows program designed for systems having an 80386SX or more powerful 
computer and 8 MB or more Random Access Memory (RAM). You need at least 20 MB of free hard disk 
space before installing Ultimate Family Tree. The files supplied with the program require approximately 15 
MB of hard disk space. An additional 5 MB of disk space is required (approximately 2.5 MB for data and 2.5 
MB for temporary work space) for every 1000 individuals you add. The program can use a TWAIN-compat-
ible device such as a scanner, a sound card, and other multimedia features. Additional hard disk space may 
be required to use multimedia features fully. A modem is required to use the “Go Online” feature.

 

Make sure you have everything you need

 

Your Ultimate Family Tree package should include:

 

• Ultimate Family Tree User’s Guide

 

• Registration card

• CD-ROM disk

 

Customer Registration

 

Fill out and mail the enclosed registration card immediately. This card qualifies you to receive notification of 
upgrades.

 

Installing Ultimate Family Tree

 

Ultimate Family Tree can be installed as a separate program or as an update to ROOTS IV, Visual ROOTS, 
or Family Gathering. If you use any of these programs, you need to decide whether to install Ultimate Fam-
ily Tree as an update or in a separate directory. If you have no other ROOTS or Family Gathering program, 
simply follow the installation instructions below. If, however, you are using one of these programs, we rec-
ommend that you install Ultimate Family Tree as an update.

If you choose to install Ultimate Family Tree as an update to Visual ROOTS, the program files for 
Visual ROOTS will be deleted after Ultimate Family Tree has been installed; however, all data files will 
remain intact. You can proceed to use Ultimate Family Tree without additional considerations.

If you install Ultimate Family Tree as an update to ROOTS IV, the Ultimate Family Tree library files 
will be installed in the same directory as the ROOTS IV library files, resulting in two sets of library files. 
When you install Ultimate Family Tree as an update to ROOTS IV, the ROOTS IV program files are deleted, 
the data files remain intact, and the library files retain their ROOTS IV names. If you start a new project, you 
have the option of choosing to create an Ultimate Family Tree or ROOTS IV project. If you choose to create 
a new Ultimate Family Tree project, the Ultimate Family Tree library files are used. If you choose to create a 
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ROOTS IV project, your existing ROOTS IV libraries, containing the places and sources entered in 
ROOTS IV, are used. If you have been using ROOTS III or another genealogy software program, you
import your ROOTS III or GEDCOM file, and the Ultimate Family Tree library files are used.

If you are currently using ROOTS IV and want to have only one set of library files, you should in
Ultimate Family Tree in a separate directory, create Event GEDCOM files of your existing data, and i
them directly into Ultimate Family Tree.

Note  ROOTS IV library files are named X_PLBOOK.*, X_SOBOOK.*, X_ELBOOK.*, and so o
ROOTS V, Visual ROOTS, Family Gathering, and Ultimate Family Tree library files are named 
V_PLBOOK.*, V_SOBOOK.*, V_ELBOOK.*, and so on.

Note  When creating a new ROOTS IV project, Ultimate Family Tree looks for ROOTS IV libra
files in the \ROOTS4\LIBRARY directory. If the ROOTS IV library files are located in a directory 
other than \ROOTS4\LIBRARY, you cannot create a new project using those files in Ultimate Fa
Tree. If you want to continue to use ROOTS IV library files for new projects and ROOTS IV is 
installed in a directory other than ROOTS4, install Ultimate Family Tree as a standard installatio
not as an update to ROOTS IV.

Installation Instructions
To install Ultimate Family Tree as a new program or as an update to Visual ROOTS or Family Gather
follow these steps:

Note  If you have any problems with the installation, see “Installation Troubleshooting” on 
page 203. Please ensure that you have disabled all virus scanning software, screen savers, an
other software which may interfere with the installation.

1. Start Windows

2. Insert the CD-ROM in your CD drive.

3. If you are running Windows 3.x, choose File from the Program Manager, and then Run. If you are 
ning Windows 95, choose Start, and then Run from the task bar.

4. Type d:\setup (substitute the correct drive letter for your own CD-ROM drive). Click OK.

5. The Ultimate Family Tree install program begins. It is strongly recommended that you close all 
ning Windows applications before proceeding. Click Cancel to stop the setup program and clos
running applications or click Next to continue.

6.  The Setup program will search for installed components of Visual ROOTS, ROOTS IV, or Fami
Gathering. The installation program will ask you if you want to update an existing program or in
Ultimate Family Tree in a new directory.

7. Click Yes to update the program or No to install Ultimate Family Tree as a separate program.

Note If you install Ultimate Family Tree as an update to ROOTS IV, Visual ROOTS, or Family G
ering, the program files for those programs will be deleted after Ultimate Family Tree has been 
cessfully installed.
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8. If you chose No, the default directory is C:\UFT. Click Browse to specify a different directory.

Note If you specify a directory that doesn’t exist, a message appears stating that fact. Click Ye
continue the installation. Do not specify a directory which contains ROOTS IV, Family Gathering, 
Ultimate Family Tree, or Visual ROOTS unless you chose one of the update options in the prev
window. If you do, Ultimate Family Tree will not be installed as an update to that program. The pro
gram files for the existing program will remain after Ultimate Family Tree has been successfully
installed. No data files will be overwritten; however, important control files for the other program
be overwritten.

9. Choose one of the following options and click Next:

• Typical — Installs the program plus the Kennedy sample project.

• Minimum — Installs Ultimate Family Tree and library files without the Kennedy sample project.

• Custom — Allows you to install selected files. The Custom option should be used for reinstallation

10. You are prompted to select a program folder or group. The default is genealogy. You may enter a folder 
or group name and click Next.

11. Setup tells you that it has enough information to start copying files from the CD-ROM. Click Ne
continue. Setup installs Ultimate Family Tree, Ultimate Family Tree Gateway, Family Album Ma
Records Requester, the Gazetteer, and Browser Setup.

Note If you need to go back to a previous step for any reason, click Back to return.

12. If you are installing over a previous version of Family Gathering or Ultimate Family Tree, the ins
program will ask you whether you wish to retain or copy over the following:

• Existing Spell Checker files

• Existing Event Choice lists

• Existing report configurations

• Existing Task Lists

• Existing right mouse setups

Note  If previous REVENT, Spell Checker, or Event Choice files are found, you are prompted 
install new files or use existing ones. If you have added words to the Spelling Dictionary, added
REVENT data in ROOTS IV, or added new event types in Visual ROOTS or Ultimate Family Tree
not install the newer files.

Warning Answering no will replace these files with program default files, and you will lose any 
changes you may have made. Before reinstalling over a previously installed version of Family G
ing or Ultimate Family Tree, please read “Reinstalling Ultimate Family Tree” on page 6.

Once all of the files have been updated or installed, the Readme file, containing up-to-date infor
not included in the manual, is displayed.

13. Close the Readme file and click Finish to end the installation.
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14. In the new Genealogy Program Group, up to six icons are created, depending on the installatio
options you chose and the operating system you are using.

• Browser Setup — Identifies a browser for Ultimate Family Tree.

• Ultimate Family Tree — Starts Ultimate Family Tree.

• Kennedy Sample — Starts Ultimate Family Tree with the sample Kennedy project.

• Uninstall Ultimate Family Tree — In Windows 3.x, an additional icon is created to uninstall Ultimat
Family Tree from your system. In Windows 95, Uninstall is located in the Control Panel under A
Remove Programs. Note that Uninstall cannot remove any files created or modified after install
such as Project or Library files.

• Ultimate Family Tree Editor — Opens the powerful Windows word processor supplied with Ultima
Family Tree.

• Readme file — Opens a text file with last-minute information not available when the manual was cre

On-Line Guide and Browser Setup
In order to use the on-line features of Ultimate Family Tree, you need to run the Browser Setup progr
installed with Ultimate Family Tree. Browser Setup looks for an existing browser on your system and 
configures Ultimate Family Tree to use this browser, or lets you install the Netscape browser from the
mate Family Tree CD-ROM. Browser Setup will not change your browser configuration in any way.

To use Browser Setup, exit Ultimate Family Tree and follow the Browser Setup instructions in th
Line Guide included separately in the Ultimate Family Tree box.

Reinstalling Ultimate Family Tree
To reinstall Ultimate Family Tree, follow these steps.

1. Start Windows.

2. Insert the CD-ROM in your CD drive. 

3. If you’re running Windows 3.x, choose File from the Program Manager, and then Run. If you’re ru
ning Windows 95, choose Start, and then Run from the task bar.

4. Type d:\setup (substitute the correct drive letter for your own CD-ROM drive). Click OK.

5. In the Welcome dialog, read the information and click Next.

6. Setup will search for installed components and display a message if an existing Ultimate Famil
installation is found. Click OK.

Note  The directory in which the Ultimate Family Tree executable file was found is displayed in
Destination Directory box. Click Browse to change to another directory.

7. Three installation options are available. Select Custom and click Next. 
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8. Deselect the options you do not want reinstalled with Ultimate Family Tree.

9. Highlight Ultimate Family Tree by clicking once on the program name. Notice that the Change b
turns from gray to black. Click Change to select the modules of Ultimate Family Tree that you w
reinstall.

Note  If you have added your own images, do not select Image Libraries. Choosing Program F
and Printing Support Files reinstalls program files only and will not affect any data files. If you h
added your own images, places, or sources, do not select the image libraries, place libraries, or
libraries. Intstalling these options will destroy your data by installing default libraries.

Creating an Ultimate Family Tree Icon in Windows 95
In Windows 95, Ultimate Family Tree can be accessed from the Start, Programs list. If you want to cre
Ultimate Family Tree icon on the Windows 95 Desktop, follow these steps:

1. Click the right mouse button on the Desktop.

2. Choose New.

3. Choose Shortcut.

4. Click Browse.

5. Change to the \UFT directory and choose UFTREE (UFTREE.EXE).

6. Click Open. UFTREE.EXE appears in the Command line.

7. Click Next.

8. Type Ultimate Family Tree in the name field and click Finish.

Starting Ultimate Family Tree
Before starting Ultimate Family Tree you should be familiar with Microsoft Windows, have Ultimate Fa
Tree installed on your computer, and have your printer correctly installed and configured under Windo
your printer is not set up, consult your Windows manual for assistance.

To start Ultimate Family Tree, follow these steps:

1. Start Windows.

2. Open the Genealogy program group (or whichever group or folder in which you installed Ultima
Family Tree).
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3. Double-click the Ultimate Family Tree icon. If you are starting Ultimate Family Tree for the first ti
the Ultimate Family Tree Title window appears, followed by the Welcome window with a messag
stating Ultimate Family Tree did not find a project. You are offered the following options:

• New — Begins a new project

• Open — Opens an existing Ultimate Family Tree project

• Exit — Leaves Ultimate Family Tree

Ultimate Family Tree Desktop Display
Ultimate Family Tree provides two styles for desktop display. They are Graphics and Windows Colors
Graphics provides wallpaper on the desktop and windows. Windows Colors establishes desktop and w
colors from the Windows Control Panel. If your monitor is set to 16 colors, the Windows Colors are us

Using the graphics display can reduce the performance of the program. If you suspect that Ultim
Family Tree is running more slowly than it should, refer to page 196 for instructions on how to switch 
Windows color mode. Choose the colors option for Ultimate Family Tree according to your personal p
ence and system performance.

Note The illustrations in this User’s Guide use the Windows Colors option to display screen sh

Figure 1-1: Welcome Window
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Figure 1-2: Ultimate Family Tree with Graphics Desktop Display

Open Miscellaneous,
Medical, and Multimedia
windows

Go to top of event list

Move up one event

Move down one event

Go to bottom of event list

Figure 1-3: Ultimate Family Tree with Windows Colors Desktop Display

Click to edit event text

Click to edit event evidence
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Creating a new project
To start a new project in Ultimate Family Tree, follow these steps:

1. In the Welcome Window or from the File menu, choose New.

2. In the File Type list, select Ultimate Family Tree and choose Open.

3. In the File Name field, type a file name (up to eight characters) for the new project.

4. Select the drive and directory for the new project. Typically, it’s \UFT\PROJECTS. The current d
tory name appears above the directory list box.

Note Do not save to a floppy disk. Be sure you have sufficient disk space on the hard drive be
starting a new project. You need at least 2.5 MB of free disk space and 2.5 storage space for ev
1,000 individuals.

Figure 1-4: New File Window

Figure 1-5: Save As Dialog Box

Type project name

File list

Path to file
Save file

Directory list

Drive list
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5. Choose OK. The Project has now been created and the Project Information window is displaye

Note To open the Project Information window at any time, choose Project Info from the File m

6. Enter a short description of the project, such as a family name, on the Description line. The desc
appears on the title bar of the Ultimate Family Tree window.

7. Enter the name of the principal researcher for this project in the Researcher Field. This field is 
optional, but you can have the researcher’s name appear in the footer on printed reports by typ
name here and choosing Preparer in the Page Setup window. See the note below.

8. Enter the address of the researcher. This information can be included in the footer with the pre
name, if you want. You might include “Prepared by:” before the name to have the footer of your
reports printed in this way.

Note To print the relationship of the preparer on Family Group reports when Preparer Info is 
checked, enter the Researcher’s record number in the Researcher # field. For a new project, en
Individual Record for the preparer and then return here by choosing Project Info from the File m

9. Key Families is a list of surnames in the project arranged in the order of frequency of occurrenc
mate Family Tree keeps track of the number of times each surname is encountered and display
the right of the name. This field is blank for a new project. Choose the Update button to update th
Families surname list. When new individuals have been entered into Ultimate Family Tree, choo
Update to get a new count of the surnames.

10. The Comments box displays the source of the data used in this project, including import method
and time. Enter general information about the project in this box.

Figure 1-6: Project Information Window

The date the project 
was last edited

Update Key Family list

Path to the Project
Control file

Version number of project

Version number of
Ultimate Family Tree
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11. Choose OK to close the window and save changes. The Individual Record window appears and
ready to begin.

To open an existing project, follow these steps:

1. From the Menu Bar, choose File.

2. Choose Open.

3. In the File Type drop-down list, select Ultimate Family Tree Project.

4. Select the drive and directory of the existing project. Select \UFT\SAMPLE directory if you wan
Kennedy sample project, or the \UFT\PROJECTS directory if you’ve already converted or saved
project that you’d like to open.

5. Make sure that the proper drive, directory, and subdirectory appear above the directory list box

6. Select the project filename to be opened (for example, KENNEDY.PRO).

7. Choose Open. The Individual Record window appears and is ready to accept information abou
individual.

See Section 8 for information on importing GEDCOM and ROOTS III files.

Getting Familiar with Ultimate Family Tree
You can use a mouse or keystrokes to execute commands in Ultimate Family Tree menus and windo
use the mouse, position the pointer over a desired option and press the left mouse button. If a select
required, double-click the left mouse button. To use the keyboard, press the Tab or reverse Tab (Shif
keys to position the selection bar. If a selection is required, press Enter or the appropriate shortcut ke

Figure 1-7: Open Dialog Box

Path to file
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Menu Bar
The Menu Bar contains a list of words extending across the main window. It provides easy access to
aspects of the program.

To view a menu, click once on the menu name. A menu drops down under the menu name. You can 
the keyboard to display menus. There are two keyboard methods:

• Press the Alt key to activate the menu bar and then use the right or left arrow keys to move acro
bar to the menu name you want. Press the down arrow key to open the menu.

• Press the Alt key followed by the underlined letter in the menu name.

A similar approach is used to choose options within each menu. Use one of the following options:

• Press the left mouse button

• Press Alt plus the underlined letter

• Press the combination of shortcut keys indicated next to an option

Note At certain times during operation of the program, some menu selections are not available
short menu appears. When the short menu bar is displayed, the Toolbar is not active.

The menu items access a wide range of functions. For a description of each menu item, see On
Help.

Function and Shortcut Keys
Several of the keyboard function keys help you enter data more efficiently. Others are used to move 
down lists, to find people or places, and to access context-sensitive help. In combination with the Shift
the Control (Ctrl) key, the function keys perform a wide variety of additional tasks.

Shortcut keys are a combination of the Ctrl or the Alt key with a letter key. Similar to the function
keys, these specialized key strokes facilitate many essential tasks, such as copy, paste, build, and he

Here are helpful and frequently used keyboard shortcuts:

• F5 — To view an Individual Record, highlight a person’s name anywhere in the program and pres

• F8 — To open the Events window for an event, select the event and press F8 or choose the num
button to the left of the event name.

• F9 — To save data in a window, press F9, or in an Individual Record click the Save button on th
Toolbar.

Figure 1-8: Menu Bar

Title bar
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• F10 — To find an individual, press F10. Type in that person’s record number or first few letters o
name and choose Find to display the full name. Choose OK.

See the back of the Ultimate Family Tree User’s Guide for a list of function and shortcut keys.

Toolbar
Below the Menu Bar is the Toolbar. It contains a set of buttons and icons that you click to perform sp
functions. These functions are also accessible from the Menu Bar, but the Toolbar provides a shortcu
use a mouse. The Toolbar is not active when the short Menu Bar is displayed.

You can turn the Toolbar on and off, and you can disable the balloon (command description) hel
ciated with each Toolbar button. See page 196 for instructions.

The arrow buttons on the Toolbar serve two functions. They are used to move up and down lists
opened from the View menu. They are also used to change from one individual to another in windows
the Find button is active. You can move to the previous, the next, the first or last person in the project
next person is determined by the order in which you last selected and viewed an individual list. If the
individual list you opened resulted from a search, the focus will change to those individuals in the sea

Reserved Characters
The following characters are reserved for use by Ultimate Family Tree and must be considered when
ing data:

• / — Used to mark surnames. On ROOTS III import, the pipe symbol (|) is substituted for extra for
slash characters in names. Do not use the forward slash character in names except to mark the
ning and end of the surname.

• # — The number sign is used in role sentence codes. Do not use the number sign in name, even
place, or date fields.

• { } — Used to mark a title in a person’s name. Can be used in other fields, subject to the restric
under Rich Text Format listed in the next section, “Rich Text Format Printing.”

Figure 1-9: Toolbar
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Rich Text Format Printing
Rich Text Format (RTF) is a data exchange format developed by Microsoft to allow formatted text to b
moved from one application to another. Fonts, underlining, index information, footnotes, and most oth
mat instructions are preserved.

• \  — Used for control codes in RTF files. Do not use the backslash character in Ultimate Family T
you will be using the RTF feature.

• { } — Used for control codes in RTF files. Do not use the left or right brace character (except to 
a title in a name) if you will be using the RTF feature.

International Characters
If your keyboard does not have the accented keys you want for special characters, position the curso
location where you want the character to appear. Hold down the Alt key and use the numeric keypad
the three-digit ASCII number for the character, or copy and paste the character from the Windows Ch
Map. Ultimate Family Tree uses the MS Sans Serif font in name fields. Use the Arial font setting in th
dows Character Map. See your Windows manual for help with Character Map.

Quick Start Tutorial
The Quick Start Tutorial is designed to help you learn how to perform the following tasks:

✓ Add a new individual

✓ Add parents

✓ Create a birth event

✓ Create a marriage event and add a spouse

✓ Create other events such as a graduation

✓ Create a divorce or an engagement event

✓ Move around the Individual Record window

✓ Add evidence and text

✓ Add a child

✓ Add a sibling

✓ View a family in a Family Tree (Pedigree) window

✓ View an individual

For additional hints and tips, see “Did You Know?” on page 23.



1 6 SE C T I O N 1 : I N T R O D U C T I O N

the-
re 

ages, 
o the 

vents.

he 
ber.

the 

le, 

elect 

 win-
Creating an Individual Record
All information about an individual is entered in the Individual Record window. This is a simple, fill-in-
blanks screen where an individual’s name, sex, parents, spouse, children, siblings, and life’s events a
entered, as well as any text and footnotes for that person.

Other windows are for medical information, miscellaneous information such as nationality, langu
aliases, and social security numbers. A media window is used to attach images or audio recordings t
record for the individual.

In the following exercise, you’ll add a new individual and parents, and create birth and marriage e

Creating a new record for yourself
1. If this is a new project, the Individual Record window displays record number 1. If not, choose t

New Individual button to display a new Individual Record window with the next available record num

2. In the Name field, type your full name given at birth. Ultimate Family Tree automatically marks 
surname with slash (/) characters.

3. See Section 2, page 29 for more information on entering names which include titles.

4. Tab to the Sex field. Type M, F, or U. Alternatively, you can press the down arrow and select Ma
Female, or Unknown from the drop-down list.

5. Tab to the Living field. Type Y(es), N(o) or U(nknown). Alternatively, you can use the mouse to s
one of these options from the drop-down list.

Note Use the mouse or the Tab key to move forward from field to field in the Individual Record
dow. Shift+Tab moves you in the opposite direction.

Figure 1-10: Individual Record Window

Click to edit event

Surnames
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by program

Create a new
individual
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individual record

Open event window
(add new event)
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Adding parents
1. Tab to the Father field and type the name of your father.

2. Tab to the Mother field and type the name of your mother.

If you enter a full name in either the Parents or the Spouse fields for an individual that has alread
entered into Ultimate Family Tree, a message appears when the window is being saved stating that th
has already been entered. If it is a different person, choose New. If the person has already been ente
light the person’s name and choose List to link that individual. If you want to make changes, choose C
to return to the Individual Record window.

To edit the parents records, choose the associated button to the right of the parent name. ChooFa to 
edit the father’s record. Choose Ma to edit the mother’s record.

Creating a birth event
1. Tab to the Birth event date field.

2. Type your birth date using any format you want. See Section 8, page 195 for information on se
date preferences.

3. Tab to the Place field and type the place of birth.

Note You can select an event name and press F8 or click the numbered button to the left of the
name to open the Events window where you can enter more detailed information. See page 30
more information on the Events window.

Creating a marriage event and adding a spouse
1. If your spouse is not yet in the project, choose the New Spouse button to create a new Individu

Record along with a marriage record. If a marriage event has not yet been created for your paren
are given the option to add one now.

2. A new Individual Record opens. Type the name of your spouse in the Name field.

3. Press Tab to move to the date field of the newly created marriage event and type the date on w
marriage took place.

4. Tab to the Place field and type the location of the marriage.

5. Click the “S” button to the right of the spouse’s name field to return to your Individual Record.

Creating other events
1. Choose the New Event button to add another event. The Events window opens.

2. Select any event from the list. To scroll the list, use the down arrow on the scroll bar or type the
letter of the event you want to move to.
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3. With the event highlighted, type the free-form date in the Date field. The structured and sort date
are automatically calculated and entered when you Tab out of the Free-form date field.

4. Tab to the Place field and type the place name where the event occurred.

5. When certain events are created, an event detail line becomes available. For example, in the c
graduation, the detail is the institution or school from which you graduated. Type the detail infor
tion in the event detail line and press Enter. A marriage or divorce type event activates the Spou
where you can enter the name of the other individual linked to this event.

These events use the Event Detail field:

6. Choose OK to return to the Individual Record window.

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code

Figure 1-11: Events Window
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Adding Evidence, Text, and Other Information
1. Practice using the Tab key to move around the Individual Record window. Notice the context-se

help that appears at the bottom of your Ultimate Family Tree window as you move from field to 

Note Use the buttons to the right of the Events list to move up or down the list. An individual ca
have a virtually unlimited number of events recorded for his or her life. Next to the Place field in
Events list are two columns of status boxes for Event Text and Event Evidence. An X in the statu
indicates Text, Evidence, or both are present.

2. Select the Birth event you created for yourself and click the Text Status box to open a window w
you can type free-form notes about this event. Up to 65,000 characters of text can be entered h
Type a few words and choose OK to save the data and close the text window. An X shows that 
present for this event.

3. Choose the Event Evidence Status box to open a window where you can enter evidence to sup
event, such as a birth certificate. See page 40 for information about entering sources.

4. Choose the Text and Evidence buttons to type notes about an individual (up to 65,000 characte
attach evidence documenting your knowledge of that individual. The Individual Text and Individu
Evidence buttons work the same way as the Event Text and Event Evidence Status boxes.

5. Choose the More button to open an Individual More window and then choose Miscellaneous to
the Miscellaneous Individual Information window. Record miscellaneous information about your
Type your Social Security number in the last field and choose OK to close the window.

6. Choose the More button, and then Medical to open the Medical History window in which you ca
enter physical details and medical conditions. Choose a medical condition to open a second wi
where you can type up to 65,000 characters of information about that condition. Choose OK an
return to the original Medical History window. Type your weight, height, and hair and eye color in
Physical characteristics group. Choose OK.

7. Choose the More button, and then Media to open the Multimedia Link window where you can a
and display or play image or audio recording files linked to an individual. See Section 7 for infor
tion about adding and linking Media.

8. Choose Cancel to close the Multimedia Link window and return to the Individual Record window

Figure 1-12: Individual More Window

Open Miscellaneous Individual
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Open Medical History window

Open Multimedia Link window
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Adding a Child
The Children box lists all children of the selected individual.

1. Add a child by choosing the New Child button at the bottom of your Individual Record window.

2. In the Parent window, specify the name of the other parent and choose Selected. A new Individ
Record window opens with the child’s surname already entered and the parent’s names in the M
and Father fields.

Note If the correct parent is not listed in the Other Parent window, choose None. A new Individ
Record window opens. Enter the correct parent (if known) in the Father or Mother field.

3. Type your child’s given name before the surname in the name field and complete the rest of the
mation.

Adding a Sibling
The Siblings window lists all siblings of the subject, including half-siblings.

1. From a child’s Individual Record window choose the New Sibling button to add a brother or sist
new Individual Record window opens for your child’s brother or sister with the sibling’s surname
already entered, along with your name and your spouse’s name in the parent fields.

2. Complete the sibling’s name field and the rest of the Individual Record.

Note To use the Sibling button on the Individual Record, you must have entered a parent. If yo
not know the parents for a group of siblings, enter a name for the father or mother in one of the 
fields. For example, for an individual named John Smith, you could enter a father or mother named 
Unknown /Smith/, or (-----) /Smith/.

You have just entered three generations of individuals in your project and familiarized yourself w
the Individual Record window. Now you can view your data.

Figure 1-13: Other Parent Window

Choose to specify a
parent in the list
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Viewing Ancestors in the Family Tree (Pedigree) Window
1. From the View menu, choose Family Tree to leave the Individual Record window and open the F

Tree window, which is also known as a Pedigree chart.

2. Click the Find Individual button on the Toolbar or press the Find Key (F10) to open the Find indiv
window. Type the number 1 and press Enter (or choose Find) to find your name. Choose OK.

The Family Tree window opens with your name in the focus position with generation 1 displ
beneath it. You can view up to five generations of a family at once. Your children are listed at the
left and, if you have entered any of your siblings, they are listed at the bottom left. A plus (+) sig
the left of a name in the Child or Sibling window means that this person has descendants.

The generation number changes depending on the generation of the focus person in relatio
original starting person displayed at the upper left of the Family Tree window.

3. Double-click your name in the upper-left corner of the window to bring yourself back to the focu
position. Choose Close to close the window.

Viewing a Family Group
1. From the View menu, choose Family Group. The husband and his parents (if known) are displa

the top, the wife and her parents are displayed in the center, and their children appear at the bo
the window.

Figure 1-14: Family Tree (Pedigree) Window
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2. To change the focus of the window, choose the Parents button to move your parents into the H
and Wife fields. Select a child in the Child list box and choose the Child button to change the fo
that child.

3. Select your name and choose Close to close the window.

Viewing an Individual Summary
1. From the View menu, choose Individual Summary to view all the information recorded about you

This window can be sized smaller or larger for ease of reading.

Note Event details are displayed twice when viewing an Individual Summary. Because the Ind
ual Summary shows a summary of all the information entered for an event, it displays the text th
be printed in the report as well as the basic data entered in the detail field. For this reason, you

Figure 1-15: Family Group Window

View parent’s Family GroupView any additional spouses

Number of children

Figure 1-16: Individual Summary Window
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view the more extensive event information that can be entered into ROOTS IV and then access
Ultimate Family Tree. What you see as a duplicate detail on the computer screen will not print in
report.

2. Scroll through the text to review the information that you entered.

3. Close the window by choosing the Close box or by pressing Escape.

If you have entered data for your family during this tutorial session, you can now add to it. If you
would like to delete this tutorial project and start anew, follow the steps in the next section.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window opens with this message, ARE YOU 

SURE? ### records will be PERMANENTLY deleted if you choose OK.

2. Choose OK.

3. Another window appears with this message: ARE YOU SURE? This project will be PERMANENTLY
erased if you choose OK. Choose OK.

Did You Know?
There are some important features and short cuts built into Ultimate Family Tree designed to make e
your data easy. Read through this section for a description of some of these features. See “Frequent
Questions” on page 206 for answers to common questions.

Go Menu
The Go menu has two functions. It gives you the ability to move through lists and to quickly return to 
recently edited records. Choose Go Top to move to the first person in the project. Choose Go Bottom
move to the last person. Choose Up or Down to move to the next person in the list. The person’s pos
the list is determined by the order in which you last selected and viewed an individual list. If the last lis
opened resulted from a search, the focus will change to those individuals in the search list.

Figure 1-17: Delete Project Warning
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Up to ten individual names are displayed in the Go List. Each time you open an Individual Recor
name of that individual is moved to the top of the list. From the Go menu, choose any name in the lis
return to that individual’s record.

The New Spouse Button
To enter a new spouse for an individual, choose the New Spouse button. An Individual Record windo
opens allowing you to enter the name and other information for the new spouse. You can return to th
spouse by choosing the “S” button to the right of the name on the Spouse field or by selecting the nam
the Go menu. The marriage information can be entered in either record.

If the spouse is already in the project, choose New Event rather than New Spouse. Select Marr
from the list and type part of the name in the Spouse field. Choose Find to open the Candidate Indivi
list with individuals whose names begin with the letters you typed in the list. Select the name and cho
OK. If you type the complete name instead of choosing Find, a message appears when you save the
asking if the person is an existing person from the list. If so, choose List. If it is a new person, choose

Text and Evidence Status Boxes
Event text and evidence can be added in the Events window or in the Individual Record window. Two
umns to the right of the Event Place field in the Individual Record window contain Text and Evidence 
boxes. Click the Text or Evidence status box to open the associated window. An X in the status box indicates
that data is present.

Choose the numbered button next to an event name to open the Events window where you can
the Text or Evidence button to enter additional information.

Using Undo
If you choose the New Individual, New Spouse, New Child or New Sibling button and decide not to c
the new record, choose Undo from the Edit menu to delete the record and return to the previous reco

Note Undo is not available if the record has been saved. As you enter information, the record 
saved automatically. To delete a saved record, from the File menu, choose Delete Record.

Date Preferences
You can specify the date format for the free-form date field. Set your preference to have dates displa
print exactly as you’ve entered them or set a date format default such as 12 JUL 1943.

From the Utilities menu, choose Desktop Preferences, and then Miscellaneous. Scroll through th
options and select the format you want. If you select any option other than “As entered,” modifiers wi
converted to full words in the free-form date field, such as ABT to about. Dates entered before select
date preference are unchanged.
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Graphics Display
Ultimate Family Tree provides two styles for desktop display, Graphics and Windows Colors. The gra
mode can reduce the performance of the program. If you suspect that Ultimate Family Tree is runnin
slowly than it should, switch to the Windows color mode.

From the Utilities menu, choose Desktop Preferences and then Miscellaneous. Choose Use Wi
colors and “none” in the Wallpaper drop-down list to change to Windows colors. Restart Ultimate Fam
Tree to complete the change.

When you open certain window while in the graphics mode, the message, “Picture colors may b
incorrect. Do you wish to use Windows Colors?” may appear. Choose No to ignore the message and
the window. Choose Yes to change the desktop display to Windows Colors. Exit and then restart Ultim
Family Tree to change to Windows colors. This message will appear if your graphics monitor is set to
colors. If your monitor is set to 16 colors, the Windows Colors are used.

Editing Place Names
If you want to edit or combine place names, create a new Individual Record for a temporary person. 
“an unknown location” on the birth event field and choose the Find button. A list of all places in the P
Library is displayed. Scroll throughout the list to find place records you want to edit. Highlight a place 
and choose OK. Edit the place name and press F9, or choose the Save button on the Toolbar or Save
File menu. A message appears stating that the place name has been changed. Choose OK to save th
change. Because the Place Library is common to all projects, changing the spelling will change it glo
throughout the open project and all other projects.

To edit another place, highlight the place name in the Individual Record and press the Del (Dele
on your keyboard. Press F9 to save and then choose the Find button to reopen the Place List. Selec
place from the list.

Note See pages 192 for information on combining duplicate place names.

When you have completed editing the place names, from the File menu, choose Delete Record
delete this temporary record from the project.

Finding Individuals
There are several ways to find new subjects for the Individual Record window besides using the Find
vidual window. If you select the main name field in the Individual Record window and choose the Fin
ton, a list of all individual in the project opens. The list is alphabetical by given name. Press any letter
keyboard to move to the given names in the list which start with that letter. Select a name and choose
change to that person’s record.

You can also choose a name from the Individual List. From the View menu, choose Individual L
and then by Surname. Scroll through the list and double-click the left mouse button on a name to ope
Individual Record for that person.

From the Go menu, choose any name to move to that person Individual Record. Up to ten of th
individuals edited are displayed in the Go list.

See page 80 for information on using the Find Individual window.
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Using Existing Records for Parent and Spouse Fields
If you enter a full name in either the Parents or the Spouse fields for an individual that has already be
entered into Ultimate Family Tree, a message appears when the window is being saved stating that th
has already been entered. If it is a different person, choose New. If the person has already been ente
light the person’s name and choose List to link that individual. If you want to make changes, choose C
to return to the Individual Record window.
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If you completed the Quick Start Tutorial, you know that information about an individual is entered in 
Individual Record window. This is a simple, fill-in-the-blanks screen where an individual’s name, sex,
ents, spouse, children, siblings, and events are entered, as well as any text and footnotes for that pe

The Individual Record window also provides an easy way to navigate through your family from 
ents to children or children to parents. Because of it’s importance, the Individual Record window is al
on the desktop. It can be minimized to remove it from the desktop when desired.

Additional windows are provided for medical information and miscellaneous information such a
nationality, languages, aliases and social security number. A media window can be opened for attach
images and audio recordings.

In this section you will learn how to:

✓ Enter an individual’s name, sex, parents, spouse, children, and siblings

✓ Enter events and places for an individual

✓ Enter evidence to support your information

✓ Record family stories and anecdotes

✓ Enter miscellaneous information such as aliases, religion, nationality, and more

✓ Enter addresses for creating Mail Labels

✓ Enter medical information about an individual

✓ Display pictures and sound connected to a person or a family
2 7
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✓ Create a Marriage Record

✓ Delete a person’s record, an event, and a place

✓ Create or edit a source and footnote

For hints and tips, see “Did You Know?” on page 23.

Creating an Individual Record
Follow these steps to create an Individual Record:

1. If you are in another window, choose Individual Record from the Build menu or by pressing F5 o
keyboard. You can also use these methods:

• Choose the Individual Record button on the Toolbar.

• Select the Individual Record window (if it is displayed behind an open window).

• Double-click a name in a View list.

• Select a name from the Go menu.

2. Choose the New Individual button to display a new record with the next available record numbe
you do not want to save this new record, choose Undo from the Edit menu. You will be returned
last selected individual.)

Figure 2-1: Individual Record Window

Enter event date

Enter event location

Add new
individual

Add new
spouse

Add new
child

Add new
sibling

Add new
event

Click to open misc,
medical, and
media windows

Click to edit or add
text about individual

Click to edit or add
evidence for
individual
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Use the Tab key to move forward from field to field and Shift + Tab to move in the opposite direc
Don’t use the Enter key because its primary function is to choose a selected command button or othe
selected item.

Note Many buttons in the Individual Record window have an underlined letter in their title. Hold
down the Alt key and type that letter to move to the associated field or choose the associated b
Once you have opened a record, you can enter a person’s information.

1. Type the person’s complete name. The name can include given names, surname, and title in an
Ultimate Family Tree marks the last name entered as the surname by enclosing it with slash (/) 
ters. If you enter names in a different order, you can manually enter the slash (/) characters. If a
is longer than 52 characters, enter a shortened version here and enter a name of up to 65,000 c
in the Long Name text box opened from the Miscellaneous window. See page 48.

Note Mark a title by enclosing it with left and right braces { } to distinguish it from a surname, f
example, John /Smith/ {Jr.} or Jane /Smith/, {Ph.D.}. The slashes and curly braces do not appear on
printed reports. To remove them from the displayed names on any Ultimate Family Tree window
except the Individual Record window, select No Slashes in the Name Format window (see page
Use only one set of slash characters in the name field.

2. Tab to the next field and enter the sex of the individual. Type F, M, or U or press the down arrow
select Male, Female, or Unknown from the drop-down list.

3. At the Living field, type Y, N, or U to indicate whether or not the individual is still living. Using the
mouse, you can click the down arrow and select from the drop-down list. If a death event is ente
this field is automatically set to N when you save the record. This field is optional.

A record number is automatically assigned when a new record is created. You can also choose
own record number (any number between 1 and 9999999). Ultimate Family Tree checks to make sur
number is not already in use before accepting it.

Adding Parents
1. Tab to the Father field and type the father’s name. If the father is already in the project, type the

few letters of his name (or simply highlight -unknown-) and choose the Find button. From the Cand
date Individual’s list, select the correct individual and choose OK.

Note The Candidate Individuals list shows individuals in alphabetical order by first name. The 
and death years (if known) and the record number for the selected individual are displayed at th
tom of the window. For two or more individuals with identical names, check the record number, 
and death dates to be sure you have selected the correct person.

2. Repeat the step above for the Mother field.

To edit the parents records, choose the associated button to the right of the parent name. ChooFa to 
edit the father’s record. Choose Mo to edit the mother’s record.

If you enter a full name in the Parent field for an individual that has already been entered into Ult
Family Tree, a message appears when the window is being saved stating that this name has already
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entered. If it is a different person, choose New. If the person has already been entered, highlight the p
name and choose List to link that individual. If you want to make changes, choose Cancel to return to
Individual Record window.

Adding Events
Events are added from the Individual Record window.

1. Choose the New Event button or click the numbered button to the left of an Event field labeled “
in the Individual Record window. Events are listed alphabetically, with the most common events
talized so they appear first in the list.

2. Highlight an event name to select.

Ultimate Family Tree provides hundreds of event types, including ethnic and religious events fro
which to choose. The definition of the event and the person’s role are displayed. Click the Source bu
display the source for a selected event. Create a new event type by clicking New. (See page 33.) You
delete a selected event type by highlighting it and clicking the Delete button in the Event box. Basic e
types such as Birth, Marriage, Death, and Burial cannot be deleted. The Restore button restores pre
deleted event types. The information in the role field changes as you scroll through the events.

To delete an event (or unlink it from the individual), open the Events window for the event and ch
the Delete button under the OK and Cancel buttons on the right.

Dates
1. Enter a free-form date in the date field.

Figure 2-2: Events Window

Role for event

Role definition

Event being Event definition
edited

Enter event date

Event place

Event detail
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2. Tab to the next field and confirm the results in the Structured and Sort date fields.

When you move to any other field after entering a free-form date, the Structured and Sort Date 
are automatically calculated and entered. If you enter only the year in the Free-form or Structured fie
Ultimate Family Tree sets the Sort date to July 1 of that year. If you enter only the month and year, th
date uses the 15th as the day. The Sort date does not print in reports.

You can enter dates in a variety of ways:

• Free-form Date — The Free-form Date field permits the date of an event to be entered exactly a
was found in the original source. This field will accept partial or incomplete dates, date modifiers
date ranges in any order.

When typing a free-form date, do not use the number sign (#) in the date field because the n
sign is used internally in Ultimate Family Tree sentence codes. See Section 8, page 195 for info
tion on setting date preferences.

• Structured Date — Ultimate Family Tree converts the date you enter in the Free-form date field in
several components: a date modifier such as BEF (before), AFT (after), CA (Circa), the day, the 
(three-letter abbreviation such as JAN), and the year in the Structured Date field and the Sort D
field. The structured date is used in reports, such as the Pedigree, where space is limited.

• The Sort Date — The sort date, used by the program to establish the order of events, doesn’t app
reports. Use the sort date to order events where you don’t know the dates but you do know the 
for example, the birth order of children.

If you do not know a date for an event such as a birth, but you do know the birth order of so
one’s children, you can enter an approximate date for the individuals in the Sort Date field. It is i
tant to note that the order of events will be proper but no dates will appear for this event in repo
because only a sort date has been entered. Enter a full date (MM/DD/YYYY) in the Sort Date fi

You can edit the structured and sort dates created by Ultimate Family Tree without affectin
free-form date you’ve entered. However, revising and then exiting a free-form date field resets t
structured and sort dates. Dates entered as text (thirteenth) instead of numbers (13) are not co
to the Structured Date or Sort Date fields. In this case, you must manually enter the day in the S
tured Date field. It is then reflected in the Sort Date field.

• Unusual Dates — Because the free-form date field accepts any variation of a date, you can hand
uations that would otherwise be impossible. For example, you can enter Quaker or Jewish date
can also record dates that are normally outside the range of Ultimate Family Tree. Dates must 
between the limits of 100 AD to 3000 AD to be properly sorted. You can, however, record BC dat
dates following any other calendar system, in the free-form date field. If you want to record BC 
establish the order of events by using a fictitious year in the sort date field that is within the norm
limits of 100 AD to 3000 AD. If you choose the year 100 for BC dates, 365 separate BC dates c
entered and ordered properly by assigning each BC date to a unique sort date (for example, 01
0100 through 12/31/0100). Using this technique, the order of events occurring before the year 1
be established.

• Double Dating — If you encounter dates prior to 1752, double years such as 1725/26 might be l
This double dating results from an alteration to the calendar. In 1582 it was found that the Julian c
dar, which had begun with Julius Caesar, was inaccurate by 11 minutes and 14 seconds a year a
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to the cycle of the sun and moon. In 1582 Pope Gregory XIII corrected the discrepancy. The ca
lost ten days as the Pope decreed that October 4 would be followed by October 15.

Countries accepted the new Gregorian calendar at different times, and England and the Am
colonies did not do so until 1752. By then the discrepancy between the Julian and Gregorian ca
was 11 days. This difference was compounded by the celebration of two New Year’s days by En
and its colonies. The government celebrated New Year’s on March 25, and the masses celebra
holiday on January 1. Depending upon which calendar you used and when you celebrated New
Day, there would be a difference in dating. To satisfy both conventions–until 1752 when the Jan
New Year’s celebration was made official–double dates sometimes were recorded.

You can enter the double date year in the Free-form date field. The double date will print o
reports, such as the Genealogy report. The Structured date will display the second year in the d
date and will print on structured reports such as the Family Group Report.

Adding a Place
1. To enter a place for an event, Tab to the place field, type the first few letters of the place, and c

the Find button if the place you want is already in your project. If the place is not already in you
project, type the entire place name.

Up to 60 characters can be typed for a place name. A place name of that length will not dis
entirely in the place field unless you scroll to the right. However, the entire place name will print
text reports such as Family Journal (Genealogy), Text Descendant and Ahnentafel reports. In s
tured reports where space is limited, such as the Family Tree (Pedigree) and Family Group rep
long place name is abbreviated.

Note The number sign (#) is used in Ultimate Family Tree role sentence codes. Do not use the
ber sign in Ultimate Family Tree place fields.

Removing a Place from an Event
1. To remove a place from an event, highlight the entire place name.

2. Press the Del (Delete) key on your keyboard, or type a new place name.

3. If you type a new place name, you’ll get a message when saving the record stating what the ev
place was and what it is now. You are asked if these places are the same. If you are just chang
spelling of the name, choose Yes. If you want to create a new place, choose No.

Editing a Place Name
To change the spelling of a place name, highlight the place name in the place name field in the Indiv
Record window and type the correct place name. Choose Save from the File menu or press F9 to sa
spelling change. A window opens stating what the event place was and what it is now. Choose Yes to
the name. For additional information, see page 25.
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Event Details
You can add important details to some events.

When you choose one of these events from the Event Choice list, the event detail line, directly 
the place field, becomes available. Type the detail, such as the name of the cemetery for the burial e
this field. Use up to 32 characters.

Do not use the number sign (#) in Ultimate Family Tree event detail fields as it is used internally
creating role sentences. Instead, use No., Number, etc. to include a building or apartment number.

Deleting Event Types
You can delete event types from the list if you want. Deleting Event Types from the list allows you to sh
the list to include only those event types that you use on a regular basis. Basic event types such as B
Marriage, Death, and Burial cannot be deleted.

1. Choose the New Event button in the Individual Record window.

2. Highlight the event type in the Event Choices List.

3. Choose the Delete button in the Event box.

Note If you want to restore all event types, click Restore. Deleting an event from the list does 
affect existing events you have already entered.

4. Choose Cancel to return to the Individual Record without creating a new event for the individua

Creating a New Event Type
1. To create a new event type, choose New Event in the Individual Record.

2. Choose New in the Events window.

Event Detail

burial cemetery

graduation and education events institution or school

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code
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3. In the New Event Type window, type the name for an event, the name or abbreviations that you w
appear on reports, and the role that the individual plays in this new event.

4. Add a GEDCOM tag for the event and the role. Use any name you want, usually four or five upp
characters, that will be used if you transfer this data via GEDCOM. If the name you choose for 
event tag is already in use as a GEDCOM tag, you cannot use it. Try another.

Note You can create your own event and role tags for export when Event GEDCOM is selecte
When creating your own tags, start the GEDCOM tag with an underline character, for example,
_MEMSER for an event called Memorial Service. The GEDCOM tag should be somewhat descr
of the event or role. See pages xx for more information about GEDCOM.

5. Complete the sentence in the Verb box: First name _______ place date. If you are creating a m
service event, for instance, enter the words “was memorialized” on the blank field in the Verb box
role sentence might then read “Mickey was memorialized in Windsor, California, May 1, 1996.”

6. Complete all fields in the window.

Marriages
You can create a marriage by choosing the New Spouse button in the Individual Record window, or b
choosing New Event. In both cases, a marriage event is added.

When you choose the New Spouse button, a new Individual Record opens where you enter a n
spouse. If you choose the New Event button, the Events window opens where you can choose Marria
the Events list. In this case, a spouse field appears. The Spouse field is used for engagement, pre-n
agreement, marriage, domestic partnership, annulment, separation, and divorce events. The label fo
Spouse field depends on the event and the sex of the individual whose record you’re entering.

Some of the spouse titles include:

• Fiancee or Fiancé for engagement and pre-marriage events

Figure 2-3: New Event Type Window

Type event name

Create your own
GEDCOM tags

Create a sentence
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• Bride or Groom for marriage events

• Divorcee or Divorcé for divorce events

• Husband or Wife for LDS sealing of spouse, Get (Jewish religious divorce), and separation event

• Partner1 or Partner2 for a domestic partnership event

• Man or Woman for an annulment

• Novio or Novia for diligencias matrimoniales, matrimonio and velacion (Hispanic marriage event

Creating a New Marriage Record
Follow these steps to create a new marriage event.

1. Choose the New Event button in the Individual Record window.

2. Select Marriage from the Event list.

3. Enter the free-form date.

4. Tab to the place field and enter a place name. If the place has already been entered, type a par
name (or simply highlight an unknown location) and choose the Find button to open the Candid
Places list. Highlight the place name you want to enter for the event and choose OK.

5. Type the spouse’s name in the Spouse field. If the spouse is already in your project, enter a pa
name (or simply highlight -unknown-) and choose the Find button to open the Candidate Individ
list. Highlight the name and choose OK.

Note If you enter a full name in the Spouse field for an individual that has already been entere
Ultimate Family Tree, a message appears when the Individual Record is being saved stating th
name has already been entered. If it is a different person, choose New. If the person has alread
entered, highlight the person’s name and choose List to link that individual. If you want to make
changes, choose Cancel to return to the Individual Record window.

Adding Text for an Individual or Event
You can add text for every individual and event. To add text for an individual, choose the Text button 
upper right corner of the Individual Record window. To enter text for a specific event, click the Event T
status box to the right of the event. Alternatively, you can click the numbered button to the left of the e
name to open the Events window and choose the Text button. Enter up to 65,000 characters in any fr
text field. Many reports can include individual and event text. See page 14 for information on reserve
acters that should not be used when entering text.

Choose the option you want:

• Text or Biographical — Text Prints in the body of free-form reports.
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• Footnote — Prints selected text as a footnote in reports. The selected text is displayed in the Te
dow, but will print only as a footnote.

• Research Notes — Records information about past, ongoing, or future research on this event or i
vidual.

• Underline, Bold, and/or Italics — Formats selected portions of text in reports. Highlight the text an
then choose a format.

Do not use the following characters in text with the Rich Text Format (RTF) feature:

• \ — Do not use the backslash character in Ultimate Family Tree if you will be using the RTF fea

• { } — Do not use the left or right curly brace character in Ultimate Family Tree (except to mark a
in a name) if you will be using the RTF feature.

See page 85 for information on using the RTF feature.

International Characters
If your keyboard does not have the accented keys you want for special characters, position the curso
location where you want the character to appear. Hold down the Alt key and use the numeric keypad
the three-digit ASCII number for the character, or copy and paste the character from the Windows Ch
Map. Ultimate Family Tree uses the MS Sans Serif font in name fields. Use the Arial font setting in th
dows Character Map. See your Windows manual for help with Character Map.

Figure 2-4: Event Text Edit Window
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Text Formatting
Use the font style options to instruct Ultimate Family Tree how to display and print the text in reports.
familiarizing yourself with the formatting codes available, you can use the font style buttons or you ca
the codes in the text windows. Formatting codes are displayed in text windows, but are not printed in 

Automatic word wrap occurs at the end of lines unless the Enter key is used to end a line. Blan
are preserved in Ultimate Family Tree reports. Press the Space Bar once at the beginning of a new pa
to indent the first line.

The formatting codes appear around the selected text:

[BO:This text is bold.:BO] This text is bold.
[UL:This text is underlined.:UL] This text is underlined.
[IT:This text is italicized.:IT] This text is italicized.

How to Select Text
You can use the mouse or the keyboard to select text. To use the mouse:

1. Position the mouse cursor over the first character to be selected.

2. Press the left mouse button and hold it while dragging the mouse across the text to be selected

3. Release the left mouse button.

To use the keyboard:

1. Position the cursor under the first character to be selected.

2. Press and hold the Shift key. Press the Right Arrow key until the text is selected.

3. Release the Shift key.

Checking Spelling
The Spell Check feature includes a dictionary of 140,000 words and 10,000 proper names. You can c
spelling in Edit Text windows and all text data fields.

1. To check spelling in an editable window, choose the Spell button, choose Spell Check from the
menu, or press Ctrl+B.

2. If Spell Check does not find a misspelled word, the Spell Check window does not open. When 
Check finds a word that is not included in its dictionary, the word is highlighted and displayed in
Word In Context box. Highlighted words are shown in lowercase letters but are saved as shown
Replace With Word field.

3. A list of closely matched words is displayed in the Possible Spellings box. If the word you want t
is in the list, select the word and choose Replace.

4. To edit the misspelled word, choose Edit. After editing, choose Replace.

5. To stop checking spelling and return to the Edit window, choose Done.
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The following is a list of options in the Spell Check window:

• Add — Adds the word in the Replace With Word field to the dictionary.

• Done — Ends the spelling check.

• Edit — Allows you to edit the misspelled word.

• Ignore — Ignores the current misspelled word.

• Ignore All — Ignores the current misspelled word and continues to check spelling. The word is 
ignored during the rest of the spelling check.

• Look-Up — Checks the spelling of the current text in the Replace With Word field.

• Possible Spellings — Displays the closest matching words.

• Replace — Replaces the misspelled word with the current text in the Replace With Word field.

• Replace All — Replaces all occurrences of the misspelled word.

• Suggest more words — Updates the Possible Spellings list box with more suggested words.

• Undo — Reverses the last Replace or Replace All command.

Figure 2-5: Spell Check Window

Ignore misspelled
(or unrecognized) word

Replace misspelled word

Edit missplelled word

Replace all occurances
of misspelled word

Add word (or name)
to dictionary

Undo last command
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Importing an External Text File
You can import external ASCII text files (up to 65,000 characters in size) into any Ultimate Family Tre
window. The text should not contain any control codes, such as those found in word processor files. See 

1. Open any Ultimate Family Tree text window by choosing the appropriate Text button.

2. Choose Import.

3. Change to the drive and directory that contains the text file you want to import.

4. Highlight the file and choose Open.

5. From the Edit menu, choose Select All (or highlight selected text).

6. From the Edit menu, choose Copy.

7. Close the external text file by choosing the Close box (or press Escape).

8. Click the left mouse button in the Text window where you want to insert the text.

9. From the Edit menu, choose Paste.

10. Choose OK to close the window and save changes.

Exporting Text
To transfer text to an external text file, use the clipboard. The following method describes how to crea
external text file and copy text from any Ultimate Family Tree text window to this file.

1. Open any text window in Ultimate Family Tree.

2. Select the text you want to export. See page 37 for instructions on selecting text.

3. From the Edit menu choose Copy (or press Ctrl+C).

Figure 2-6: Open Dialog Box

Select file

Verify drive and
directory
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4. Choose OK to close the Text Edit window.

5. From the File menu, choose New.

6. Select Text from the Type list.

7. Choose Open.

8. Enter the file name with a .TXT extension in the File Name field.

9. Select the drive and directory where you want to place the text file.

10. Choose OK to open the new external text file.

11. From the Edit menu choose Paste (or press Ctrl+V).

12. Choose the Close box to close the file.

13. Choose Yes when closing the text file if you want to save it.

Event Evidence
The Evidence window, accessed from the Individual Record and Events windows, provides tools to e
and organize evidence used as proof for information contained in an Ultimate Family Tree project. Ev
can include formal source citations and free-form notes.

Figure 2-7: Evidence Window
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Create footnote
from source
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Source Record
The same sources can be used many times in a genealogical project. The source, once entered, is s
the Source Library. Often, however, additional information, such as a page number, is unique in spec
dence. A source that might require additional text makes the Text button available. The additional info
tion must be entered as text. The purpose for this text, originally established by the source type, is sh
the Edit Text window.

A source can be entered into the Source Library either before you add it to an Evidence window
while you are in the Evidence window. Follow these steps to create a source from the Build menu.

1. From the Build menu, choose Source Record.

2. Choose New.

3. Select a template from the 47 templates provided in the Source Types list. The Source Type He
at the right side of the window provides a description of the template you select. Choose OK.

4. Type Abbreviation 1 and 2 names for the type of source you’re entering. Abbreviation 1 is used
identify the source in lists. Enter a unique Abbreviation 1 so that the source is easily identifiable
lists. If you must create a duplicate Abbreviation 1, be aware of it when you add sources to evid
windows.

5. Choose the first component (by double-clicking, or highlighting and pressing Enter) and enter t
information about that component in the Component Contents box. Do not add ending punctua
because it is added automatically when the report is printed.

6. Repeat step 5 for the remaining component lines.

Figure 2-8: New Souce Type Window

Sample of selected
source type

List of source types
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Note Enter ending punctuation (if desired) in the Main Text component field only for the Free-f
Text source type.

7. After completing the components, choose Preview to see how your source will look when it’s pr
Look for source components that are incomplete or that need further editing. Make any correcti
you want in the associated Source Component field.

8. Choose Close to close the Preview window.

9. Choose OK to save the source and to close the Source Record window, or choose New to crea
another new source.

Adding Evidence
To enter Evidence for an Individual, choose the Evidence button in the Individual Record window. To 
evidence for an event, click the Evidence status box on the appropriate event line or click the numbe
ton to the left of the event name and choose the Evidence button in the Events window.

You can create new structured or free-form sources. Existing sources can be also be accessed
ing the Find/Add Structured Source button. The Footnote button creates a footnote from the source i
tion you have entered. Use the Edit Source button in the Evidence window to make editing changes 
existing source.

To add an existing source to the Evidence window, choose the Structured button in the Find/Ad
Source group in the Evidence window. The Add Evidence window opens.

1. Scroll through the list of sources to find the correct source, select it, and choose OK. The selec
source is displayed in the Source Type list.

Figure 2-9: Add Evidence Window

Select a source
from the list
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2. Choose Text in the Edit group (if available) to open the Edit Text window, and then enter the ap
ate data, such as the specific page number you want to cite for this proof.

Note Do not type ending punctuation because it is added automatically when the reports are p

3. Choose OK to close the Edit Text window and return to the Evidence window.

4. Repeat the previous procedure to add additional sources of evidence for proof.

5. Choose the Footnote button to create a footnote.

Creating a New Source from the Evidence Window
Sources can also be entered into the Source Library directly through the Evidence window.

1. From the Evidence window, choose the Structured button in the Add New Source group to crea
new source and add it to the Evidence window.

2. Select a source type. If the source type you want is not in the list, choose the source type, Free
text. Source Type Help is displayed to the right of the Source Type list.

3. Choose OK.

4. Type the Abbreviation 1 and Abbreviation 2 names. Help for the type you have selected is displa
the Help for Type box.

5. Choose the first component (by double-clicking, or highlighting and pressing Enter) and type th
information about that component in the Component Contents box. Do not add ending punctuat
the component lines because it is added automatically when the report is printed.

Figure 2-10: New Souce Type Window

Selected source type

Description and sample
of selected source
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6. Repeat step 5 for the remaining component lines.

Note Enter ending punctuation (if desired) in the Main Text component field only for the Free-f
Text source type.

7. Choose OK.

8. Choose Text in the Edit group (if available) to open the Edit Text window, and then enter the ap
ate data, such as the specific page number you want to cite for this proof (for example, page 29
not type ending punctuation.

9. Choose OK to close the Text window and return to the Evidence window.

10. Repeat the above procedure to add additional sources of evidence to the Evidence List for the 

11. Choose the Footnote button to create a footnote.

Creating Free Notes
Use Free Notes as evidence in a proof.

1. To add a Free Note to the Source List, choose the Free-form button in the Evidence window.

2. Enter the Free Note in the Edit Text window and use formatting buttons if desired.

Note Ultimate Family Tree does not add ending punctuation to Free Notes. Add ending punctu
to the Free Note, if desired.

3. Choose OK to save any text entered and return to the Evidence window.

Creating Footnotes
Evidence that is formatted as a footnote will appear as End Notes. Evidence that has not been forma
footnote will not appear in reports.

1. In the Individual Record window, choose the Evidence button for the individual or Evidence Sta
box for an event.

2. After adding a source, choose the Footnote button in the Save/Build group to create a footnote

Note The footnote appears in the Footnote box. You can customize the footnote for printing if n
sary. See “Customizing a Footnote.”

3. Choose OK to save and close the Evidence window.

Customizing a Footnote
Customizing footnotes is not necessary, but you might want to rearrange footnotes for printing.

1. Create a footnote. See “Adding Evidence” on page 42.

2. Edit the footnote as follows:
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• Enclose each Source or Free Note in your footnote in code brackets, for example, [FR: :FR] or 
[SO#: :SO]. The pound symbol (#) represents the record number of the evidence for that sourc

• Do not change formatting inside the SO: source code brackets. When Ultimate Family Tree prints a
footnote, it reconstructs the footnote from the sources in the Source Library and from Free Note
text added to sources. Changes made within the source or Free Note code brackets in the Foot
window are not reflected in the Source Library record or the Added Text window, and will not be
included in end note reports.

Formatting is added automatically to text within the source code brackets according to the s
template in use. You can, however, manually customize the formatting in a footnote outside the 
code brackets by typing the format codes before and after the appropriate text. For example:

[BO:This text is bold.:BO] This text is bold.
[UL:This text is underlined.:UL] This text is underlined.
[IT:This text is italicized.:IT] This text is italicized.

You can also add information to a source listing that is unique to a specific piece of evidenc
example, a page number in a document. Type this text outside the source code brackets, for ex

[SO12:Harvey Rachlin, [IT:The Kennedy’s, A Chronological History:IT] (New York, NY: Ballantin
Books, 1986),:SO] page 43.

You can Cut and Paste text inside the footnote to customize the way it displays and prints, a
as you move sources and free notes with their codes.

3. Choose OK to save your changes and close the Evidence window, or choose Cancel to close t
dence window without saving changes.

Figure 2-11: Evidence Window

Add a Free Note
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footnote will print
(without codes)

Format a footnote
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Editing a Source from the Evidence Window
To edit an existing source from the Evidence window, select the source and choose the Source butto
Edit group.

Note Any changes made to the source record will affect all footnotes using this source.

Deleting a Source from the Evidence Window
1. From the Source List in the Evidence window, select the source to be removed for an individua

event.

2. Choose Selected in the Delete group, or choose All to delete all evidence.

3. Choose Proceed to delete the source and footnote reference (if present), or choose Cancel to 
the Evidence window without deleting the source.

Adding Children
The Children window lists all children of the subject.

1. In the Individual Record window, double-click the left mouse button on an individual’s name to m
that person the focus of the Individual Record window. If you want to make a parent or spouse 
focus, choose the appropriate button to the right of their name.

2. To enter a new child for a selected individual, choose the New Child button.

3. In the Parent window, select the other parent for this child. Choose Selected. A new Individual R
window opens for that child with the child’s surname already entered in the name field and the c
parents (if known) already in the Mother and Father fields. Type the remaining information. If yo
choose not to create this new record, choose Undo from the Edit menu. You will be returned to t
selected individual. If the other parent is not listed, choose Cancel or None in the Parent window

Figure 2-12: Other Parent Window

Click to choose other
parent from list
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new Individual Record window opens showing the parent. Enter the other parent in the appropr
parent field.

Note To maintain proper text alignment, the text in the Parent window appears in a different fo

Adoption
Ultimate Family Tree provides ways to indicate that a child is adopted. Begin by entering the adoptive
ents as the Father and Mother in the child’s Individual Record window. You then can add an adoption
for the child with information concerning the birth parents (if known), or the adoption itself, in the Eve
Text window. Another method to indicate adoption is simply to use the Miscellaneous window to add 
“adopted” flag for the child.

Children of Unmarried Parents
A marriage is not required to connect parents to their children. In addition, you can enter one parent 
other parent is not known. When reports print for these families, no mention of the unmarried status i
printed (unless you use the Unmarried event or include the information in the Individual or Event Tex
dows).

Adding Siblings
The Siblings window lists all siblings and half-siblings of the subject.

1. From the Individual Record window, add a brother or sister for that person by choosing the New
ling button. A new Individual Record window opens for a brother or sister with the sibling’s surn
already entered, along with parent names.

2. Complete the sibling’s name field and the rest of the Individual Record. If you choose not to crea
new record, choose Undo from the Edit menu. You will be returned to the last selected individua

To use the Sibling button on the Individual Record, you must enter a parent. If you do not know
parents for a group of siblings, enter a name for the father or mother in one of the parent fields. For ex
for an individual named John Smith, you could enter a father or mother named Unknown /Smith/, or (-----) 
/Smith/.

Additional Information
Ultimate Family Tree provides a way to add additional information for an individual. In the Individual 
Record window, choose the More button to open the Individual More window. A green indicator next 
button shows if information is already present.
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1. Choose Miscellaneous to open the Miscellaneous Individual Information window where you can
record information such as aliases, nationality, languages, individual flags, ancestor and desce
interest levels, and Social Security number.

2. Choose Medical to open the Medical History window where you can enter information about the
vidual’s physical characteristics (height, weight, skin, eyes, hair, etc.) as well as any known med
conditions.

3. Choose Media to attach images or audio from the Multimedia Library to the individual you’re ed

Miscellaneous Individual Information
Ultimate Family Tree provides a way to add miscellaneous information for an individual. In the Individ
Record window, choose the More button, and then choose Miscellaneous to open the Miscellaneous
ual Information window.

Figure 2-13: Individual More Window

Open the Miscellaneous
Individual Information window

Open the Medical History window

Open the Multimedia window

Figure 2-14: Miscellaneous Individual Information Window

Open a long name
text window

Open a mail
list/label window

Alias names

User-defined flags
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• Long Name — Opens a text window for entering a name of up to 65,000 characters for the selec
individual. The long name is not displayed in Build or View windows, but is used in Family Journ
(Genealogy) reports. Remember to use slash characters (/) to define the surname and curly bra
to define a title.

• Mail Label — Opens the Mail Label window where you can enter an address of up to 34 characte
line and a telephone number for the individual. You can specify mailings such as a newsletter to
to this person. See pages 126 for more information about printing mailing labels.

• Interest Level — Optional Ancestor and Descendent Interest levels are required in Tiny-Tafel rep
The Tiny-Tafel is a summary of your research interests that can be distributed to others so you c
people who are researching family lines in which you have an interest. Ultimate Family Tree int
designations are as follows:

0 People who will not be used to establish a family line.

1 People in whom you have no further interest or for whom your data is marginally reli
and therefore of no interest to anyone else. These people can be included in a Tiny-Tafel 
erence to establish a family line.

2 People in whom you have little interest, but your data is a high quality and might be 
interest to another researcher.

3 People in whom you have moderate interest. The data is either good or poor.

4 People in whom you have great interest. The data is good or poor.

• Individual Flags — Flags designate special information that you might want to include in your 
project. Ten flags are available for each individual. They can be defined differently for each indiv
Examples of possible flags include attendance at a certain college, needs more research, or ca
death. Up to ten characters of text can be entered in each Flag field.

• Birth field — Enter N(ormal), T(win), M(ultiple), S(tillborn), I(llegitimate), L(egitimate). This field i
optional.

• Immigrant — Check this field if the individual you are entering was an immigrant. The Immigran
field is used in Family Journal reports to establish the correct generation number reference.

A person identified as an immigrant in the Miscellaneous Information window is numbered 
generation 1 in Family Journal reports. In Descendant Family Journal reports, each generation 
individual’s ancestors is identified with an alphabetic character beginning with A, while the desc
dant generations are assigned the usual generation numbers, beginning with 2. In Reverse Reg
Family Journal reports, opposite from Descendant reports, each generation of descendants is g
alphabetic character, beginning with A, while the ancestor generations are each assigned a gen
number beginning with 2.

• Last Edit — The last edit date is the date this record was last saved. Ultimate Family Tree uses 
computer’s system date. The last edit date cannot be changed manually.
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• Reference — If you have your own system for referencing and would like to use it, enter your dat
the Reference field. Any combination of letters, numbers, and punctuation marks can be used u
characters.

• Common name — You can enter a commonly used name such as Johnny or Mary Jo. This name prints 
instead of the first name in reports where first names print without a surname. If a report has lim
space for an individual’s name it is truncated and the common name is substituted for the first n
For example, if Mary Jo is not entered here, Ultimate Family Tree uses Mary as the first name.

• Alias 1 — First alias for the individual. This is a good place to record a woman’s married name, 
French Canadian “dit” name, nickname, or the way you’d like a person’s given and surname(s) 
appear in printed reports. Remember to use slash characters (/) to define the surname and curl
{ } to define a title.

• Alias 2 — Second alias for the individual. Use slash characters (/) to define the surname and cu
braces { } to define a title.

For printed reports, Ultimate Family Tree provides a first and second choice for names in th
Page Setup window. For example, you can choose Alias 1 as the first choice and Main (the Ind
Record name) as the second choice. Ultimate Family Tree uses the Alias 1 name if it is present
then, if it’s not present, the Individual Record name. The name choice is useful if you want to us
name other than a birth name on printed reports. If you consistently use Alias 1 for a married na
then Ultimate Family Tree uses the married name (when present) if you have selected Alias 1 a
first choice name. The name options are Main, Alias 1, Alias 2 and Religious name.

• Signature — How the individual signed his or her name, for example, M. A. Smith.

• Nationality — Nationality of this individual.

• Language 1 — Primary language for this individual.

• Language 2 — Second language for this individual.

• Religion 1 — First religion for this individual.

• Religion 2 — Second religion for this individual.

• Religious name — Religious name for this individual. Use slash characters (/) to define the surna
and curly braces { } to define a title.

• Web Link — Universal Resource Locator (URL) that links an individual to any other Internet URL
an Instant Web Page. This link can be to images, sounds, or other genealogies. For example, y
link John F. Kennedy to a genealogy at another WWW site. If this genealogy were to be found a
http//www.anothersite.com/jfk.html, you could enter this address in the Web Link field for John F. 
Kennedy. Someone browsing your genealogy could then click on the link to move to the new pa
JFK. This link is included in Instant Web Pages.

• Ances. File # — Identifying number for LDS Ancestral File.

• Social Security No. — Individual’s Social Security number.
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Mail Label
Open the Mail Label window by choosing the More button in the Individual Record window. Choose M
cellaneous, and then choose Mail Label in the Individual Miscellaneous window. Use the Mail Label w
dow to enter an address and phone number for the individual. There is also a list you can use to des
specific mailings. The name entered in the addressee field can be different from the name in the Indi
Record window, such as Mr. and Mrs. Thomas Smith.

1. Enter a name and address for the individual on the appropriate lines. You can enter up to 34 ch
per line.

2. Designate specific mailings to send to this person, such as a newsletter. Check any of the appr
options.

3. Choose OK to return to the Miscellaneous Individual Information window.

Figure 2-15: Mail Label Window

Name and addresses

Phone number

Check boxes to include
individual on special
mailing lists
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Medical History
Choose the More button in the Individual Record window, and then choose Medical to open the Med
History window.

Choosing a medical condition opens a free-form text window where you can enter up to 65,000
acters of information. Choose the OTHER button at the end of the list of medical conditions to add an
ical conditions not listed in this window.

Figure 2-16: Medical History Window

Open a medical
condition text
window

Enter physical
characteristics
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Media
Choose the More button, and then Media to open the Multimedia Link window where you can attach i
or audio from the Multimedia Library to the individual you’re entering.

1. To add an image or audio file, in the Add Media Link group, choose Existing Media to open a M
Select window.

2. In the Media list, highlight the item you want to add and choose Add to copy it to the Linked Me
list.

3. Choose OK.

4. Choose the Play Image or Audio/OLE button (depending on the type of file) to display or play th

5. Choose OK to close the Multimedia Link window.

See Section 7 for more information on the Multimedia Link window and building a Multimedia 
Library.

Figure 2-17: Media Select Window
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Description of
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List of linked media
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Use the View menu to choose ways to display information you have entered in your project. The follo
formats are available: Family Tree, Family, Individual Summary, Descendants, Kinship, Photo, Slide 
Media Tree, and Lists. Use the list windows to display information about individuals, marriages, and s
in table (row and column) format. Use lists to help analyze data in your project, as well as to locate re
for editing.

You will learn how to:

✓ Move around the Family Tree window displaying up to five generations per screen with pictures

✓ Display a Family Group window combined with pictures

✓ View all information entered about an individual in story form

✓ View the descendants of a selected individual with pictures

✓ Determine the relationship between any two individuals in your project

✓ View a slide show for an individual or family

✓ View a four generation Media tree including pictures and narrative

✓ See a person’s full name and record number

✓ View all individuals in your project by record number, surname, given name, or birth date

✓ View a list of marriages in your project organized by surname or given name, date, or place

✓ View the list of sources in your Source Library
5 5
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Family Tree (Pedigree) Window
The Family Tree (also known as a Pedigree) window displays up to five generations of a family. This 
dow can be used with other windows, such as the Individual Record window, to discover more about
selected family members.

1. Choose Family Tree from the View menu, or click the Family Tree button on the Toolbar.

2. To change the subject of the Family Tree window, click the Find button on the Toolbar, or use th
key (F10) to select an individual.

3. Double-click a name to make that person the focus person of the window.

Note The indicator to the right of a name in the far right column will be on if that line continues

4. Choose Previous if you want to move back to the previous subject.

5. Choose any person (by double-clicking the left mouse button) in the child list to move that pers
the subject line. (Use the scroll bar to move up and down a long list of children, or click once on
child and use the up and down arrow keys to move through the list. Type the first letter of a nam
move up or down the list to that child’s name.) The number of children in the list is shown at the 
the list. Highlight a child’s name and press F5 or the Individual Record button on the Toolbar to 
play the Individual Record for the selected child. When you return to the Family Tree window, th
child will be the focus of the window.

Figure 3-1: Family Tree Window

Focus person

Switch to spouse’s pedigree Return focus to previous subject

Indicates line
continues when
green
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6. Double-click any sibling to make that person the focus. All siblings are listed, including those w
have only one parent in common. Use the scroll bar or the up and down arrow keys to move up
down a long list of siblings, or type the first letter of the name to move up and down the list to th
ling’s location. Press F5 or the right mouse button to display the Individual Record window for a
selected sibling.

Note A plus (+) sign is displayed to the left of a subject’s child or sibling if that person has descend

7. Choose the Spouses button to display spouses of the selected individual in the window. Choose
to return to the Family Tree window for the original person, or OK to return to the Family Tree w
the selected spouse as the new subject. (Choose edit in the Spouses window to open the spou
vidual Record window.)

8. Choose the Previous button to return the focus to the previous subject.

9. Choose Photo to display the preferred image (if any) for the selected individual. See page 164 
information on selecting a preferred image for someone.

Note To return the focus to the original individual, double-click his or her name at the top of the win

10. Choose Close to close the Family Tree window and return to the Individual Record window. Th
selected individual in the Family Tree window will be the new focus of the Individual Record.

Family Group Window
The Family Group window displays a family unit including a husband, wife, their parents, and their ch
dren.

1. Choose Family Group from the View menu or click the Family Group button on the Toolbar to o
the Family Group window.

Figure 3-2: Family Group Window

View any additional spouses

Marriage date and place

Number of children

View parent’s family group
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2. Press F10 or click the Find button on the Toolbar to find a new subject, and choose OK to return
Family Group window with your selected person as the Start person. Remember, you can press
choose the Individual Record button on the Toolbar if you’d like to display the Individual Record
dow for this or any selected individual.

3. If a marriage record for the husband and wife is found, the date and location of the marriage is 
in the center of the Family Group window. Otherwise, you’ll see “marriage record not found.”

4. Choose +Wives or +Husbs to display a list of spouses or parental partners. Select a spouse or 
partner from the list to display his or her associated family, or choose Cancel to return to the Fa
Group window. These buttons are dim if no other spouses are found.

Note Parents who are not married or do not have a marriage record are considered parental p

5. Choose Parents to display the family for the husband’s or wife’s parents. These buttons are dim
parents are found.

6. To shift the family display forward one generation, highlight the child in the child list box, choose
Child button, or double-click the name. When “no children” appears in the Child list box, the Ch
button is dim.

Note The children for this husband and wife are shown in the list box next to Child and the nu
of children is displayed under Child. This list contains all common children for this couple. Use 
scroll bar or the Up and Down Arrow keys to move up and down a long list of children. You can 
type the first letter of the name to move down the list to that child’s name. A plus (+) sign in fron
child’s name indicates that his or her descendant line continues. Type a plus sign to move up o
the list to a name with a plus sign.

7. Choose Photo to display the preferred image (if any) for the selected individual.

8. Choose Close to close the Family Group window and return to the Individual Record window.

Individual Summary
To view all the information you’ve entered for an individual, follow these steps.

1. Select an individual in any window, and then choose Individual Summary from the View menu, 
Shift + F5 on the keyboard, or choose the Individual Summary button on the Toolbar.

The selected individual’s information is displayed in story form. Individual text, plus footnote
and research notes, are shown in their entirety.

2. Information in the Individual Summary window can be viewed but not edited. To change informa
appearing in the Individual Summary, edit the information in the Individual Record window.

3. To close the Individual Summary window, press Escape or choose the Close box.

Note Some event details might be displayed twice. This is normal.
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Descendants Window
The Descendants window shows a list of descendants, one generation at a time, for a selected individ
example, you can use the Descendants window to view all grandchildren of a selected person. Up to
generations can be viewed.

1. Choose Descendants from the View menu.

Note To find a new starting person for the Descendants window, press F10 or choose the Find
on the Toolbar to open the Find Individual window. (See page 80.)

Figure 3-3: Individual Summary Window

Double-click to close window

Figure 3-4: Descendant Window

Select a generation number
to view descendants in a
specific generation

Descendants of start person

Generation number,
number of individuals

Parents of selected person
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2. Choose a generation number from the Generation Gauge on the left side of the window to view
descendants in a specific generation. (To choose a generation number, highlight the number or
sponding number line in the gauge, or Tab to the gauge and use the Up and Down Arrow keys.

3. Use the scroll bar if the list of descendants in a generation is longer than the box. Individuals in
Generation List are shown in alphabetical order by given name. The number of persons in that 
tion are shown above the list, as is their relationship to the ancestor. The parents of the selected
if known, are displayed at the bottom of the window.

Note To edit an individual record, select the individual and press F5 or the Individual Record b
on the Toolbar to open the Individual Record window.

4. Choose Close.

Kinship
You can find the relationship between any two individuals through birth or marriage. If a relationship e
Ultimate Family Tree displays a list of common ancestors. The relationship between the selected indiv
is computed through 16 generations. Two individuals (Subjects 1 and 2), are selected as the subjects
relationship check.

Note In order to maintain proper text alignment, the text appears in a different font.

1. Choose Kinship from the View menu.

2. Start with Subject 1. A Lock button is next to the name field. Unlock the Lock button if it is chec
Click the Find Person button on the Toolbar or press F10 to find a new individual. When the des
individual is found, choose OK in the Find Individual window. See page 80 for information on us
the Find Individual window.

Figure 3-5: Kinship Window

Relationship of
individual 1 and 2

Common ancestors

Select to view how the
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redundant ancestors



K I N S H I P 6 1

 F10 

ill 

s well 

up and 

 genera-
ber of 

m rela-
ant 
mber of 
lation-

stor to 
 sub-
 when 
on 

Birth 

onsan 
3. Check Lock to lock in Subject 1.

4. Unlock the Lock button for Subject 2 (if Lock is on). Click the Find button on the Toolbar or press
to find the second subject for the relationship check. When the person is found, choose OK.

Note You must unlock a subject before the Find Individual and arrow buttons on the Toolbar w
work. Be sure to lock Subject 1 before moving on to Subject 2.

5. Choose Start to compute the relationship between the two subjects.

6. The Related Thru group displays how the two individuals are related through birth or marriage, a
as any events they may have in common.

• Select Birth to find a blood relationship.

• Select Marriage to display relationships through marriage.

• Select Events to display the events that the two individuals have in common.

7. To find the nearest common ancestor of the two subjects, select Birth from the Related Thru gro
Nearest in the Show group.

8. Select Redundant1 from the Show group to display the redundant ancestors and the number of
tions from Subject 1 to all individuals in the list. To display the redundant ancestors and the num
generations to Subject 2, select Redundant2.

Note Birth must be selected to access the Redundant options. Redundant ancestors result fro
tionships in which there is more than one line from an individual to his or her ancestor. Redund
lines result when cousins marry. If Subjects 1 and 2 have common redundant ancestors, the nu
generations to both is displayed. If the number 999 is displayed after an individual, there is no re
ship between the selected subject and the individual in the list.

9. Select Generation from the Number group to display the number of generations from each ance
each subject. The resulting Relationship list contains the nearest common ancestors of the two
jects, and the number of generations from subject 1 and subject 2. (This is the default selection
the Kinship window is first opened.) Birth and Nearest must be selected to access the Generati
option.

10. In the Number Group, select Ahnentafel to display the Ahnentafel number for Subject 1 and 2. 
and Nearest must be selected to access the Ahnentafel option.

11. To display the degrees of consanguinity (kinship) between each ancestor and subject, select C
from the Number group. Birth and Nearest must be selected to access the Consan option.

12. Choose Close to close the Kinship window.
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Name and Record Number
Choose Name and Record Number from the View menu to display that individual’s full name and rec
number. Click OK to close the window.

Slide Show
Use the Slide Show window to view slide shows that you have created.

1. Choose Slide Show from the View menu to open this window.

2. Highlight one of the shows in the Slide Show list and choose Preview to see the slides for that s
displayed eight at a time. This allows you to review the show before viewing the show, one slide
time. See page 166 for steps to create a slide show.

3. To view the slides manually or automatically, select the appropriate option in the Mode group. I
choose Manual, you must advance each slide by pressing the Escape key. If you choose Autom
program advances the slides for you.

4. Check the Sound Effects option to turn sound effects on or off.

5. Choose Selected to view the show you highlighted or All to view all of the shows.

Media Tree
The Media Tree displays four generations of a family with pictures and recordings attached to each ind

1. Choose Media Tree from the View menu.

2. To change the start person for the tree, use the Find Individual button or F10 key to find a new 

Figure 3-6: Slide Show Window

List of slide shows

Turn sound effects on or off
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3. Select Narrative from the Multimedia drop-down list and choose an individual’s name on the Me
Tree to hear a recording that has been linked to that person.

4. Select Photo and Narrative from the drop-down list and then choose an individual’s name to se
enlargement of the “preferred image” and play a narrative, if present.

Note If more than one image is linked to an individual and none have been selected as the pre
image, the first image linked to the individual is displayed in the Media Tree.

5. Choose Close to close the Media Tree.

Viewing a Photo
Choose Photo from the View menu to display the preferred image for the selected individual. If no im
linked to this individual have been selected as the preferred image, this feature is not available. See p
for instructions on selecting a preferred image.

Individual, Marriage and Source Lists
• Individual List — Displays a list of all individuals in your project. To open the Individual List, choo

Individual from the View menu and choose one of the options: By Record Number, By Surname
Given Name, or By Birth Date.

Figure 3-7: Media Tree Window
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• Marriage List — Provides a list of the marriages in your project. To open the Marriage List, choo
Marriage List from the View menu and choose one of the options: By Husband Surname, By Wif
name, By Husband Given, By Wife Given, By Date, or By Place.

• Source List — Provides a list of all your sources in the Source Library.

When the right side of a List window is opened, the information in a record is displayed vertically
you can view all fields in a record. To open the right side of a List window, position the cursor on the 
box on the lower-right corner of the List window. Hold down the left mouse button and drag the pointe
the left.

When text is available in a text or note field, you’ll see Memo in the list with an uppercase M. W
no text is available, memo is displayed with a lowercase m. If text is available, you can view the text b
pressing Ctrl+PgDn with Memo selected. If you double-click on Memo, the Individual Record for the 
selected individual opens.

Text in List windows can be viewed, but not changed. To edit text, events, sources, or other info
tion displayed in an Individual List window, select the field and press F5, or double-click the left mous
ton to open the Individual Record window. Choose the appropriate button to access text, event, or so
windows and make editing changes. In a Marriage list, double-click to open the Individual Record for
person on the left side of the list. In a Source list, double-click a selected field to open the Source Re
window.

Use the vertically positioned arrows to scroll up and down the list. Use the arrows along the bott
the window to scroll horizontally throughout the list.

Figure 3-8: Individual List Window

Use arrows to
scroll horizontally
through list

Hold left mouse
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Ultimate Family Tree provides a powerful set of search routines designed to locate individuals in a pr
In this section you will learn how to locate individuals by using search criteria.

✓ Name and/or SOUNDEX code

✓ Citations

✓ Events in an individual’s life

✓ User-defined flags

✓ Mailing label information

✓ Linked pictures or audio recordings

✓ Information contained in the Medical window

✓ Information contained in the Miscellaneous window (long names, aliases, religion, nationality, s
security number, and more)

✓ Relationships

✓ Biographical, research or footnote text

✓ Event details

✓ Vital statistics (age at marriage, sex, living, related, unrecorded parents, and more)

✓ Record number or part of the name
6 5
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Using Search Windows
Each Search window provides options for defining the scope of your search. Ultimate Family Tree loca
records for which the contents of the specified field matches the search criteria. Information entered 
Search window is retained when you close the window. You can close a Search window, and then op
again to conduct another search using either the same or modified search criteria.
Search windows contain a drop-down list with the following options:

• Replace the list with those found — Starts a new search list. This option replaces an existing search
with the results from the current search list. Individuals already in the list are removed, and the n
is saved.

• Add them to the name list — Builds a composite list from two or more searches. This option adds 
results of the current search to an existing search list. For example, if five individuals are already
list from a previous search, and seven new individuals are found and saved with this option, the
list will contain 12 individuals.

• Remove them from the name list — Narrows an existing search list. This option removes the results
the current search from an existing search list. If five individuals are in an existing list, and two i
viduals from a new search are already in that list, they will be removed. The new search list will
tain three individuals.

• Keep if already in the name list — Matches items in an existing search list. This option keeps the 
results of the search if they are already in the existing search list. If five individuals are in an ex
list and a new search finds two who are already in that list, the new list will contain two individua

Other options common to all search windows are:

• Close — Closes the search window

• Search — Creates the Search list

• Results — Views the results of the last search

• History — Shows how the search list was built

• Group — Replaces the Grouping List with the results of the selected search

• Preview — Displays the results of a search without committing the results to the search list

Steps for Completing a Search
The following basic steps are used to conduct a search.

1. Open any search window from the Search menu.

2. Make selections for defining the search. The search criteria are shown at the top of the search 
as you make your selections. This information is also added to the History window after a searc
complete.
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3. Choose one of the options from the drop-down list at the bottom of the window to Replace, Add
Remove, or Keep for the resulting Search list. (See options listed in the previous section.)

4. To check the search without committing the results to the permanent search list, choose Preview
Escape to return to the Search window.

5. Choose Search to create the Search list and view the results.

6. Choose Group to replace the Grouping List with the results of the current search.

7. Choose Close or press Escape to close the Search Window.

Note Choose Results to show the last completed search list. Double-click any name to open th
vidual Record for that person. Choose History to see a summary of how the Search List was bu

Name Search
You can locate a person in an Ultimate Family Tree project by name or names. Various options provi
ibility in defining the Name search. The following rules apply when entering names in the Name Sear
Find Individual windows:

• Use either uppercase or lowercase letters. Name searches are not case sensitive.

• Enter more than one name for a person if you want. For example, if you are looking for John Fitzger-
ald Kennedy in your project, you can type john fitzgerald in the top field.

• Type either full or partial names. For example, you can type hn fit to locate John Fitzgerald Kennedy.

• Use special characters called wildcards. The question mark wild-card character (?) is used to sub
for a single unknown character. For example, jo?n finds all those named John or Joan. The asterisk (*) is 
used to substitute for more than one consecutive character. For example, ho*r finds Howard and Homer.

Figure 4-1: Name Search Window

Conduct search

See search list

See list of all steps taken
to create the search list
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results to the permanent
search list
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Move contents of search
to Grouping List



6 8 SE C T I O N 4 : SE A R C H I N G F O R I N D I V I D U A L S

nter a 
nter a 
places 

s. It is 
e is 

 and 

 a sur-
UN-
• Use forward slash characters (/) to specify surnames. For example, by typing /smith/ you find all those 
individuals having the surname Smith. If you enter smith without slash characters, Ultimate Family 
Tree finds all individuals whose name contains smith at any place in their name.

• Use braces to specify titles. For example, typing {Sr.} finds all those individuals having the title Sr.

• Search for surnames in the top text field of each Name Specification box by SOUNDEX code. E
surname without the slash characters or a valid SOUNDEX code in the first name field. If you e
surname, Ultimate Family Tree converts the name to the SOUNDEX code for that name, and re
the name in the text field with the code.

Note SOUNDEX is a code used by the United States Government to index early census record
used to find names with the same sound, no matter how they are spelled. Each SOUNDEX cod
made up of a letter and three numbers. The letter is the same as the first letter of the surname.

Searching for a Simple Name
1. Choose Names from the Search menu.

2. Type a name in the first name field of the top Name Specification box. Use wild cards if desired
any combination of uppercase and lowercase letters.

3. Complete the search as described on page 66, “Steps for Completing a Search.”

Searching for a Surname by SOUNDEX
1. Enter a surname (without slashes) or a valid SOUNDEX code in the first name field. If you enter

name, Ultimate Family Tree converts the name to the proper SOUNDEX code for you. (The SO
DEX search only finds surnames.)

2. Check the SOUNDEX check box in the appropriate Name Specification box.

Figure 4-2: Name Search Window

Type name here

Check here to exclude
names containing
characters entered below

Check here to search
by SOUNDEX code
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3. Make sure all other name fields are empty.

4. Complete the search as described on page 66, “Steps for Completing a Search.”

Completing a Complex Name Search
1. Enter the search information using any combination of the four name fields available. Select the

SOUNDEX and the NOT conditions that you want to use. The two name fields in each Name S
cation box are used together.

2. Check the NOT check box to exclude names from the search.

Note The characters entered in both fields must be present in an individual’s name for that indiv
record to be included in the search list. If the OR Name Specification fields (lower Name Specific
box) are used with the upper Name Specification Box, a record must match one or the other to 
included.

3. Specify surnames by using the forward slash, for example, /Smith/, and titles by using braces, for 
example, {Jr.} .

4. Complete the search as described on page 66, “Steps for Completing a Search.”

Searching for Individuals Linked to Citations
The Citation Search locates individuals who are connected through a citation to specific sources in th
Source Library. Open the Citation Search window by choosing Citations from the Search menu. The C
Search window contains a list of all sources in the Source Library, and options to narrow your search

The search criteria are displayed at the top of the search window as you make your selections.
information is also added to the History window after a search is complete.

1. Select Any in the Source box. Choose Selected to include only a specific source in the search.

Figure 4-3: Citation Search Window
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with citations

Search for events
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Search for all citations
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2. If you chose Selected in step 1, select the source you want to include in your search from the S
List. The Source List includes all the sources in the Source Library. The list shows the Abbrevia
name for each source.

3. Narrow your Citation search by specifying where the citation was used. Three location options 
provided:

• Individuals — Searches for the selected source when used in citations for information in the Indiv
Record window

• Events — Searches for the selected source when used in citations for events

• ALL — Searches for the selected source when used in any citation

4. Complete the search as described on page 66, “Steps for Completing a Search.”

Individual Events Search
The Individual Events Search looks for individuals connected to events in your project based on the e
entered in the Individual Record window. The search criteria are displayed at the top of the search win
you make your selections. This information is also added to the History window after a search is com

1. Choose Events from the Search menu.

2. Choose Selected Event or All Events in the lower-left corner of the window.

3. If you chose Selected Event in step 2, select an event from the Possible Events list that shows 
event types used in the current project. Scroll through the events using the up and down arrow 
by typing the first letter of the event you want to search.

Figure 4-4: Individual Events Search Window

Select to search on
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a search



F L A G S  SE A R C H 7 1

d then 
a, skip 

cluding 
harac-

earch is 

o one 

ate.

date 

vents 
ld and 

rma-
This 

ed in 

ags 
r True 
4. To search for events that happened in a selected place, check Selected in the Places group, an
choose Place to open the Find Place window. If you are not including places in the search criteri
to step 9.

5. Type in the first few characters in a place name.

6. Choose Exact for all place names with an exact match or choose Like and use any characters in
wildcard characters. The question mark wild card (?) is used to substitute for a single unknown c
ter. The asterisk wild card (*) is used to substitute for more than one consecutive character.

7. Choose Show to see the list of places found.

8. Select a place and choose OK to close the Find Place window. The place to be included in the s
added to the criteria at the top of the window.

9. To search for an event that took place in a certain time period, enter dates for the time period. D
of the following:

• Enter the date in the After field in the Dates group to search for events occurring after a given d

• Enter the date in the Before field to search for events occurring before a given date.

• Leave both the After and Before fields blank to search for events that occurred on an unknown 
(the event date fields are blank).

Note If a date is entered in the Before field and the After field is left blank, the search includes e
with a blank date field and events having dates after 1/1/100. If a date is entered in the After fie
the Before field is left blank, the Before date defaults to today’s date.

10. Complete the search as described on page 66, “Steps for Completing a Search.”

Flags Search
The Flags Search locates individuals whose Individual Records contain specific user-defined flag info
tion. The search criteria are displayed at the top of the search window as you make your selections. 
information is also added to the History window after a search is complete.

1. Choose Flags from the Search menu.

2. Select a flag from the list of individual flag fields. All flag labels assigned to the project are includ
the list.

3. In the Status group, select True to search for flags marked True, or select False to search for fl
marked False. Select Either to search for individuals linked to the selected flag marked as eithe
or False.

4. Complete the search as described on page 66, “Steps for Completing a Search.”
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Mail Search
The Mail Search window locates individuals by information entered in the Mail Label window, opened 
the Miscellaneous Individual Information window. The search criteria are displayed at the top of the s
window as you make your selections. This information is also added to the History window after a se
completed.

1. Choose Mail from the Search menu.

2. Scroll down the list of options in the label field and select the criteria to be used in the search.

3. If you select one of the label fields that contains text, such as an addressee, enter the words to s
the Text field.

Figure 4-5: Flags Search Window

List of individual flags

Select to search for all flags
set to True, False, or Either

Figure 4-6: Mail Search Window
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of the Mail List options
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4. Select a mailing list from the Label Fields (such as Family Association, Newsletter, Birthday, Ho
and Other 1 and 2) to enable the buttons in the Included in Mail List box.

5. Select Yes to search for individuals included in the selected mailing list, or No to find those not 
included in that mailing list.

6. Complete the search as described on page 66, “Steps for Completing a Search.”

Media Search
The Media Search searches for individuals who are connected to a selected image or audio recordin
search criteria are displayed at the top of the search window as you make your selections. This inform
also added to the History window after a search is complete.

1. Choose Media from the Search menu.

2. Select the audio or image you want to include in the search from the Media list.

3. Complete the search as described on page 66, “Steps for Completing a Search.”

Medical Search
The Medical Search looks for individuals for whom you have medical information. The Medical Histor
window is opened from the Individual Record window. The search criteria are displayed at the top of 
search window as you make your selections. This information is also added to the History window af
search is complete.

1. Choose Medical from the Search menu.

Figure 4-7: Media Search Window
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2. Select one of the three options located under the Medical Conditions list: Selected, All, or Ignor
you choose Ignore, the Medical conditions are ignored and only the Measure and Misc. groups
available to be searched.

3. If you chose Selected in Step 2, select the medical condition from the Medical Conditions list. S
through the list by using the Up and Down Arrow keys or by pressing the first letter of the condi
you want to search.

4. Select Any Text in the Text group to search for text entered in the Medical Condition text window
select Specific Text and enter the words you want to search for.

5. Type a weight and/or height to search for. Enter a minimum and maximum number for each crit
You can specify either pound/foot/inch (pd/ft/in) or kilogram/meter/centimeter (kg/m/cm).

6. Type specific criteria such as hair color, eye color, skin color, or blood type.

7. Complete the search as described on page 66, “Steps for Completing a Search.”

Miscellaneous Search
The Miscellaneous Search window locates individuals with information entered in the Miscellaneous 
vidual Information window. The Miscellaneous Individual Information window is opened from within th
Individual Record window. The search criteria are shown at the top of the search window as you mak
selections. This information is also added to the History window after a search is complete.

1. Choose Miscellaneous from the Search menu.

2. Select a field from the Miscellaneous Fields list. Use the scroll bar or the Up and Down Arrow ke
move through the list.

Figure 4-8: Medical Search Window

Check option to
include medical
conditions
in search

Type specific weight
and height data to
be searched

Select to search on
any text

Enter text to be
searched
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3. Type in the text you wish to search for, or if you have selected Ancestral Interest or Descendan
est, type the low and high interest limits in the boxes below the Search box.

4. Complete the search as described on page 66, “Steps for Completing a Search.”

Relationship Search
The Relationship Search searches for individuals who are related directly or through collateral lines t
specified person. The search criteria are displayed at the top of the search window as you make you
tions. This information is also shown in the History window after a search is complete.

1. Select (from any window) the individual you want as the starting subject of the search.

2. Choose Relationship from the Search menu.

Note Press F10, or choose the Find button on the Toolbar to find a new starting person for the s
See page 80 for information on using the Find Individual window.

Figure 4-9: Miscellaneous Search Window

Type text to be found

Ancestral and
descendant limits
can be entered here

Figure 4-10: Relationship Search Window
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Add other spouses
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3. Select one of the following Relationship Options:

• Ancestors Only — Searches for ancestors to a specified generation limit

• Ancestors Plus — Their Descendants Searches for ancestors to a specified generation limit, and
descendants of those ancestors to a specified descendant limit

• Descendant Only — Searches for the selected individual’s descendants to a specified generation

• Descendants Plus — Their Ancestors Searches descendants to a specified generation limit, and 
tors of those descendants to a specified ancestor limit

• Ancestors Plus Descendants — Searches ancestors and descendants to a specified generation lim
each way

• Siblings — Searches for the start person’s siblings (generation limit not used)

4. Use the Limits group to specify the number of generations (up to 999) to include in your search
Limits group includes three fields:

• Generation — Enter the number of generations to search in the direction you are searching (anc
descendants or both).

• Descendant — Enter the number of generations of descendants to include when Plus Their Des
dants is selected.

• Ancestor — Enter the number of generations of ancestors to include when Plus Their Ancestors
selected.

5. Check the Add Other Spouses box to add spouses not already included in the search.

6. Complete the search as described on page 66, “Steps for Completing a Search.”

Note The starting individual is always included in the list.

Text Search
The Text Search locates individuals whose records contain any or specific text in a free-form text fiel
search criteria are displayed at the top of the search window as you make your selections. This inform
also added to the History window after a search is complete.

1. From the Search menu, choose Text.

2. To search on a specific field, select the Individual, Event, or Media text field from the Text Field
Scroll through the list using the Up and Down Arrow keys or by typing the first letter of the even
want to search. Choose Selected below the Text Field list.

3. To search all fields, choose All below the Text Field list.

4. Choose Any Text or Specific Text.
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5. If you chose Specific Text, type the specific text you want to search in the Text box.

6. Complete the search as described on page 66, “Steps for Completing a Search.”

Vital Statistics Search
The Vital Statistics Search locates individuals on the basis of their vital statistics, such as age. The s
criteria are shown at the top of the search window as you make your selections. This information is a
added to the History window after a search is complete.

1. From the Search menu, choose Vital Statistics.

2. Select a vital statistic from Vitals Search Options list.

Figure 4-11: Text Search Window

List of Individual, Event,
and Media text fields

Restrict search to
a selected field

Select to search
on specific text

Enter text to be found

Figure 4-12: Vital Statistics Search Window

Enter T (true), F (false),
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limits

Y (yes), N (no), or
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3. Enter the appropriate search code or limit in the Search group.

Note Vital statistics can be specified either by code (such as Y for yes, N for No) or limits (suc
low age and high age). Appropriate search conditions are available for each vitals search option

4. Use the vitals search options, Age at first (event) and Age at last (event) to choose any event yo
For instance, you can choose Age at first (event) from the Vitals Search Options and then selec
event included in your project from the Possible Events list. Enter the age to be searched in the
box.

5. Complete the search as described on page 66, “Steps for Completing a Search.”

Grouping
The Grouping option merges search lists generated through the Individual search routines. Use the G
List to hold only the names of individuals on whom you want to focus. It can also be used as a basis 
printed reports and new projects. Each search window has a Group button that replaces the Groupin
with the results of the selected search. Use the Grouping window to merge the contents of several se

1. From the Search menu, choose Grouping.

2. Select a search routine from the Individual Search Options List. The Individuals In group displa
number of individuals in each of three categories:

• Selected Search — Displays the number of individuals in the search routine selected from the Se
list

• Entire Project — Displays the total number of individuals in the project

• Grouping List — Displays the number of individuals in the current Grouping List

Figure 4-13: Grouping Window
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Note You must run a search in the selected routine before you can add it to the Grouping List.
number of individuals found in the selected search appears next to Selected Search in the Indiv
In group. If this number is zero, a search has not been run and a Grouping List cannot be creat

3. Choose History for Selected to see a summary of how the results were obtained for the selected

4. Check the Invert Selected check box to include all individuals not in the selected search.

5. Select one of these options from the drop-down list for the resulting search list:

• Replace grouping list with selected list — Starts a new search list. This option replaces an existing
search list with the results from the current search list. Individuals already in the list are remove
the new list is saved.

• Add selected list to grouping list — Builds a composite list from two or more searches. This option
adds the results of the current search to an existing search list. For example, if five individuals a
already in the list from a previous search, and seven new individuals are found and saved with 
option, the new list will contain 12 individuals.

• Remove selected list from grouping list — Narrows an existing search list. This option removes the
results of the current search from an existing search list. If five individuals are in an existing list,
two individuals from a new search are already in that list, they will be removed. The new search
will contain three individuals.

• Keep in selected list and grouping — Matches items in an existing search list. This option keeps th
results of the search if they are already in the existing search list. If five individuals are in an ex
list and a new search finds two who are already in that list, the new list will contain two individua

• Add spouses to grouping — Adds spouses for all individuals in the Grouping list.

6. To check the search without committing the results to the permanent search list, choose Preview
Escape to return to the Grouping window.

7. Choose Search to create the Grouping list.

Note Choose Results to show the list. Double-click a name to open the Individual Record for t
person. Choose History to see a summary of how the Grouping List was built. Choose Close or
Escape to close the Grouping window.

Adding an Individual to the Grouping List
You can add an individual to the Grouping List.

1. From the Search menu, choose Grouping.

2. Choose Results to open the Grouping List.

3. Press F10 or click the Find button on the Toolbar to open the Find Individual window.

4. Find the person and choose OK. The Grouping List will close. Choose Results to open the Gro
list again with the individual’s name highlighted.
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Removing an Individual from the Grouping List
You can remove an individual from the Grouping List.

1. Open the Grouping List by choosing Results in the Grouping window.

2. Highlight the name of the individual.

3. Press Shift + F9, or from the File menu, choose Delete Record.

Note This procedure removes an individual from the Grouping list, but it does not delete the p
from the project. When removing an individual from the Grouping list, the change is not reflecte
the list until you have closed and reopened the list.

Finding an Individual Using the F10 Key or Find Button
The quickest, simplest way to find an individual is to enter a record number or type part of a name in
Find Individual window.

1. Press F10, choose the Find button on the Toolbar, or choose Find from the Search menu to op
Find Individual window.

2. Type the first few characters of the name (or the record number, if known) and press Enter, or c
Find to display the first occurrence of that name in your project.

Note If you type a full name, use slash (/) characters to mark the surname. See the next sectio
other rules on entering names in searches. If you have typed characters, Find locates all individ
the project whose names contain those characters and places them in a list. The first name foun
played in the Find Individual window.

3. Use the scroll bar or Shift+F3 (Go Top), F3 (Go Up List), F4 (Go Down List), or Shift+F4 (Go Bo
tom) to move through the list. To display the entire list and make a selection, choose Show.

Figure 4-14: Find Individual Window
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4. Highlight the name of the individual you want in the Find list and close the window (choose the 
trol-menu box or press Escape) to return to the Find Individual window.

5. Choose OK to return to the original window with the focus changed to the newly found individua

Rules for name searches
• Names are not case sensitive—use uppercase or lowercase letters.

• Enter more than one name for a person if you want. For example, if you are looking for John Fi
ald Kennedy in your project, you can type john fitzgerald.

• Type either full or partial names. For example, you can type hn fit to locate John Fitzgerald Kennedy.

• Use special characters called wildcards. The question mark wildcard character (?) is used to substit
for a single unknown character. For example, jo?n finds all those named John or Joan. The asterisk (*) 
is used to substitute for more than one consecutive character. For example, ho*r finds Howard and 
Homer.

• Use forward slash characters (/) to specify surnames. For example, by typing /smith/ you find all those 
individuals having the surname Smith. If you enter smith without slash characters, Ultimate Family 
Tree finds individuals whose names contain smith at any place.

• Use braces to specify titles. For example, typing {Sr.} finds all those individuals having the title Sr.

Using the Go Menu
The Go Menu gives you the ability to move throughout the individual list and quickly return to recently
edited records. Up to ten individual names are displayed in the Go List. Each time you open an Indiv
Record, that individual’s name is placed at the top of the list.

From the Go Menu, choose any name in the list to open that individual’s record. Choose Go To
move to the first person in your project. Choose Go Bottom to move to the last person. Choose Up o
to move the the previous or next person in the list. The next person is determined by the order in whi
last opened individual records. If the last individual record you opened resulted from a search, the foc
change to those individuals in the search list.
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Ultimate Family Tree prints a wide variety of genealogical charts and reports, from simple lists to fully
indexed and documented books. Many different formats are provided which you can customize to yo
preferences. You can send reports directly to a printer or to a file for printing later. Reports can be se
ASCII file, or to a Rich Text Format (RTF) file that can be imported into many word processing progra

In this section you will learn how to:

✓ Use print setup to select a printer or file

✓ Use page setup to set name format and preferences, and to choose fonts and page layout

✓ Use print and print preview

and to print the following reports:

✓ Title Page

✓ Family Journal (Genealogy) report

✓ Image

✓ Family Tree (Pedigree) report

✓ Ancestor (Ahnentafel) report

✓ Text, Direct Drop, or Indented Descendant report

✓ Box Chart

✓ Relationship List

✓ Free-form text

✓ Footnotes as end notes
8 3
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✓ Index

✓ Family Group report

✓ Individual or Project Summary

✓ Individual, Marriage, Source, and GEDCOM Exception Lists

✓ Mail Lists and Labels

✓ Text or Box style Calendar

✓ Tiny-Tafel reports

Using the Print Setup Window
Before you can print, you must install a printer through the Windows Control Panel. The default printe
Windows is displayed at the top of the Print Setup window in Ultimate Family Tree. Choose Print Set
from the File Menu to view a list of installed printers. For instructions on installing additional printers, 
to your Windows manual.

Changing the Default Printer
1. From the Ultimate Family Tree File menu, choose Print Setup.

2. Select a printer from the list and choose the Set as Default Printer button. The printer name you
appears in the Default Printer box.

Note Changing the printer in the Print Setup window also changes the default printer in the Win
Control Panel. Ultimate Family Tree supports 8 1/2 ´ 11 inch and A4 portrait page formats. The Box
Chart has additional options. You can export the report to a word processor for other page form

Figure 5-1: Print Setup Window

Default printer specified
in Windows Control Panel Check here to print to a file

Installed printers
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Select type of file

Select word processor
destination for RTF file
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Printing to a File
Using the Print Setup window, you can designate Ultimate Family Tree Editor, Microsoft Word for Win
dows, or another word processor as your primary word processing application.

1. From the File menu, choose Print Setup.

Note In the Windows Control Panel, you can configure your printer to print to a port such as LP
to a file. The Ultimate Family Tree Print to File option does not change the default setting for the p

2. Check Print to File.

3. In the File Contents group, select the radio button for the type of file to create.

• Printer Codes — Prints your report to a file containing embedded printer codes for the currently 
selected printer. Use this option print a report to a file and then later send the report from DOS 
appropriate printer.

• ASCII — Creates the report in ASCII text format, 10 characters per inch, with no printer codes 
included.

• Rich Text Format — Creates reports using RTF. Ultimate Family Tree does not export reports via
that are highly structured, such as the five- and six-generation Family Tree Charts and Calenda
others such as an index, that are created in a word processor used for formatting the report.

Note When Rich Text Format is selected, the Editor (RTF) options are activated. See the next se
“Rich Text Format.” Select the destination word processor in which the report will be edited and pr

4. Check the Launch Editor box in the Editor (RTF) Options group. When this box is checked, Ulti
Family Tree Editor or Word for Windows will open automatically when you create a report.

5. Select the word processing application you want to use from the Editor Choice drop-down list.

6. Click Browse if the executable file for the word processor you have chosen does not appear in th
to Editor field.

7. For information on using the Ultimate Family Tree Editor, see “Ultimate Family Tree Editor” on 
page 228.

8. To include indexing codes if you are printing the report to an RTF file, check Include Index.

9. Click Close to leave the Print Setup window.

Note Table of Contents and Index codes are normally included in Ultimate Family Tree RTF fil
Some word processors, such as AmiPro, do not import index codes. When creating an RTF file
word processor that does not import index codes, do not check the Include Index option. Table o
tents codes can sometimes create a double section or chapter title in word processors that do n
port Table of Contents data. Redundant titles can be manually removed using the word process

Rich Text Format 
The RTF standard developed by Microsoft describes a method of encoding formatted text for easy tr
between applications. With the RTF standard, documents composed under different operating system
with different software applications can be transferred between those operating systems and applica
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Ultimate Family Tree supports the RTF standard for exporting report formatting, text justification,
attributes (size, bold, italic, superscript), indexing, footnotes, table of contents entries, headers, and f
By using RTF, most Ultimate Family Tree reports can be sent to many IBM-PC and Macintosh word p
cessing programs for further editing and formatting. Word for Windows, Microsoft Word, WordPerfect 
Windows, WordPerfect 6.0, Professional Write Plus, and Ami Pro are examples of word processing p
grams that accept RTF files.

The menu options for reports that are not exported are not available when the RTF radio button
selected. If you want, these reports can be exported as ASCII files, and then imported into any word p
ing program. ASCII files, however, contain only text and not the other attributes available for RTF files

The following characters should not be used with the Rich Text Format feature:

• \ — Used for control codes in RTF files. Do not use the backslash character in Ultimate Family T
you will be using the RTF feature.

• { } — Used for control codes in RTF files. Do not use the left or right curly brace character in Ultim
Family Tree (except to mark a title in a name) if you will be using the RTF feature.

Using the Page Setup Window
To select various print options that affect how most reports appear, choose Page Setup from the File m
Page Setup, you are given a first and second choice in name preferences from which to choose. If th
field for the first choice is blank, Ultimate Family Tree uses the name entered in the second choice. I
second choice name field is blank, Ultimate Family Tree defaults to the Main name field. This gives y
option to use a woman’s married name instead of her maiden name. You can also use aliases or a re
name. If a name is entered in the Long Name field of the Miscellaneous window, the Long Name is u
instead on free-form reports such as Family Journal reports.

Some reports, such as the Family Journal reports, override the Name Format selections to comp
National Genealogical Society and New England Historic Genealogical Society styles. Also, the Desc
Box Chart functions independently of the Page Setup window. Use the Box Chart Page Setup windo
the Chart window itself to select page and formatting options for Box Charts.

Figure 5-2: Page Setup Window (left side)
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to be printed in reports

Prints name in reverse order
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Choose any of the options to customize your report:

• Book Title — Prints in the header of every page in reports. Limited to 25 characters.

• Name Format — Capitalizes and uses bold for Given names or Surnames. Select Surname 1st t
the Surname before the Given name.

• Name Preference — Prints the preferred name in reports.

Note In the Ultimate Family Tree Miscellaneous window (opened from the Individual Record w
dow) you can enter many variations for a person’s name.

• Page Layout — Sets the page layout in reports. Select Reverse Odd/Even to use an odd/even p
number layout. Check Preparer to include the preparer’s name in the footer of the report. If you
preparer, select either Name or Name/Address. Check Date to include the date in the footer. C
Header/Footer Lines to insert header and footer lines on each report page.

• Index Additions (RTF) — Adds information to names in the index. Select Birth/Death Years to add
birth and death years to names in the index for RTF reports. Select Record Numbers to add rec
numbers.

Note The preparer’s name is the name you entered in the Researcher field in the Project Inform
window. You might include “Prepared by:” before the name to have the footer of your reports pri
in this way.

Changing Font Style and Size
To select different fonts for the various components of a report, choose Page Setup from the File me
Ultimate Family Tree default fonts are Ariel and Times New Roman. Suggested font sizes for each co
nent follow:

Figure 5-3: Page Setup Window (center)
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Include preparer’s name in footer

If preparer is included,

lines on each report page

select either option

Fully justify text

Include date in footer

Add birth/death years

Add record numbers

to names in index

to names in index



8 8 SE C T I O N 5 : PR I N T I N G  RE P O R T S

indows 
s both 
 is set 
f lines 
 use a 
• Book Title 16

• Page Number 12

• Chapter Name 14

• Section Name 12

• Text 10

• Small Text 9

• Notes 8

• Index 9

• Preparer/Date 8

Specific fonts, font styles, and font sizes can be changed for various components of a report. W
scalable fonts can be used in Ultimate Family Tree reports. However, Ultimate Family Tree determine
the font style and size in Box Calendar and in all List reports. In Family Tree reports, only the font size
by Ultimate Family Tree—you can change the font style if you want. The index uses a fixed number o
on a page. It is designed to use a 9-point font. White space will occur at the bottom of the page if you
smaller font size. A larger font size can cause overflow to the next page.

1. Select the report component (for example, Book Title).

2. Choose the Fonts button.

3. Select a font from the Font list.

4. Select a font style: Regular (upright), Italic, Bold, or Bold Italic.

Figure 5-4: Page Setup Window (right side)

Report components

Font type and size for
selected component Change font type and size

for selected component
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5. Select a font size.

6. Choose OK to close the Font dialog box.

7. Repeat steps 1–6 for each of the remaining report components.

Basic Steps for Printing Reports
Each report window provides options for customizing and tailoring a report to your needs. Ultimate F
Tree uses the options you select to format and create the reports. Report windows share some or all
same options. The following basic steps are used to print Ultimate Family Tree reports.

1. Choose a report from the Reports menu.

2. Click the Find button on the Toolbar or Press F10 to find the individual you want to use as the fo
the report. See page 80 for information on using the Find Individual window. Some reports, suc
Calendar, Index, End Notes, Text and List reports, do not require a focus person.

3. Type a Chapter Title (up to 40 characters). A title is required if you want to include this report in
index, the table of contents, or in end notes reports. A title is not required when using Print Prev
The report title is used as the chapter name and appears at the beginning of the report.

4. Choose any of the available options for customizing the report.

5. Enter a number in the Generation limit field (if available) to limit the number of generations inclu
in the report.

6. To include an introduction in a report, check Introduction, and then choose Intro Text to open a
form text window where you can write introductory text for the report or chapter. The text windo
consists of an area for entering text, and a list of command buttons for formatting that text. See
page 37 for more information on formatting text. See page 39 for information on using the impo
ton if you want to import introductory text from an external text file.

Figure 5-5: Font Dialog Box

List of available fonts
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7. To use a subset of the individuals in your project, locate and list individuals in your project that 
specific criteria and add them to the Grouping list. You can then use the options in Grouping to 
your printed reports to those individuals in the Grouping list. Check the appropriate boxes to inc
the following options:

• Use List (in the Grouping box) — Prints a report which includes only those individuals who are in
Grouping list.

• Add Asterisk — Prints a report including all individuals but with an asterisk to indicate those in th
Grouping list.

Note The Grouping option is available in Family Tree (Pedigree), Descendant, Relationship, F
Group, Calendar and List reports

8. Choose the Print or Preview button on the report window.

Note Print Preview is not available if you choose Print to File in the Print Setup window. In this c
choose Print to print to a file. A Save As window opens when the report is formatting. Type a file 
for the report file, without an extension. Ultimate Family Tree automatically adds the appropriate
extension to the print file. Select the drive and directory where you want to place the report file.
current directory will be displayed above the directory listing box. You can then preview, edit, an
print the report from your word processing program.

Print Window
After selecting a destination for reports and Page Setup options for printing, you can print reports in U
mate Family Tree in two ways: Print or Print Preview. See Print Preview on page 91 for information a
previewing and printing a report.

Use the Print command to print and collect several reports in a book format. In the Print window
can choose a starting page number for a report, collect an index for each chapter, and include the re
you’ve generated in a table of contents.

1. Open a report window and choose the report options you want. Choose Print in the report wind
from the File menu to open the Print window.

2. The Print window includes options for printing reports. If you want to collect an index for the rep
select Collect Index. Check the Table of Contents check box if you want to include the report ch
name and page number in the table of contents.

Note If the selected report cannot be indexed or a chapter title has not been entered for the re
then Collect Index is not available. Reports that cannot be indexed include Box Chart, Calenda
Notes and Index. Collect Index is also not available if you are printing to a file. See page 85 for 
information.

3. Use the First Page field in the Book group to specify the first page number for the report in rela
the entire book. This number appears in the report header. The number in this field defaults to th
available page after you have printed a report. Use this field to skip one or more pages when pr
multiple reports.
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4. In the First Page box in the Report group, enter the page to start the report. If you want to print
five, enter 5 in the First Page field. The First Page field determines which page of a report will b
printed, not the page number that appears at the top of the page.

5. In the Last Page box in the Report group, enter the page number to stop the report. If you want 
only pages five and six of the report, enter 5 in the First Page field, and 6 in the Last Page field

6. Enter the number of copies of the selected report to be printed in the Copies box.

7. Use the Reset buttons to clear all Table of Contents, End Note and Index entries that have bee
lected and stored for previous reports. Choose Reset TOC to clear all entries from the Table of 
tents report window. Choose Reset Notes to clear all entries from the End Notes report window
choose Reset Index to clear all entries from the Index report window.

Note The Reset buttons are dim if a Table of Contents, End Notes, or Index has not been colle
and stored in the respective report windows.

8. Chose OK to start printing the report or collecting the index.

Print Preview
Print Preview shows how a report will appear when printed. While previewing the report, you can prin
entire report or a single page of the report. Use Print Preview to print a single copy of a stand-alone r
When using Print Preview to print instead of using the Print window, be aware of the following differe

1. All reports start with page 1.

2. The report is not included in a table of contents.

3. The report is not included in the index. (An index for the previewed report can be created, howe

4. The footnotes are not stored in the End Notes report window. (End notes for the previewed rep
be created.)

Figure 5-6: Print Window

Include chapter in
Table of Contents

Print report for

Collect index for
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active report window
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Using Print Preview
1. To use Print Preview, open the window for the report you want to prepare.

2. Choose the report options you want.

3. Choose the Preview button in the report window or Print Preview from the File menu.

Note If the Preview button or Print Preview from the File menu are dim, either the Report windo
not open or the report is set (in the Print Setup window) to print to a file.

4. Enter the first page of the report you want to view in the First Page field. If you want to view page
enter 5 in this field. To preview from the beginning of the report, leave this field set to 1.

5. Enter the last page of the report you want to preview in the Last Page field. If you want to stop 
viewing at page ten, then enter 10 in this field. To view the entire report, leave this field set to 99

6. Choose Report, Notes, or Index for the selected report. Choosing Report allows you to preview
selected report before printing it.

7. Select the Notes option if you want to view and/or print the end notes (footnotes) for the report.
Notes option is not available for reports that do not include End Notes, such as the Family Tree
gree) and Images reports.

8. Select the Index option if you want to preview the index before printing.

9. Choose OK.

Note When you preview your report, the first page of the report is displayed on the screen. At th
of the Preview window is a Toolbar used to control the view of the report. Select the options for 
ing the report.

10. Click the Printer button in the Print Preview Toolbar to print the report you just previewed.

Figure 5-7: Print Preview Window

Preview active report

Preview end notes

Preview index

for active report

for active report
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Preparing to Print a Book
Before printing the first page of your book, you should prepare an outline. It does not have to be elabo
simple list of the reports, in order, will do. This is also the time to make decisions about what other in
tion to include and where to place it. Use this outline to keep track of formatting and to make other no
yourself for printing. Here is a sample outline:

• Title Page

• Table of Contents

• Introduction

• Family Tree (Pedigree) Report

• Map–two page spread, start on left page

• Reverse Register Report

• Relationship List

• Index

Suggestions on Style
Two of the most common ways to arrange genealogical records in a book are ancestral order and descendant 
order. Ultimate Family Tree is designed to automate preparation of these types of books.

Ancestral-Ordered Book An ancestral-ordered book is the history of an individual back to his
her distant ancestors. Many people choose to prepare a book about parents or grandparents, and in
complete history of their family or just a portion of it. Here is a typical format:

• Title Page

• Table of Contents

• Introduction (Text Report)

Figure 5-8: Print Preview Toolbar
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report 1st page 1 pageZoom in
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• Family Tree (Pedigree) Report for the person the book is about

• Reverse Register Report (Family Journal Report)

• Ancestor (Ahnentafel) Report

• Relationship List Report

• End Notes

• Index, Individuals

• Index, Marriages

• Index, Places

Descendant-Ordered Book A descendant-ordered book singles out an ancestor and traces h
her children, grandchildren, and all other documented descendants to the present day. If you choose
mat and have a large family, you might find there is so much information to be presented that you sh
divide the book into separate volumes (one or two children of the ancestor per volume). Here is a po
format:

• Title Page

• Table of Contents

• Introduction (Text Report)

• Descendant Report

• Register Report (Family Journal Report)

• Relationship Report

• End Notes

• Index, Individual

• Index, Marriages

• Index, Places

After deciding on your outline, be sure to open the Print window and reset the Table of Content
Index, and End Notes so that the final output will not contain any erroneous data from previously prin
reports. Collect the index before printing each report so that the starting page numbers will match. Af
lecting the index and printing each report, print the Table of Contents and End Notes reports, edit the
(if necessary), and print the Index report.

See page 89 for basic steps for printing reports. See page 118 for steps to collect an index. See
for information on resetting Table of Contents, Notes and Indexes.

Another option for printing a final book is to print the reports to an RTF file that can be opened w
many word processors. The table of contents and index codes are transferred with the report and are
in the word processor. Any page numbering changes are reflected in the Table of Contents and Index
generated by the word processor. You can then further customize your reports by changing margin s
moving text, rewriting sentences, and adding pictures within the report text.
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Title Page Report
The Title Page normally contains the book title, subtitle (if applicable), author, publisher, date, and loc
of publication. To open the Title Page window, choose Title Page from the Reports menu.

The following fields are available in this window:

• Title — Enter the title of the book in this field (up to 48 characters), for example, you might title 
book The Kennedys. The title prints in a large font in the center upper third of the page.

• Subtitle — Enter a subtitle for the book of up to 48 characters. For example, The Descendants o
Joseph Patrick Kennedy. The subtitle prints below the title in a smaller font.

• Title Page Text — When chosen, this check box opens a free-form text window where you can e
text to be printed on the book title page. You can include the preparer's name, the date the boo
written, and the publisher information, or any other text you want.

Note The Title Page Text information is right justified and prints in the lower-right corner of the 
page. The text can be formatted as bold, italics, and/or underline. Ultimate Family Tree prints up
lines of text, approximately 40 characters per line. Lines containing over 40 characters of text w
the next line. Any text over ten lines is cut off. To create a new line press the ENTER key twice.
Choose Preview to see how the text will appear. Blank lines are included in the ten line-limit.

• Borders — Select a border style from the Border Style drop-down list to print a border on the Tit
page. Choose None in the list for no border.

Figure 5-9: Title Page Report Window

Click to open text window
for title page

Choose border style for
for title page from
drop-down menu
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Family Journal Report
The most widely accepted formats for publishing a genealogy in the United States are the New Engla
toric Genealogical Society’s Register and the National Genealogical Society’s Modified Register plan
can use options available in the Family Journal Report window to create either of these formats. The 
ities between the two are substantial; the differences are slight but significant.

Family Journal Report Styles
Both formatting plans begin with one person. This person is given the number 1, indicating the positi
the first person in this first generation. The children of the progenitor are assigned, in order of birth, a
Roman numeral. In addition, each child can be given an Arabic number that establishes that child’s o
placement in both the specific family and the larger family described in the report. These numbers (b
Roman and Arabic) precede the name. All family members are placed in their respective generations
generation numbers appearing as superscripts following the first name. In the report, each primary p
name is followed by a back reference, in parentheses. The back reference includes the given names
eration numbers of each person in the line back to the progenitor.

Here are the differences between the plans:

• In the Register format, only children whose lines continue are given Arabic numbers. In the Mod
Register format, all children receive an Arabic number. In both cases, these numbers are in birth
and begin (for the eldest child) with the next number after the last one used in the previous gen

• In the Register format, children whose lines continue are clearly identified with an Arabic numbe
the Modified Register format, with all children bearing such a number, a plus (+) is placed in fro
the number to indicate children whose lines continue.

• In the Register format, the main individual’s names print in bold, uppercase letters. In the Modifi
Register format, the main individual’s names print in bold, upper/lowercase letters.

• In the Register format, notes are embedded in the text. In the Modified Register format, the note
as end notes.

Printing a Family Journal Style Report
1. Click the Family Journal button on the Toolbar, or choose Family Journal Format from the Repo

menu.

2. Choose one of the following styles:

• Modified Register (National Genealogical Society style, NGS) — Select this style to print footnote
end notes, number all children, and a use a plus (+) to indicate a child whose line continues. Th
individual’s names print in bold upper/lowercase letters.

• Register (New England Historic Genealogical Society style, NEHGS) — Select this style to inclu
footnotes as embedded notes and to number only those children whose lines are continued. Th
individual’s names print in bold, uppercase letters.
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3. Choose Section New Page to start each generation on a new page.

4. After establishing the style of Family Journal report, choose one of the following options to dete
the order in which your data will print:

• Descendant — The Descendant Family Journal Report starts with a progenitor (the selected anc
and traces his or her family line to the present. The individual selected is the subject of the first 
ation section.

• Family — The Family Report creates a descendant-style report for all families in the project with
family in a chapter in alphabetical order. Note that an end-of-line progenitor female must have e
spouse or father entered to be included because the Family Report is based on male surnames

• Reverse Register — The Reverse Register Family Journal Report starts with a descendant (the se
individual) and traces his or her line back through all ancestors. The numbering system used in
reports is the same as that used in the Register or Modified Register, but in reverse. Here you b
with a selected individual and move backwards in time.

5. Choose any of the other options by clicking the corresponding boxes:

• Include or exclude events and Event Text.

• Estimate Missing Births. Choose this option to estimate the birth date from other events when n
date is available.

• Set number of generations to include in report.

• Compress Footnotes. Choose this option to reuse footnote numbers for identical footnotes.

• Add Other options.

• Check to include Introduction (introductory text entered by clicking the Intro Text button).

Figure 5-10: Family Journal Report Window

Choose report style

Start each generation
on a new page
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6. Print the report. See page 89 for basic steps for printing reports.

Note The compressed footnote style does not conform to the recommendations in Chicago Manual 
of Style or Cite Your Sources by Richard Lackey. It is provided only to reduce the number of pages
required to print end notes.

Ancestor Reports
Ultimate Family Tree provides two kinds of Ancestor reports, Pedigree and Ahnentafel.

Family Tree (Pedigree) Chart
The Family Tree Chart graphically traces ancestral lines back through an individual’s parents, grandp
and so on. It starts with an individual and traces the family lines for each parent. In Ultimate Family T
you can choose to print four, five, or six generations on each page of a report. You can also print a bl
Family Tree Chart.

The Family Tree Chart allows room for a variety of data. Information on a four-generation Family
Chart includes the date and place of the birth, death, marriage and resides events (if known) for each
ual. If dates and places are unknown, the corresponding line on the chart is blank. Because of limited
five- and six-generation charts include a subset of the above information.

A number is associated with each person’s position on the Family Tree Chart. These numbers a
erencing system to keep track of a pedigree that fills more than one page. The Family Tree Chart can
back 54 generations. For a line that continues past the last generation on a page, Ultimate Family Tre
“continued on later chart” reference.

To print a Family Tree (Pedigree) Chart:

1. From the Reports menu, choose Ancestor, and then Family Tree.

Figure 5-11: Family Tree (Pedigree) Chart Window

Include only those
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Print blank family tree
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2. Select the number of generations to include per page from the Format group.

3. Select Blank Report to produce a Family Tree Chart form for use in research.

4. Check Omit Redundant Ancestors, if desired. (Redundant ancestors occur when cousins marry

Note If Omit Redundant Ancestors is checked, the first occurrence of a redundant ancestor in
all of his or her information. Any recurrence of the redundant information is referred back to the
occurrence, by citing the previous chart, and the redundant line is not continued.

5. Check Use List to include only those individuals in the Grouping List.

6. Check Add Asterisk to print an asterisk next to the name of each individual in the Grouping List

7. Print the report.

Space available for names is limited in the Family Tree Chart. If necessary, Ultimate Family Tre
shortens names by abbreviating the middle names, one at a time, and then the first name, until the n
in the available space.

Abbreviations for events included in the report print before the event:

• b. birth

• d. death

• m. marriage

• r. resides (prints if the person has a resides event or is still living)

Ancestor (Ahnentafel) Report
An Ancestor Report is a Family Tree Chart in text rather than graphic form. The Ancestor report lists 
tors for up to 50 generations. All ancestors included in the Ancestor report are given a number from t
Ahnentafel system. In this system, a unique number is assigned to each position in the pedigree rega
whether or not a person is occupying that position. Ahnentafel numbering assigns the number 1 to th
ing individual. The father’s number is two times his child’s number, and the mother’s number is two tim
her child’s number plus one.

With these position markers you can quickly determine exactly how any person on the chart is r
to the starting person. For example, the label, great-great-grandfather, reveals that the ancestor is fo
ations back and is male. A great-great grandfather can be any one of eight people. Ahnentafel numb
however, is the maternal grandfather’s mother’s father (for the selected individual).

To print an Ancestor (Ahnentafel) Report:

1. From the Reports menu, choose Ancestor, and then Ancestor Report.

2. From the Style section, select any of the three options:

• Compressed — Removes white spaces from the report

• Generation Lines — Prints lines between generations

• Bold Ancestor — Prints names in bold type
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3. In the Events group, choose whether or not to include the individual’s events on the report, or c
to create an abbreviated Ancestor report that contains only Ahnentafel numbers, names, and d
birth and death.

Note If you select Birth/Death Dates or No Events, the option to include Event Text cannot be 
selected.

4. Check to include options in the “Other Group” or an introduction.

5. Print the report. See page 89 for basic steps for printing reports.

Descendant Reports
Ultimate Family Tree provides four different styles of Descendant reports: Indented, Text, Direct Drop
Box Chart.

Indented Descendant Report
The Indented Descendant Report window prepares a descendant chart that starts with the progenito
family line and follows all descendant lines to their ends. Each generation is indented from the previo
eration. Up to 16 generations can be included.

1. From the Reports menu, choose Indented Descendant, or press the Descendant report button 
toolbar.

2. Choose to include any additional options from the Contents group. Choose Other Spouses incl
spouses from marriages with no children.

Figure 5-12: Ancestor Report Window
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3. Choose Use List to include only those individuals in the Grouping List.

4. Set the number of generations (up to 16) for the report.

5. Enter a number in the Extra Indent box (from 0 to 10) if you want to increase the number of col
that each generation is indented. When Extra Indent is 0, generations are indented three colum
to ten extra columns can be added for each generation. Use Print Preview to view the results o
the Extra Indent option and name shortening.

Note You can change the spacing between generations for ease of reading with the Extra Inde
option. This option is useful when there are only a few generations or when names are short. Th
for names is based on the options selected to be printed: generation number, birth and death da
record numbers. If a name does not fit in the available space, Ultimate Family Tree shortens the
so it will fit. If a common name has been entered in the Miscellaneous Information window, the 
mon name is used when a name is shortened.

6. Print the report. See page 89 for basic steps for printing reports.

Descendant Text Report
The Descendant Text Report is a descendant report in text style that offers several generation numb
styles: Generation Number, Henry Number, Modified Henry, and D’Aboville. Information included in t
report is dependent on the options chosen in the report window.

1. From the Reports menu, choose Descendant Text.

2. Choose a numbering style:

• Generation Number — The generation number for each descendant is included with his or her nam
Descendant Text Reports.

Figure 5-13: Indented Descendant Report Window
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• Henry Numbering System — A genealogical numbering system where the progenitor, or a selecte
individual, is given the number 1. The oldest child is number 11, the next child the number 12, et
oldest child of number 11 is number 111, the next is 112, etc. When there are more than nine ch
the numbers are placed in parentheses.

• Modified Henry Numbering System — A genealogical numbering system that is similar to the Henr
system except that instead of using 10, 11, 12 in parentheses for the tenth, eleventh, and twelft
dren, the letters A, B, and C are used. If there are more than 35 children, lowercase letters are u
example, a, b, c, for the thirty-sixth, thirty-seventh and thirty-eighth children.

• D’Aboville Numbering System — A genealogical numbering system where the progenitor, or selec
individual, is given the number 1, the first child is given the number 1.1, the second child is give
number 1.2, etc. This system is similar to the Henry Numbering System, except that each indivi
number includes periods to separate generations. For example, 1.2.2 indicates that an individua
second child of the second child of the progenitor for this family line.

3. Choose one of the options in the Events group to determine which events will be included in th
report: All, Basic (Birth, Marriage, Death, and Burial), or No Events.

4. Include additional options from the Other group.

5. Include only individuals found in the Grouping List by selecting Use List. See page 78 for inform
on grouping.

6. Choose Add Asterisk to add an asterisk to individuals in the report who are in the Grouping List

7. Print the report. See page 89 for basic steps for printing reports.

Figure 5-14: Descendant Text Report Window
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Direct Drop Descendant Report
The Direct Drop Descendant chart shows how two people are connected through a direct line. It star
an ancestor and traces his or her direct family line to any descendant you choose.

1. From the Reports menu, choose Direct Drop.

2. After choosing a start person, click the Choose button to open the Choose Descendant List win
The list includes the starting person and descendants.

3. Select the descendant you want as the ending person on this report, then double-click the nam
close the Choose Descendant window by pressing Escape or choosing the Close box.

4. Choose to include any additional options from the Contents box: Record Number and/or Birth a
Death Dates plus an introduction.

Note The space for names is limited. If a name does not fit in the available space, Ultimate Fa
Tree shortens the name so it will fit, abbreviating the middle names (one-by-one) and finally the
name.

5. Print the report. See page 89 for basic steps for printing reports.

Note If you choose to include introductory text, the Direct Drop report starts on the next full pa

Descendant Box Chart
Ultimate Family Tree includes an option to print a beautiful family tree or Box Chart as either a page 
included in a family history book or as a wall chart. There are many styles, fonts, and border options 
which to choose to customize a unique chart. The contents of charts can be edited and saved for futu
sions. Up to 16 generations of descendants can be included.

Figure 5-15: Direct Drop Descendant Report Window
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Creating a New Box Chart
1. From the Reports menu, choose Box Chart, or choose the Box Chart report button on the Toolb

open the Box Chart window.

2. Choose New in the Open Chart group.

3. Type a name of up to eight characters in the Chart Name field. This is the control name that app
the Charts list.

4. Type a title (optional) for the chart in the Chart Title field. This title appears at the top of the char
dow and can be included on printed charts.

5. Enter a number in the Generation limit field if you want to limit the number of generations to be
included in the chart.

6. Choose Use List if you want to limit the report to only those individuals in the Grouping List. Us
Ultimate Family Tree search routines to locate and list individuals in your project that meet spec
criteria, and add them to the Grouping list. See page 78 for information on grouping.

Figure 5-16: Descendant Box Chart Window
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box chart
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Figure 5-17: New Chart Window
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7. Choose Design from the Contents group to open the Box Chart Design window.

8. Choose the appropriate options you want included in the chart. The sample window in the lowe
corner displays how the options chosen will appear in the boxes on the chart.

9. Select any of the options from the appropriate drop-down lists as described below:

Event Line 1 and Event Line 2 Groups

• Blank — Leaves corresponding event line blank

• Line — Includes a line in place of corresponding event data

• Birth — Includes birth event data on corresponding event line

• Birth and Death dates — Includes birth and death dates on corresponding event line

• Birth and Death years — Includes birth and death years on corresponding event line

• Selected Event (First) — Includes event chosen from Events list. Select this option and choose th
Events button. Select the event you want included in the report and choose OK. Only the first o
rence of the selected event is used.

• Date — Includes only the date for selected event

• Place — Includes only the place for selected event

• Date and Place — Includes date and place for selected event if checked

Note The birth and death dates and years options override selections in the Dates group.

Figure 5-18: Box Chart Design Window
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Marriage Group

• Blank — No marriage information

• Marriage Date — Marriage date

• Marriage date and place — Date and location of marriage

• Include Other Spouses — Includes other spouses for whom there are no descendants

Dates Group

• Year — Year of the selected event

• Short — Day, month, and year of selected event

• Structured — Date from structured date field, including the date modifier

• Long — Free-form date for the selected event

Note The Dates group options are not used if the Birth and Death dates or Birth and Death ye
options are selected in the Event Line 1 or 2 groups.

Event Name Group

• None — No name or abbreviation for the event

• Short — Short version of event name before event data (e.g., b. for birth)

• Medium — Medium abbreviation of event name (e.g., bir for birth)

• Long — Long version of the event name

Places Group

• First and Last — First and last levels of a place name (normally city and state)

• Last Two — Last two levels of a place name (normally county and state)

• Full — Full place name

• Modifier — Place modifier (e.g., in)

10. After making your selections, choose OK to return to the New Chart window.

11. Choose OK in the New Chart window to open the Chart window you have designed.

Note The Box Chart Design sets the overall design of a chart. Once the chart is created, the b
design options cannot be altered. However, changes, additions, and customizing details can be
from the Descendant Box Chart window, the Box Chart Page Setup window, and on the Box Ch
itself. These changes are reversible.



D E S C E N D A N T B O X  CH A R T 1 0 7

 not 

 from 

ing a 
ter 
 on the 

age and 

a book, 
 Book 
arts 

d date. 
he HP 
t sup-
Preparing a Box Chart for Printing
Selections made in the Box Chart Page Setup window are used only for printing box charts. They do
affect the default printer settings in Windows or other Ultimate Family Tree reports.

1. If a box chart is open, close it. Open the Descendant Box Chart window by choosing Box Chart
the Reports menu.

2. Choose Page in the Chart Setup box.

3. Select a paper size from the Paper Size list.

4. In the Orientation box, choose to print the chart in either Portrait or Landscape mode.

5. Select the default paper bin or choose a special bin in the Paper Bin box for your printer.

Note You can set margins for pages on the box chart. This is particularly useful if you are print
wall chart. Be aware that some printers (such as the HP LaserJet series) will not print on the ou
edges of the pages. In these cases, setting the margin to less than 1/4 inch will not be reflected
printed page. Type or select the distance between the top, bottom, left, and right edges of the p
the chart. Choose the Reset button to return to the default settings of 1 inch.

6. Choose OK to return to the Descendant Box Chart window.

7. Include one, two, or no events on the chart you want to print.

8. Choose whether you want to print a chart that will fit on a standard page and can be included in 
or one that is designed to be displayed on a wall, by selecting either Book or Wall Chart. Choose
to print charts with the Ultimate Family Tree headers and footers. Choose Wall Chart to print ch
without headers and footers.

Note Headers and footers can contain the book name, page number, preparer information an
If you are printing in landscape, only printers that support type orientation commands (such as t
LaserJet 4 and later) will print the headers and footers correctly. If you do not have a printer tha
ports type orientation commands, print landscape charts as wall charts.

Figure 5-19: Box Chart Page Setup Window
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9. Choose whether or not to include individual record numbers on the printed chart.

10. Choose Preview to open the Chart to be printed. With the selected chart open, choose Print fro
File menu.

Note The original Box Chart Design sets the overall design of a chart. Once the chart is create
basic design decisions cannot be altered. However, changes, additions, and customizing details
made from the Descendant Box Chart and Box Chart Page Setup windows, and on the Box Ch
itself. These changes are reversible.

Chart Window
Use the Toolbar at the top of the Chart window to modify the displayed chart. Three buttons on the le
of the Toolbar determine which functions are available. Click the Edit Graphics button to change the o
design of the chart, the Edit Colors button to make color selections, and the Edit Fonts button to chan
fonts used.

Edit Graphics You can select the number of boxes across and down to be printed on each p
the box border style, the line thickness between boxes and around the outside of the report, and the 
position for the chart title. View the changes on the chart as you make your selections.

1. Choose the Edit Graphics button and then choose an option within the Density drop-down list to
mine the number of boxes per page.

Note The number of boxes per page in the list depends on page size and orientation choices m
the Chart Page Setup window.

2. Select the style of box you want for the chart by choosing the Box shape button. A check mark a
next to the box style chosen for the displayed chart.

3. Select the size of the lines that connect descendants by choosing the Single Lines button. A ch
mark appears next to the size of the lines chosen.

Figure 5-20: Graphics Toolbar
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4. Select the size of lines that connect spouses by choosing the Double Lines button. A check ma
appears next to the choice.

5. Select a border for the entire chart by choosing the Border button.

6. Choose the placement of the title of the chart on the bottom of the chart by choosing the Title b
The title can be left justified, centered, or right justified.

Edit Colors Choose the Edit Colors button to display the Flags Toolbar where you can selec
ors for the various boxes. For example, you can choose to have boxes for males in red and boxes for
in green.

Note Choices appear in color on printed reports only if you have a color printer.

1. Choose the Edit Colors button to display three color options: red, green, or blue.

2. Choose a color button.

3. Choose the down arrow next to this color to select an attribute, such as male, female, or spous

4. Repeat steps 2 and 3 for the remaining color options.

5. Select the Legend button to include the color legend on the chart.

6. View the changes on the chart as you make your selections.

Edit Fonts Choose the Edit Fonts button to display the Font Types Toolbar where you can m
font and formatting choices. Available choices include:

• Record Number — The unique identifier for each individual.

• Event — Any event text that has not been selected as Event, Hilite in the Chart Edit window.

• Event, Hilite — Event text you have selected in the Chart Edit window by enclosing the target te
braces. See “Editing Names, Dates and Places in a Box Chart” on page 111.

• Names — The given name for each individual.

Figure 5-21: Flags Toolbar
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• Names, Hilite — The surname for each individual.

• Title — The title you have selected for the report.

• Legend — The key for color selection in the box chart.

1. Select a field from the drop-down list.

2. Select a font and size for the selected field.

3. Choose the i(talics) button to print the selected data in italics.

4. Choose the b(old) button to print the selected data in bold.

5. Choose the u(nderline) button to underline the selected data.

6. Repeat steps 1–5 for each data item.

7. View the changes on the chart as you make your selections.

Note Use narrow fonts to allow more information to be included in each box.

Additional Options for Display
Use the buttons on the Chart Display Toolbar for additional options.

1. Choose the Ruler button to display ruler guides for the chart.

2. Choose the Page Grid button to display pages and numbers. The page layout depends on the 
made in the Chart Page Setup window.

Figure 5-22: Fonts Toolbar
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3. Choose the Test Mode button to highlight boxes where text might overflow the boxes. These bo
displayed in red. Make changes to the font type and size or edit individual boxes until all boxes a
played in black.

Note The Test Mode function is most accurate when using a 100 percent or 200 percent zoom

4. Choose the down arrow next to the Zoom button to change the zoom factor for the chart.

Zooming Chart Areas
1. To drag a box over the chart boxes you want to zoom, position the mouse pointer over the top l

ner of the box, press the left mouse button, and drag the mouse pointer to the lower-right corne

2. Press the right mouse button, and then click the Zoom to Fit button.

Note Use the arrow keys to move around a chart and view parts not displayed on screen.

Editing Names, Dates, and Places in a Box Chart
The contents of each box can be edited while the chart is displayed.

1. Double-click a box to select it.

2. Click the Descendant Box Chart window to activate it. Click the Box Chart button on the Toolba
from the Reports menu, choose Box Chart to open the Descendant Box Chart window.

Figure 5-23: Chart Display Toolbar
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3. Choose Edit.

4. Insert braces { } around any portion of the data entered in Event Line 1 or 2 to designate it as E
Hilite. To format that portion of the text use the Font Types Toolbar in the Chart window. These b
do not appear in the report.

5. After making any changes, choose OK to return to the Descendant Box Chart window. Choose
to return to the Box Chart, or simply click on the chart itself.

Note Changes made to the contents of a box are stored with the chart and do not affect any d
the Project.

Finding an Individual in a Box Chart
1. To locate a person in the chart, press F10 or click the Find button on the Toolbar.

2. Type the first few characters of the name of the individual you want to locate (or the record num
known) and press Enter (or choose Find).

3. Choose OK to close the Find window and move the focus of the chart to that individual.

Viewing Multiple Charts at One Time
1. Open an existing chart.

2. Resize the chart to a smaller size by dragging one of its borders. See the Windows manual for 
information on resizing windows.

3. Move the chart, if necessary, to display the underlying Descendant Box Chart window (or from 
Reports menu, choose Box Chart).

4. Select another chart in the list and open it.

5. Resize this chart, if necessary, so that both charts display on the screen.

Note In addition to the scroll bars, you can use arrow, PgUp, PgDn, Home, and End keys to m
around a chart to view parts not displayed.

Figure 5-24: Chart Edit Window
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Deleting a Chart
1. In the Descendant Box Chart window, select a chart in the Charts List.

2. Choose the Selected button in the Delete Chart box.

3. If you want to delete all charts, choose All in the Delete Chart box.

Printing a Chart
1. With the chart open, choose Print from the File menu.

2. See page 89 for basic steps for printing reports.

Note Print Preview in the File menu is not available for Box Charts because the chart is previe
during customization.

Relationship List Report
The Relationship List report provides a list of everyone in the project related by blood to a specified in
ual. Grouping allows you to customize the list. (You could list those individuals with a specific SOUND
code, for example, or show those who are male and who were married more than once.)

Relatives are listed in order of degree of consanguinity, which is the number of steps in a family
between people. Ultimate Family Tree calculates the relationships for this report through 16 generati

1. Choose Relationship List from the Reports menu.

2. Include any additional options from the Contents group.

3. Print the report. See page 89 for basic steps on printing reports.

Figure 5-25: Relationship List Report Window
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Text Report
The Text Report allows you to create a free-form text report such as an appendix or an introductory c
for your book. This report can include a header, footer, and title.

1. Choose Text from the Reports menu.

2. Type a title for the Text report and choose the Text button to open an Edit Text window.

3. You can type up to 65,000 characters of text. Choose import in the Edit Text window to import a
external text file. See pages 39 for information on importing text. The indicator next to the Text b
is on when text is present.

4. Choose Print or Preview. See page 89 for basic steps for printing reports.

Image Reports
The two Image report styles in Ultimate Family Tree are Portrait and Gallery. The Portrait report print
image and text connected to the image. The Gallery report prints any combination of up to 20 images
single page. Ultimate Family Tree prints black-and-white and color images if your printer supports co
you want to include an image in the body of a report, such as the Family Journal report, you must se
report to a file (RTF) and import it into a word processing program where the image can be inserted. 
page 85 for information on printing to a file.

Printing a Portrait Report
1. Choose Images from the Reports menu, and then choose Portrait.

2. Select the Image you want to print from the Digitized Images list. The name of the selected ima
displayed at the top of the window.

Note OLE objects cannot be included in Portrait or Gallery reports.

Figure 5-26: Text Report Window
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3. Choose Caption and/or Description to include the caption and/or description you entered for th
image in the Multimedia Library. If you have not entered a caption or description for the image i
Multimedia Library window, you can enter one at this time but the caption and description enter
here will not be saved in the Multimedia Library. The caption prints directly under the image and
should be limited to 50 characters or less.

4. Choose Landscape, Portrait, or Square to determine the format of the image you’re printing.

5. Choose Edit and Crop to view and edit the file before printing. Choose OK to close the Edit win

Note Edit or crop the image before printing to guarantee that the image is properly positioned.
an image has been edited, the Ready indicator is green.

6. Choose the Print or Preview button to print the report. See page 89 for basic steps for printing r

Note Depending on your hardware, the image may not display with true colors or shades in P
Preview, even though the image will print correctly.

Printing a Gallery Report
1. From the Reports menu, choose Images, and then Gallery.

2. Specify the picture space by checking any one of the 20 image positions (1A through 4E).

3. Select the image for that position from the Digitized Images List.

4. Choose the Select Image button to place that image in the selected position.

Note Select AutoEdit to open the Edit and Crop feature automatically as you position images.

5. Choose Edit and Crop to view and edit the image file. Choose OK to close the Edit window. The
lery report is designed for images having a 2:3 landscape ratio. Use Edit and Crop to center the
After an image has been edited, the ready indicator is green.

6. Repeat steps 3–5 for the remaining images you want included in the report.

Figure 5-27: Portrait Report Window
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7. To remove an image from the report, select its position and choose Edit and Crop. Choose Can
return to the Image Gallery report window.

8. To replace an image, specify the space by selecting the image position, select a new image fro
Digitized Images List, and choose the Select Image button. Choose Edit and Crop to view and/
the replacement image file.

9. Choose the Print or Preview button to print the report.

Note The information entered in the descriptive name field for the selected image appears bel
image when printed.

End Notes Report
End Notes can be printed after you create footnotes. If Ultimate Family Tree does not find footnotes b
they have not been created or they have been reset, the End Notes menu selection is not available. 
Family Tree gives you a choice of including footnotes at the end of each chapter or report, or at the e
the book.

Note Notes that are compiled and numbered on a chapter-by-chapter (report-by-report) basis,
with number 1 for each chapter.

1. Choose End Notes from the Reports menu.

2. In the Contents box, choose which chapters will be included in the notes section: All or Selecte

3. If you choose Selected Chapter, highlight the chapter for which you want to print End Notes in 
Chapters list.

4. Choose one of the footnote options in the Style group:

Figure 5-28: Gallery Report Window

Indicates images
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• Long/Short/Ibid. — End notes are printed in long form the first time a bibliographic reference app
After the source is cited in full, the short form built from Abbreviation 1 and Abbreviation 2 is use
When successive notes use the same reference, the ibid. form is used.

• Long/Short — End notes are printed in the long form first, and then in the abbreviated form for s
quent references.

• Long — All references are printed in full.

5. Choose Print or Preview in the report window. See page 89 for basic steps for printing reports.

Note If you have chosen embedded notes for a Family Journal format report by selecting the R
ter format, source citations are included in the body of the report. Individual Record Footnotes a
Event Footnotes always print as end notes.*

Index Report
An Index is a list of individuals, marriages, or places with page numbers to reference where the name
riages, or places appear on various reports. The Index provides a reference to all reports and other m
included in a book. Ultimate Family Tree reports that cannot be indexed include Images, Calendar, E
Notes, Box Chart, and Index.

You can collect an index for a report either before or after you have printed the report, but be su
use the same option selections when collecting the index as you do when printing the report. We reco
collecting the index immediately before printing the report to prevent any errors in the index.

Note Because of differences in how printers process fonts and movement commands, the ind
accumulate errors. To review and correct the index before printing, choose Edit on the Index Re
window. See page 119 for information on editing an Index Report.

* The method used in Ultimate Family Tree for preparing and printing footnotes is covered by US Patent No. 5,097,418
dated March 17, 1992.

Figure 5-29: End Notes Report Window
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Collecting an Index
1. Open the report for which you want to print an index.

2. Set the options you want to include in the report.

3. Choose Print in the report window.

4. Type the page number of the first indexed page in the First Page field.

5. Select Collect Index.

6. Choose OK to start collecting the index.

Note If Collect Index is not available (dim) in the Print window, a title has not been entered in t
report window, the Print to File option is selected in the Print Setup window, or the report canno
indexed. Use a unique chapter name, or the new chapter index will replace the duplicate. Index
be printed at any time.

Printing an Index
You can print an index for a single report, or wait until you have collected the indexes for all the chap
your book.

Note The index uses a fixed number of lines on a page. It is designed to use a 9-point font. W
space will occur at the bottom of the page if you use a smaller font size. A larger font size can c
text to wrap to the next page.

1. Choose Index from the Reports menu.

2. In the Include box, choose the chapters to include in the Index report: All or Selected.

3. If you choose Selected Chapter, highlight the chapter in the Chapters list for which you want to
an index. This list displays the chapter names of all the reports for which indexes have been col
When creating reports, be sure to enter different titles for each chapter to avoid confusion when p

4. Include any other options by checking the appropriate boxes.

Figure 5-30: Print Window
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5. Select the type of index you want to print from the Index type drop-down list.

Note If any of the Index Type options are not available (dim), Ultimate Family Tree has not foun
associated index entry for the report.

6. Choose Use List in the Grouping box if you want to print an index for only those individuals in th
Grouping list.

7. Choose Print or Preview in the report window to print the report.

Note Ultimate Family Tree prints cross references to alternative names in the Index. For exam
you have entered a woman’s married name such as Jane /Smith/ in the Alias 1 field, and her maiden 
name, Jane /Doe/, in the Individual Record window, the index will print Smith, Jane, see Doe, Jane.

Individuals without surnames are listed at the beginning of the index in alphabetical order b
given name and indented on the page.

Editing an Index Report
Because of differences in how printers process fonts and movement commands, an index can accum
errors. The index can be reviewed and corrected before printing by choosing Edit on the Index Report w

Figure 5-31: Index Report Window

Include all chapters

Add to index

List of chapters to
include in index

Edit index

Figure 5-32: Index Edit Window
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The Index Edit window provides a list of all individuals, marriages, or places in the selected cha
Select the individual, marriage, or place you want to check from the list.

Editing Page Numbers
The pages in the chapter for the selected item are shown in the Page Numbers edit box. You can add
or remove page numbers. Ultimate Family Tree reorders the page numbers automatically, so don’t w
about keeping the page numbers in ascending order. Type a comma between page numbers.

Deleting Page Numbers
To delete the page numbers for a selected individual, choose Selected from the Delete group. To elim
the entire chapter, choose All from the Delete group. Note that you must repeat this last step for indiv
marriages, and places if you want to eliminate an entire chapter from the index.

Adding Individuals and Places
Individuals and places not already in the index can be added to a chapter. Choose Add, and then sel
the candidates list that is displayed. The individual or place you want to add must already be in the pr
be included in the candidates list.

Table of Contents
The Table of Contents lists chapters and page numbers to provide a general overview of the book’s c

1. From the Reports menu, choose Table of Contents. The chapters you have created and named 
in the Table of Contents Entries field.

Note The Table of Contents menu selection is dim until chapter titles have been added as you
reports.

Figure 5-33: Table of Contents Report Window

List of chapters that
have been created



F A M I L Y  GR O U P RE P O R T 1 2 1

of the 

rs in 

 and 
t 
Family 
Tree 
2. Enter a title for the Table of Contents Report. The title is centered near the top of the first page 
printed report.

3. Select a chapter name and choose Delete to delete a chapter from the list.

4. Choose Print or Preview in the report. See page 89 for basic steps for printing reports.

Note For proper text alignment during viewing, the text in the Table of Contents window appea
a different font.

Family Group Report
The Family Group Report contains detailed information about a family unit, which is a father, mother,
their children. The Family Group Report is useful during the research phase of a genealogical projec
because it provides a ready reference to facts about the family. You can use options on the Ultimate 
Tree Family Group Report window to customize the form depending on your needs. Ultimate Family 
provides an option to print a blank Family Group Sheet for research purposes.

1. Choose Family Group from the Reports menu.

2. Press F10, or click the Find button on the Toolbar to find the starting individual.

Note To print a blank Family Group report, choose Blank Report.

3. Choose from the following options:

• Basic — Includes only Birth, Marriage, Death and Burial events on the report.

• Extended — Prints all applicable events.

Figure 5-34: Family Group Report Window
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• Break Child Blocks — When not checked, moves the block of information for a child to the next p
if the entire block does not fit on the current page. Ultimate Family Tree does not move the bloc
doing so leaves more than 15 blank lines at the bottom of the page. When checked, splits block
child information across page boundaries to reduce white space.

• Mother/Father — Prints Mother and Father labels instead of Wife and Husband.

• Place Modifiers — When checked, the report includes the place modifier, for example, in.

• Preparer Info — Includes Preparer relationship information in the report.

Note To include the preparer name and address in the footer of the report, check Preparer in th
Setup window. When Preparer Info is selected as an option, the Preparer relationship informati
includes the relationship of the preparer to the husband and wife. (Only blood relationships are
included, not relationships by marriage.) The preparer relationship information prints above the 
on the first page. If the Researcher’s individual record number is entered in the Researcher # fi
the Project Information window, the blood relationship to the husband and wife is shown. If you d
want the relationship to show, enter 0 in the Researcher # field.

4. Choose one of the options from the Family section:

• Selected — Prints a single Family Group Report for the selected individual

• Plus Descendants — Prints Family Group Reports for the selected individual plus his/her descenda

• Plus Ancestors — Prints Family Group Reports for the selected individual plus his/her ancestors.

• All — Prints Family Group Reports for every individual in the project

Note If you select Plus Descendants, Plus Ancestors, or All, use the grouping option. You shou
complete a Vital Statistics search for those individuals who are married and/or have children. M
this search into the Grouping list and choose Use List in the Grouping box on the Family Group
Report window. By using these features, Family Group Reports will be printed only for those ind
uals who are married and/or have children.

5. If you choose Plus Descendants or Plus Ancestors in step 4 and want to set the number of gen
to print, enter the number in the Generation limit field.

6. Choose any additional options from the Other list.

7. Choose one of the options in the Child Marriage section: First (print only the first marriage for e
child), Last (prints only the last marriage for each child), All (prints all marriages for each child) 
None (excludes child marriages).

8. Choose Research to print a research version of the report. Research notes entered in the Indiv
Record Text and the Event Text window print as text if the Individual Text and the Event Text op
have been selected.

9. Choose Footnotes if you want to include footnotes at the end of the report.

10. Print the report. See page 89 for basic steps for printing reports.
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Note If an individual has more than one spouse, Ultimate Family Tree asks you to select one o
spouses from a list.

Single Family Group Reports contain vertical lines to separate columns of information. Mul
Family Group Reports do not use vertical lines.

Individual Summary Report
The Individual Summary provides a comprehensive report for individuals in your project. You have th
option of including any or all of the information that you’ve entered for selected individuals. By using 
Grouping option, you can create a customized report for whatever purposes you need. All information
footnotes is included.

1. From the Reports menu, choose Summary, and then Individual.

2. Press F10 or click Find on the Toolbar to find the individual for whom you want to print the repo

3. Choose the options you want to include in the summary.

Note To print multiple Individual Summary reports, place the individuals in the Grouping list an
check Use List in the Grouping box of the report window. See page 78 for information on using 
Grouping window.

4. Print the report. See page 89 for basic steps for printing reports.

Figure 5-35: Individual Summary Report Window
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Project Summary Report
The Project Summary Report contains comprehensive information on the current project. This report
include the project information, a file list, project statistics, and a system summary.

1. Choose Project from the Summary submenu in the Reports menu.

2. Include any of the options by checking the appropriate boxes.

3. Select Introduction and click Intro Text to enter an introduction.

4. Print the report. See page 89 for basic steps for printing reports.

The following information is provided in the Ultimate Family Tree Project Summary report when
System Summary option is selected:

• Processor — The microcomputer chip detected by Ultimate Family Tree. Note that Pentium proc
sors are reported as 40486.

• Graphics Card — The graphics card detected by Ultimate Family Tree. VGA/CGA is shown for C
and higher resolution boards.

• Default Drive — The drive where FAMGATH.EXE is located

• Directory — The current directory.

• Start Directory — The directory where Ultimate Family Tree was started.

• Disk Size — The size of the default drive.

Figure 5-36: Project Summary Report Window
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List Reports
The List Reports create tables of information for individuals, marriages, and sources. They also print m
lists or mailing labels, and provide a list of the data not transferred into Ultimate Family Tree via a GE
COM file.

Individual, Marriage and Source List Reports
1. Choose Lists from the Reports menu, and then choose Individual, Marriage or Source.

2. To select the items to include in the report, from the Field list, double-click an item (or highlight 
press Enter). To insert a selected field in the field list to the spot above the selected field in the S
list, click the Insert button at the bottom of the Selected list. When the selected field is added to
Selected list, the column numbers are updated.

The fields print in the order shown in the Selected list. To remove an item from the Selecte
using the mouse, double-click the item in the Selected list. Using the keyboard, select the item 
press the Enter key to remove it.

Note The Level 2 category for Birth and Death place names is generally used for the county.

3. Choose Skip 1st Column to omit the first column in the Selected list from printing. This gives the
ity to sort the list on the first column field, but not actually print the first column information. You 
then attach many reports side-by-side that are sorted using the same field without having to pri
redundant column over and over.

4. Choose Line Numbers to include them to the left of the first column.

5. Select one of the following font size options:

• Small — Allows the most information to be printed on a single page

Figure 5-37: Individual List Report Window
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• Medium — Uses a larger font size and therefore prints fewer columns

• Large — Uses the largest font size and prints the least amount of information

Note Selecting a font size determines the number of columns available for the report. The sma
the font, the more columns you are able to print. Ultimate Family Tree automatically determines
font size and style for the small, medium, and large options.

6. Print the report. See page 89 for basic steps for printing reports.

Mail List Report
The Mail List Report contains a complete or selected list of mailing addresses and phone numbers fo
viduals in your project. This list can be formatted and printed for mail labels. You enter mailing addres
and phone numbers for an individual in the Miscellaneous window opened through the Individual Rec
Ultimate Family Tree automatically determines the font size and style for Mail List reports.

1. From the Reports menu, choose Lists, and then Mail.

2. Select the order in which you want the addresses to be printed.

Note The name entered in the addressee field can be different from the name in the Individua
Record window, such as Mr. and Mrs. Thomas Smith instead of Nancy Smith. Ultimate Family T
does not differentiate between first and last names in the Mail Label window. Mr. and Mrs. Thom
Smith will print in the mail list before Nancy Smith, if the Label Name radio button is selected, 
because M comes before N in the alphabet.

3. Choose one of the formats from the Format list.

• Ultimate Family Tree Report, 2 across (full page) — Prints an address list on a full page, two acros
with headers and footers

Figure 5-38: Mail List Report Window

Use name from
Mail Label window
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• 3 1/2" ́  15/16", 1 across (Avery 4145) — Prints mailing labels, one across on 3 1/2 ´ 15/16-inch 
Avery brand or equivalent dot matrix pin feed labels

• 3 1/2" ́  15/16", 2 across (Avery 4030) — Prints mailing labels on 3 1/2 ´ 15/16-inch Avery brand or 
equivalent dot matrix pin feed labels, two across

• 2 1/2" ́  15/16", 3 across (Avery 4144) — Prints mailing labels on 2 1/2 ´ 15/16-inch Avery brand or 
equivalent dot matrix pin feed labels, three across

• 2 5/8" ́  1", 3 across (Laser) — Prints mailing labels on 2 5/8 ´ 15/16-inch laser printer labels, three
across (30 per sheet)

• 4" ´ 1", 2 across (Laser) — Prints mail labels on 4 ´ 1 inch laser printer labels, two across (20 per 
sheet)

4. Enter a title you want to be printed at the top of the mail list. This field is available only when the
mate Family Tree Report format is selected from the Format list in this window.

5. Adjust the size of the left margin on the mailing labels by entering the margin size, in inches, in
field. This field is not available when the Ultimate Family Tree Report format is selected.

Note Names and addresses are cut off if the text does not fit on the label. Take note when ent
address information.

6. To include introductory text in your report, enter the text in the Intro Text window and choose In
duction. These options are available only when the Ultimate Family Tree Report format is selec

7. Print the report. See page 89 for basic steps for printing reports.

Note Ultimate Family Tree determines both the font style and size in all List reports, including 
Mail List.

GEDCOM Exceptions List Report
The GEDCOM Exceptions List prepares a list of data that did not transfer into Ultimate Family Tree th
a GEDCOM file. You can also view the missing data on screen by choosing Projects from the Utilities 
and then choosing GEDCOM Exceptions to open the GEDCOM Exceptions window.

1. After importing a GEDCOM file, choose Lists from the Reports menu, and then GEDCOM Exce
tions.

2. To select the items to include in the report, from the Field List double-click an item (or highlight 
press Enter). To insert a selected field in the Field List to the spot above the selected field in the
Selected List, click the Insert button at the bottom of the Selected List. When the selected field 
added to the Selected List, the column numbers are updated.

The fields print in the order shown in the Selected List. To remove an item from the Selecte
using the mouse, double-click the item in the Selected List. Using the keyboard, select the field
press the Enter key to remove it.
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3. The choices available and columns used are:

• File Position — The position (number of characters from the start of the GEDCOM file) in the GE
COM file where the exception is located

• Level — The level number of the exception in the GEDCOM file. For example, the BIRT tag for a
individual is level 1 and the DATE tag under the BIRT tag is level 2

• Error Tag — The GEDCOM tag to which the exception belongs, such as PLAC or DATE

• Error Text — The text or information that did not import into Ultimate Family Tree

• Indiv No — The individual record number in Ultimate Family Tree for the individual associated w
the exception

• Event Type — The name of the event in Ultimate Family Tree (such as Birth) that is associated w
the exception

4. Choose Skip 1st Column to omit the first column in the Selected List from printing on the report
can sort the list on the first column field, but not actually print the first column information. You c
then attach many reports side-by-side that are sorted using the same field without having to pri
redundant column over and over.

5. Choose Line Numbers to include them to the left of the first column for this report.

6. Select one of the following options for font sizes:

• Small — Prints the most information on a single page

• Medium — Uses a larger font and therefore prints fewer columns

• Large — Uses the largest font and prints the least amount of information

Figure 5-39: GEDCOM Exceptions Report Window
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The selections you make determine the number of columns available for the report. The sm
the font, the more columns you are able to print. Ultimate Family Tree automatically determines
font style and size for the small, medium, and large font options.

• Col/Page — Columns available on the report page for the font size selected. To increase this nu
use a smaller font size. To decrease this number use a larger font size.

• Col Used — Total columns used when selections are made from the Field List.

• Col Left — The number of columns still available.

7. Choose Print or Preview in the report window. See page 89 for basic steps for printing reports.

Calendar Report
Ultimate Family Tree produces a calendar that includes birthdays, anniversaries, and other events fo
all individuals in your project. The calendar can be customized by using the grouping option. You can
calendars in a box style or text style. Ultimate Family Tree determines the font size and style for text 
the day boxes in Box Calendar reports. Names in the Calendar can’t be printed in bold font.

Note The Calendar prints as it will (or did) exist for the date you select. If you select to print a c
dar for June 1948, only events that took place on or before June 1948 appear in the calendar. T
endar is designed as a stand-alone report and is not included in indexing, nor can it be exported
Text Format.

1. From the Reports menu, choose Calendar. Type in a chapter title. (The chapter title is used only
Text style calendar and is centered at the top of the first page.)

Figure 5-40: Calendar Report Window

Include birthdays

Only include birthdays
if person is still living

Only include marriage
if individuals are still
married

Include number of
years since event

Choose one
additional event

Include event
selected from list



1 3 0 SE C T I O N 5 : PR I N T I N G  RE P O R T S

endar 

y num-

oose 
alen-

iduals 
ho are 
. Ulti-
 the 
.

dow 
amily 

ilable 

ly one 
 the 

 this 

s 

 Family 

ent (if 
2. In the Starting Month field, enter the numeric equivalent for the month in which you want the cal
to begin. For example, October should be entered as the number 10.

3. Enter the year in which you want the calendar to begin.

4. Enter the number of months you want to print from the starting month and year. This can be an
ber up to 99.

5. Select any of the options in the Birth Group. To include birthdays of individuals in your project ch
Include. Select Alive to include birthdays for only those individuals who are still living as of the c
dar date. If Alive is not checked, all individuals in the project are included.

6. Select any of the options in the Marriages Group. To Include the marriage anniversaries of indiv
in the project, choose Include. Select Marriage to include the marriage anniversaries of those w
still married at the time of the date on the calendar. Years includes the number of years married
mate Family Tree uses the sort date for this number. The number shown is the number of years
couple has been (or would have been or will be) married at the time of the date on the calendar

7. Choose either Box or Text Style.

8. Check Use Grouping to include only those individuals listed in the Individual Grouping list.

9. Check Addresses to include the current address and telephone number from the Mail Label win
for the individual shown on the calendar. For marriages, engagements, and divorces, Ultimate F
Tree uses the first valid address it finds for one of the two individuals involved. This option is ava
for the Text Style Calendar only.

10. If you do not want to include an additional event in the Calendar report, skip to step 17.

11. Select an event from the list of Available Events.

Note On the Text style calendar, both individuals are shown for engagements, marriages and 
divorces when one of these events is selected as the extra event. In the Box style, however, on
individual is included for events that have two individuals connected. Ultimate Family Tree uses
first individual found.

12. Choose Include to include the event selected from the Available Events List on the right side of
window. The event selected is shown in the Event Group title field.

13. Choose Alive to include the selected event only for individuals who are still living.

Note An individual whose Living field is marked as unknown will not be included if this option i
selected.

14. Choose Years Since to include the number of years since the selected event occurred. Ultimate
Tree uses the sort date for the selected event to calculate this number.

15. Choose Abbr: (Box Style Calendar Only) to include an event name or an abbreviation for the ev
the event name is long) on the Calendar.
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16. Enter the event name, or abbreviation of up to 10 characters, in the Abbr: field. If nothing is ente
this field, only the name of the person connected to this event is printed. The abbreviation is us
the box style report. The text style report uses the full name of the event from the Event Library

17. Choose the Labels button to open the Calendar Labels window if you want to edit the month na

18. Enter any text in the Month Label field (up to 35 characters) that you want printed on the bottom
the Calendar. Leave this blank if you want only the month and year to be printed.

Note If you want to print a calendar with the months shown in a different language, edit the mo
name (up to 15 characters). The month is printed on the bottom right of the Calendar along with
year. You cannot change a month in this field, but you can rename it.

19. Choose OK to save changes and return to the Calendar report window.

20. Once you have made your selections, choose Print or Preview. See page 89 for basic steps for
reports.

Tiny-Tafel Report
The Tiny-Tafel Report is a shortened version of an Ancestor (Ahnentafel) list. The report contains one 
text for each family line. It also contains the surnames, time periods, and locations represented by tha
line, plus codes to signify the degree of interest in receiving information about the ancestors or desce
of that line.

Every family consists of a number of family lines. A Tiny-Tafel family line starts with an ancestor
(with a particular surname) for whom you have assigned an Ancestor Interest (AI) level and extends fo
in time to all descendants for whom you have set a Descendant Interest (DI) level. These interest lev
assigned in the Miscellaneous window from the Individual Record.

Figure 5-41: Calendar Labels Window

Remove month labels
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Note If more than one DI level is set in a family line, a new Tiny-Tafel line is created. You can h
two or more lines for the same family line with different interest levels.

For Ultimate Family Tree to establish a family line and create a Tiny-Tafel Report, you must set
Ancestor Interest (AI) Level for the earliest ancestor and the Descendant Interest (DI) Level for the la
descendant in a line.

Adding Ancestor and Descendant Interest Levels
You can easily add interest level flags to an existing project. For the AI level, use the Pedigree windo
spot the gaps in your family tree and identify the individuals whose line you want to extend back in tim
the DI level, use the Descendant window to move forward through a family line and identify the most r
individuals.

To get the most use out of the Tiny Tafel report, follow these guidelines when setting the AI and
levels in your project:

Interest level ranking

• 0 — The individual is not used to establish either the Ancestor or Descendant end of a line.

• 1 — No interest, and reliability of the data is marginal, making it of little interest to others, but us
establish one end of a family line.

• 2 — Low interest, but contains high quality data that might be of substantial interest to another 
researcher.

• 3 — Moderate interest; data quality is good or poor.

• 4 — Highest interest; data quality is good or poor.

Note Ancestor and Descendant Interest levels imported from ROOTS III are increased during im
to the next higher number. (For example, 1 becomes 2, 2 becomes 3, and 3 becomes 4. 0 does
change.)

1. Press F5, choose Individual Record from the Build menu, or click the Individual Record button o
Toolbar to open the Individual Record window.

2. Press F10 or click the Find button on the Toolbar to find the earliest ancestor in a family line yo
interested in.

3. Choose the More button, and then Miscellaneous to open the Miscellaneous Information windo

4. Enter the AI level.

Note Set the AI level only on the earliest ancestor in a family line you are interested in. Becaus
Descendant Interest Level setting higher than 0 will result in a separate Tiny-Tafel line for each 
vidual so marked, set the DI level only if you are interested in receiving Tiny-Tafel information fo
selected individual.

5. Choose OK.
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6. Press F10 or click the Find button on the Toolbar to select the most recent individual in the fami

7. Choose the More button and then Miscellaneous.

8. Enter a DI Level.

Note In most cases, a DI Level is used to indicate that you are interested in all descendants a
family line, so you can select the most recent individual in the family line for the interest level se

9. If you have a gap in a family line, use AI and DI to indicate that you would like to fill in the gap. 
the DI on the older end of the gap (because that individual’s descendants are missing) to 4, and
AI on the younger end (you want information on that individual’s ancestors) to 4.

Printing a Tiny-Tafel Report
1. Before opening the Tiny-Tafel Report window you should specify the destination for the Tiny-Ta

the Print Setup window. The Tiny-Tafel can either be sent to the printer or to an ASCII file. If you 
to create a file, give it the extension .TAF.

2. Choose Tiny-Tafel from the Reports menu.

3. Choose one of the AI/DI Threshold options.

Note Eight radio buttons are available to select what appears in the Tiny-Tafel report; four radi
tons are for the AI level, and four radio buttons are for the DI level. Select the appropriate radio b
in each column for the lowest interest level to be included in the Tiny-Tafel. If you select 2, then
est levels 2, 3, and 4 are included. If you select 4, only interest level 4 is included.

Figure 5-42: Miscellaneous Individual Information Window
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4. Choose Use List if you want to limit the individuals to be included in the Tiny-Tafel Report to on
those in the Grouping list.

Note To create a Tiny-Tafel for one line, use the Relationship Search feature to identify the line
then add the results to the Grouping list. You can also use the Miscellaneous Search window to
for an Ancestor and/or Descendant Interest level, and add the resulting people to the Grouping

5. Choose the Submitter button. A submitter is the person offering his or her selected genealogica
along with requests for further information.

6. Enter the submitter’s name of up to 38 characters plus spaces. Enter your name here exactly a
when you sign on to a bulletin board system. For example, if you use John Doe for the bulletin b
do not use John H. Doe in the header. This field is mandatory. The report cannot be created if t
mitter name (at a minimum) is not entered. The remainder of the header fields are optional.

• Address — Your mail address, up to four lines of 38 characters each

• Telephone — Your telephone number, up to 38 characters

Figure 5-43: Tiny-Tafel Report Window

Figure 5-44: Tiny-Tafel Submitter Window
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• Services — The communication services where you can be contacted, up to 3 lines of 38 charac
each. Generally, these lines will be in the form, Name of Service/ID Number.

• BBS — Enter the Name of Bulletin Board/Telephone Number that you are using, up to 38 chara

• Remarks — Remarks about the Tiny-Tafel, for example, how to send information other than on flo
disks.

• Disk Format — The disk format radio button that you would like to use to exchange information w
other individuals. The selections are 3.5" 720K, 3.5" 1.4M, 5.25" 360K, 5.25" 1.2M, and Other. O
specifies no specific disk format. If you want to receive the Tiny-Tafel information by telephone 
writing, state your preference on the Remarks line.

7. Choose OK to return to the Tiny Tafel Report Window

8. Print the report. See page 89 for basic steps for printing reports.

Note If you have created the Tiny-Tafel as an ASCII file, you can view and edit the file while in 
mate Family Tree. Choose Open from the File menu. Select Text from the File Type list. Select t
Files check box to view all files. Change to the drive and directory of the Tiny-Tafel file. Choose
Tiny-Tafel file. The Text window appears with the Tiny-Tafel file showing.
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Section 6:

Putting Your Family History
on the Web
 Wide 
ple 

 

Ultimate Family Tree can create Instant Web Page family histories suitable for publishing on the World
Web (WWW). The Modified Register genealogy report format is used for Instant Web Page files. Sam
family histories can be seen at http://www.uftree.com.

Strategy
• Plan your family history–style, format, graphics.

• Create or identify images in the Multimedia Library you want to use. Specify these as Preferred
Images for each individual. See page 164.

• Create the Instant Web Page using the Web option. See page 141.

• Preview the Instant Web Page.

• Register online with Palladium to reserve your web space.

• Upload your Instant Web Page.
1 3 7
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Cautions
• In preparing your web page, be sensitive to the wishes of other family members who may not w

certain information to be placed on the web.

• Be sure to include your email address so other researchers and family members can contact yo

• Remember that genealogical information is only as useful as its documentation. Cite your sourc

Creating an Instant Web Page
An Instant Web Page family history contains the following information:

• Family history name as entered in the Book Title field in the Page Setup window.

• Contact information for the author of the family history including an email link, researcher's nam
address, and telephone number as entered in the Project Info Window.

• Link to an optional GEDCOM file for downloading.

• List of surnames included in the report.

• Introduction.

• Family Journal (genealogy) report in the Modified Register format, using Descendant, Family or
Reverse Register.

• Footnotes and references linked to text in the report.

• Index of names in the report.

• Images connected to the Title, Introduction, or any individual in the report.

• A file in any accepted format. Currently these include .WAV, .AU, and .AIF.

• Links to other Universal Resource Locators (URLs). A URL in the Web Link field of the Miscella
neous Individual Information window links an individual to any other Internet URL. This link can
to images, sounds, or other genealogies. For example, you can link John F. Kennedy to a gene
another WWW site. If this genealogy is found at URL http://www.anothersite.com/jfk.html, enter this 
address in the Web Link field for John F. Kennedy. Someone browsing your genealogy can then
the link to move to the new page for JFK.
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File Organization
Ultimate Family Tree provides a number of options for saving a family history file. The family history ca
saved in:

• one file

• multiple files in a single directory

• multiple files in multiple directories

The option you choose depends on the size of the family history you wish to create and the capa
of the WWW server you will be using.

The main reason to use multiple files is to improve the speed. A large file takes a long time to lo
while small files can be accessed by a browser much more rapidly. The multiple-directory option allo
large number of files to be divided into separate directories. MS-DOS slows significantly when acces
directory having more than several hundred files. Use multiple files in multiple directories for uploadin
the Palladium Ultimate Family Tree web site.

Multiple File Option
The following files are created by Ultimate Family Tree when you choose the multiple file option:

• INDEX.HTM — The main family history file containing the table of contents, surname list, and in
duction.

Figure 6-1: Miscellaneous Individual Information Window

Enter URL to link 
individual to that URL



1 4 0 SE C T I O N 6 : PU T T I N G  Y O U R FA M I L Y  H I S T O R Y O N  T H E  W E B

l 
mber 8 

 
 exist. 
es 

amily 

 it will 
PH-

ck-

phic 

 the 

ed 
le 

g 
• Innnnnnn.HTM — Files for each main individual in the report. The record number of the individua
uses the format nnnnnnn, preceded by zero's. For example, a file for a person having record nu
would be I0000008.HTM.

• SOURCES.HTM — The source citations for the report.

• NINDEX.HTM — The name index for the family history.

• HTMFILES.TXT — A list of files created for this family history.

• name.TGZ — GZip compressed TAR (Tape Archive) when Web option is selected.

Multiple Subdirectory Option
Ultimate Family Tree places the main individual files in separate subdirectories when you choose this
option. The subdirectories are created automatically below the starting directory if they do not already
The number of files in each directory can be set from the Options window described later. All other fil
listed previously are located in the starting directory.

The subdirectories created by Ultimate Family Tree have the name Dnnn, where nnn is the number of 
the directory starting with zero. If you have 500 files and have set the directory limit to 200, Ultimate F
Tree will create three subdirectories, D0, D1, and D2.

Linking Files

Images
If a preferred image (see page 164) is linked to an individual who is included in the Web Page report,
be automatically extracted from your Multimedia Library as a .GIF file and located in the HTML\GRA
ICS subdirectory.

Additional image links are provided:

• Background — Provides a background texture for the family history. Not all browsers support ba
ground images.

• Header Graphic — Displays at the top of the first page. Use this for a family picture or graphic.

• Title Graphic — Appears at the top of the first page under the header graphic. Use this for a gra
version of your title. It replaces the chapter title.

• Bullet Graphic — Precedes the names of the children the first time they are introduced following
parents in each generation.

• GEDCOM Graphic — Precedes the URL for immediate downloading of the GEDCOM file specifi
on the entry line, left aligned. Available for the web option only. Be sure to specify a GEDCOM fi
name as described later.

• Email Graphic — Appears left aligned at the end of the document preceding the URL for sendin
immediate email. Available for the web option only. Be sure to include your email address as 
described later.
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• Table of Contents — Appears left aligned at the end of each page to go back to the main HTML p
It precedes the phrase, “Table of Contents.”

• Next Page Icon — Appears at the bottom of a page in multiple-page HTMLs.

• Previous Page Icon — Appears at the bottom of a page in multiple-page HTMLs.

• Horizontal Rule — Specifies a separator bar used to separate items in the report. Normally a na
page width image.

• Audio Graphic — Precedes the URL for transmission of a sound file. Be sure to specify the audi
name.

A number of graphic (.GIF) files are included with Ultimate Family Tree for your use. These gra
files are located in the \UFT\IMAGES subdirectory.

Sounds
You can also include a sound file.

• Audio File — Links a sound file such as a narrative description.

Immediate GEDCOM
You can specify a GEDCOM file so a viewer can display onscreen or save to disk a specific GEDCO
This file can be a compressed file created with a utility such as PKZIP.

Connecting to Palladium Interactive
Ultimate Family Tree can create Instant Web Page family histories suitable for publishing on the Web
Descendant Box Chart (which includes an Indented Descendant Report) and Modified Register Fami
nal Report are available as Instant Web Pages.

To connect directly to the Palladium Interactive web site, from the Online menu, choose Conne
Palladium Interactive or choose Go Online on the Toolbar.

Instant Web Page Tutorial
The following tutorial presents the sequence of steps you take to create a family history page on the 

1. From the Online menu, choose Instant Web Page or choose the Instant Web Page button on the 

2. Choose Family Journal or Box Chart. For information on creating a Box Chart Web page, see 
“Descendant Box Chart Instant Web Page” on page 244.

3. Specify the report options and starting individual for your report. The options on the Instant Web
window are similar to the options on the Family Journal report window. See page 97.
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4. Select Hide Living Info to suppress information about living family members. The names of livin
individuals and the connections to their families remain intact, however, events, including dates
places, will not be included in the Instant Web Page. The notation (still alive) prints after the name.

5. Select the Local or Web option in the Destination box as desired:

• Local — Creates HTML files for local viewing and is not meant for the Internet. This option omits
URL email and download links you have configured in the program, and will not archive the files for 

• Web — Prepares the HTML files for uploading to your server. This option inserts all URLs as co
ured. In addition to the HTML files, it also creates a compressed file suitable for uploading to a 
server. This file has the extension .TGZ.

6. Choose Options to open the Instant Web Page Options window.

Figure 6-2: Instant Web Page Window

Choose options
for Web page

Choose graphics
for Web page

Create HTML file for
local viewing only
Create HTML file for
uploading to server

Figure 6-3: Instant Web Page Options Window

Choose options to
include on Web page

Enter email address
(or leave blank)

Optional FTP address
for GEDCOM file
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Select any options as described below:

• Parent Images — Checks for images for all main individuals in the report. If found, the image is 
inserted in the web page describing the individual.

• Child Images — Checks for images for all children in the report. If found, the image is inserted in
web page for the individual’s parents.

• Project Information — Include information from the Project Information window in your web page

• Link to Palladium Interactive — When checked, includes a link on the family history that connects
the Palladium home page. Visitors can find out more about genealogy, the Ultimate Family Tree
gram and Palladium Interactive.

• Left Align/Center — Controls placement of images and section titles. Not all browsers support ce
ing; some simply ignore it.

• Single File — Creates one large family history file. Do not select this option if creating a web pag
uploading to Palladium Interactive

• Single Directory — Specifies a single directory when single file is not checked. Do not select this
option if creating a web page for uploading to Palladium Interactive

• Files Per Directory — Specifies the number of files you want in each subdirectory. Do not enter a
number larger than 500.

• Email Address — Provides your email address. When this field is left blank, your email address i
included in the Instant Web Page.

• FTP Address for GEDCOM File — Location displayed on web pages from which a file can be ftp’d

Note This is an optional way to provide a GEDCOM file for your Family History. Normally it is b
to include the GEDCOM file with the Instant Web Page.

7. Choose OK.

8. Choose the Graphics button in the Instant Web Page window.

9. Select any field and choose Browse to find an existing graphics file, or type the names of the va
sound and graphic files in the appropriate field. Use standard DOS names. See Figure 6-4.

10. Select GIF files for each option you want to use, and choose OK.

11. Enter a GEDCOM or audio file in the appropriate field for inclusion in the Instant Web Page.

12. Select any field with a graphic entered and choose Preview to view the graphic. Choose OK to 
to the Graphics window.

13. Choose Save As. Select from the existing list, or enter a name for the Instant Web Page. Ultima
ily Tree creates a subdirectory with the name you have chosen. The main web page file is nam
index.htm.
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14. Choose OK to create the Web Page.

Previewing an Instant Web Page
1. From the Online menu, choose Preview Instant Web Page or choose the Preview Web Page bu

the Toolbar.

2. Select a web page from the drop-down list.

3. Choose OK. The web browser you configured in Ultimate Family Tree opens with the web page
selected. See page 6 for information on configuring a browser for Ultimate Family Tree.

4. After viewing your web page, exit the browser to return to Ultimate Family Tree.

Figure 6-4: Instant Web Page Graphics Window

Type filename, or
choose Browse to
automatically add
filename

Figure 6-5: Save Web Page As Dialog

Enter new Web page name

List of Web pages created
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Registering with Palladium Interactive
You must register with Palladium Interactive before uploading your Instant Web Pages.

1. From the Online menu, choose Register Online.

2. Choose Connect. Ultimate Family Tree will automatically connect with the Palladium Interactive
site. The program pauses until the connection is made. A registration window opens for user inf
tion. Not all browsers will automatically dial your phone and connect to your Internet Service Pro
(ISP). If your browser does not connect automatically, it will be necessary for you to connect to 
ISP first. Once your online session is through, be sure to disconnect from your ISP.

3. From the home page of the Ultimate Family Tree Web site, click the Publish Your Page link und
Family Web Pages icon.

4. Follow the instructions on screen to complete your registration.

Uploading Your Web Page
After creating a Web Page and registering with Palladium, you can upload the web page to the Pallad
Interactive web site.

1. From the Online menu, choose Upload Web Page or choose Upload Page on the Toolbar.

2. Read the disclaimer (see Figure 6-6). Choose I Accept to accept the terms of the agreement. If
not want to see the disclaimer each time you upload a web page, select that option before choo
Accept. If you choose I Decline, you will be returned to Ultimate Family Tree.

Figure 6-6: Palladium Disclaimer

Palladium Interactive Notice
We are pleased that you want to create a "Family Tree" web page. In order to ensure enjoyment by all of our customers, w
must establish some basic rules.

Third Party Content In creating your World Wide Web page to be uploaded on the Palladium World Wide Web site
(“Site”), you may not use any material that is protected by copyright of a third party without first obtaining permission from
the copyright owner. You, not Palladium, are responsible for any damages such as copyright infringement or any other ha
that results from Palladium's use of any items submitted by you. You agree to indemnify and hold Palladium harmless from
any claims, reasonable expenses, or attorneys' fees relating to any violation of these rules or submission of any material toal-
ladium. Remember that submission of such material to Palladium for use on the Site grants to Palladium the right to use, 
reproduce, modify, distribute, publicly perform and publicly display such material.

Objectionable or Defamatory Content Users are prohibited from posting or transmitting any obscene, hateful, def-
amatory, racially or otherwise objectionable language, images, software or content of any kind, including without limitation
any material that would constitute libel, slander, defamation, or invasions of publicity or privacy of any third party in any juris-
diction. You will indemnify, defend, and hold harmless Palladium and its representatives from any and all losses, claims, li
bilities, obligations, reasonable expenses or attorneys’ fees which arise in connection with objectionable or defamatory 
content in the materials submitted by you.
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Note Although Ultimate Family Tree builds a compressed .TGZ file when you first create your 
page, it updates it from your HTML files just before printing.

3. Type the name and password you used to register online with Palladium.

4. Type the title of your family history.

5. Type the author’s name. This is normally your name.

6. Type a short description of the family history.

Note The title, author’s name, and description are used by Palladium to create an online card c
of all family histories that are available.

7. Choose Upload.
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Using the multimedia features in Ultimate Family Tree, you can create and enhance family-oriented s
shows, and draw on a library of images, video clips, sound, and Windows objects through Object Lin
and Embedding (OLE). Images can be scanned directly into the program, edited, cropped, displayed
included in printed reports. Most image formats are supported, including Kodak PhotoCD™.

Media (images, audio, and OLE objects) is stored and maintained in the Ultimate Family Tree M
media Library. Once entered in the Library, media can be linked to as many individuals and slide sho
you wish. The material is also available to all projects. You can enter information about an image or a
recording once and then use it an unlimited number of times in any project. Digitized images and aud
recording that are stored in a file on your computer can be displayed, played, or printed.

It is important to note that all media (except referenced) must be in a digitized format for use in 
mate Family Tree. There are myriad ways in which this can be accomplished, from using media captu
ware and graphics programs to image scanners and sound boards.

In this section you will learn how to:

✓ Add, modify, or delete media files

✓ Import images and audio files

✓ Edit images and audio files

✓ Display images

✓ Select a preferred image (to display in various view windows)

✓ Scan an image into the media library
1 4 7
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✓ Export a digitized image

✓ Create a Slide Show

✓ Play audio recordings

✓ Add sound to a Slide Show

✓ Add narrative to an image

✓ Link, embed, and import an OLE object

✓ Add OLE files

✓ Edit OLE objects

Referenced Media
Much of the media that is important to a genealogist cannot be digitized. Ultimate Family Tree provid
way to record, retain, and display a complete reference to this material. Referenced media records c
information about the identity and location of important external media, from books to lithographs. Yo
link these easily accessible records to the appropriate individuals and store them in the Multimedia L

1. From the Build menu, choose Multimedia Library.

2. Choose the New button in the Add Media box. The New window opens.

3. Select Referenced in the Media Type box.

4. Scroll the list of media types to highlight the type you want to reference.

Figure 7-1: New Window
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5. Enter a unique name (up to 20 characters) in the Ref Name field in the Media Details group. Th
Name is required because it is used in Media List boxes.

6. Enter a descriptive name (optional) for the media in the Name field. This becomes the title nam
descriptive name is limited to approximately 35 characters.

7. Enter a date (optional) for the image (up to 30 characters) in the date field.

8. Enter the physical location (optional) of the media, for example, the album number for a photog
Use any description you wish (up to 33 characters).

9. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any desc
you wish (up to 33 characters).

10. Choose Description (optional) to open an Edit Text window where you can enter up to 65,000 c
ters of text describing the media. The description can include the names of the people, location
media, or any other information you wish. Choose Import to take you to an Open dialog box wh
you can select external text to copy and paste into the Description text window.

11. Choose OK to close the New Media window.

Direct Media
Direct media are items that are digitized and stored on your hard disk. The three types of direct med
images, audio, and OLE.

Images
Images can be stored in a wide variety of formats, such as bitmaps (.BMP), Aldus TIFF (.TIF), or Join
tographic Experts Group (.JPG), and can be incorporated into your Ultimate Family Tree program. W
any of these file formats containing 24-bit data are imported into Ultimate Family Tree, they are comp
using the JPEG specification that has the JPG extension. See page 162 for a list of compatible file fo
that can be used in Ultimate Family Tree.

Images can be scanned or sent to Ultimate Family Tree using a TWAIN-compatible device. A sc
image is an electronic reproduction of a picture or document that you can store in a file on your compu
scan images you must have a scanner and scanner software. Consult your computer dealer for more
tion on scanners.

You can also import Kodak Photo CD pictures into Ultimate Family Tree. Storing your photos on
CD-ROM is a wonderful way to preserve your favorite family photos. A CD-ROM drive is required. Con
a Kodak processor to have your undeveloped film, old photos, or negatives placed on a Kodak Photo

Images can be edited and modified. You can also record a narrative that is stored with that imag
play it back in any image display window, including Media Tree, Slide Show, Multimedia Link, and Mu
media Library.
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Audio
Audio files come from a wide variety of sources including audio CDs, tapes, records, sound tracks, a
voice recordings. When translated into a digitized format, the audio file must have the extension .WAV
Audio can be played in windows containing images. You need a sound board to record and play back
tized audio.

OLE
Object Linking and Embedding (OLE) is a powerful Windows tool that you can use to create an objec
any type of media, including text, images, video clips, sound clips and MIDI files, and place it in Ultim
Family Tree.

To transfer OLE objects to Ultimate Family Tree, you need a program such as Windows Object 
ager, found in the Windows Accessory Group. For a more detailed discussion of OLE technology, con
your Windows manual.

Using Media in Ultimate Family Tree
Once media is stored in the Ultimate Family Tree Multimedia Library, it can be linked to individuals an
slide shows.

Multimedia Library
The Multimedia Library is the repository for all Ultimate Family Tree media files. These files are adde
edited, or deleted from the Multimedia Library window. This window contains detailed information abo
the images or audio recordings in Ultimate Family Tree projects. You can use this window to enter new 
or audio recordings, to modify existing media records, to export image files, or to delete media record

Figure 7-2: Multimedia Library Window

List of available
media

Edit and crop image
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Adding a Digitized Image or Audio (.WAV) File
1. From the Build menu, choose Multimedia Library.

2. Choose New in the Add Media group to open the New media window.

3. Select Digitized Image or Audio (.WAV) in the Media Type group.

4. Choose File in the Add New Media From group.

5. Select the drive and directory where you placed the image or audio recording file. A list of imag
audio files appears in the Add Image File box, depending on the media type you selected in the
media window.

Figure 7-3: New Window

Select media type

Choose file to add
a digitized image
or .WAV file

Figure 7-4: Open Dialog Box

List of image or
audio files
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6. Select the image or audio recording you want to add to the library and choose Open. If you cho
image, a preview window opens where you can view the image you are adding. Choose OK to 
to the Multimedia window, or Cancel if you change your mind.

7. In the New media window, enter a unique name (up to 20 characters) in the Ref Name field in t
Media Details group. The Ref Name is required because it is used in the Media List boxes.

8. Enter a descriptive name (optional) in the Name field. This becomes the title name and will prin
below the image in Gallery reports. The descriptive name is limited to 25 characters.

9. Enter the date (optional) for the image (up to 30 characters) in the date field.

10. Enter the location (optional) of the media, (for example, the hard drive location for a digitized im
Use any description you wish (up to 33 characters).

11. Enter the condition (optional) of the media, such as poor, fair, good, or excellent. Use any desc
you wish (up to 33 characters).

12. Choose Caption (optional) to open a text window where you can enter a caption for the image.
caption is included below a digitized image when it’s printed and should be limited to 50 charact
less.

13. Choose Description (optional) to open an Edit Text window where you can enter up to 65,000 c
ters of text describing the image. The description can include the names of the people in the ima
location of the image, or any other information. Choose Import to take you to an Open dialog bo
where you can select external text to copy and paste into the Description text window.

14. Choose OK to close the New media window.

15. The Multimedia Library window displays the name you typed in the Name Field in the Media Lib
list. Choose OK to close this window.

Scanning an Image into the Multimedia Library
Note You must use a TWAIN-compatible device (such as a scanner) to scan images in Ultima
Family Tree.

1. From the Build menu, choose Multimedia Library.

2. Choose New in the Add Media group.

3. Select Digitized Image in the Media Type group.

4. Choose Scanner in the Add New Media From group to open the Scan window.

5. Choose Select Source to select the scanner you wish to use.

6. Choose Scan to open the control window supplied by the manufacturer of your TWAIN-compat
device and begin scanning.

7. Choose OK to close the window.
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8. In the New window, enter a unique name (up to 20 characters) in the Ref Name field. The Ref N
required because it is used in Media List Boxes.

9. Enter the optional Media Details for your scanned image.

Adding an Existing OLE File in Windows 3.x
OLE objects, constructed from your media, are placed in Ultimate Family Tree. The program used to 
OLE objects into Ultimate Family Tree is called the OLE server. The program in which an OLE object is pla
called the OLE client. Consult your Windows manual for a more detailed discussion of OLE technolo

1. From the Build menu, choose Multimedia Library.

2. Choose New in the Add Media group.

3. Select OLE in the Media Type group.

4. Choose OLE in the Add New Media From group to open the OLE window.

5. From the Edit menu, choose Insert Object.

Figure 7-5: Scan Window

Choose to begin scanning

Figure 7-6: Insert Object Dialog Box

Choose File after
selecting an object type
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6. In the Insert Object window, select the object type and choose File.

7. Change to the drive and directory that contain the file you want to add.

8. Choose Insert. An OLE window opens with an icon representing the object.

9. Close the OLE window by double-clicking on the close box.

10. In the New Media window, enter a unique name (up to 20 characters) in the Ref Name file.

11. Enter the optional Media Details for the OLE file.

12. Choose OK to close the window.

Adding an Existing OLE File in Windows 95 (or Windows 3.x)
1. From the Build menu, choose Multimedia Library.

2. Choose New in the Add Media group.

3. Select OLE in the Media Type group.

4. Choose OLE in the Add New Media From group to open the OLE window.

5. From the Edit menu, choose Insert Object.

6. In the Insert Object window, select the object type and choose OK to open a server windows fo
type you have chosen.

7. Carefully follow the instructions shown in the window. These instructions vary according to the i
vidual server. When you close the server window, an icon appears in the OLE window.

8. Close the OLE window by double-clicking the close box.

9. In the New Media window, enter a unique name (up to 20 characters) in the Ref Name file.

Figure 7-7: Insert Object From File Dialog Box
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10. Enter the optional Media Details for the OLE file.

11. Choose OK to close the window.

Note Some OLE servers (such as Windows Media Player) interfere with Ultimate Family Tree.
you lock (freeze) when exiting Windows, use Ctrl-Alt-Del to reset your system. To prevent this p
lem, use Object Packager to link OLE objects.

Using Microsoft Object Packager with Ultimate Family Tree
Object Packager is a Windows program that converts images, text, video clips, and sounds to an OLE
that can be linked to Ultimate Family Tree. Object Packager is located in the Windows Accessories Gr
Windows 3.x. It is located in the Windows folder in Windows 95. Read the Object Packager online He
learn about its many capabilities.

Objects can be connected to Object Packager in one of two ways:

• Start Object Packager and choose Import from the File menu to import a file that can be embed
Ultimate Family Tree.

• Choose Paste from the Edit menu to link an object from a server where you have previously co
that object to the clipboard.

The following procedure shows how to use Object Packager. It assumes that you have previous
installed Video for Windows on your system. To link a video clip to Ultimate Family Tree through Obje
Packager, follow these steps:

1. Start Media Player from the Accessories Group or type media player in the Run window in Wind
95.

2. Choose Video For Windows from the Device Menu. The file Open dialog box is displayed.

3. Choose an AVI file from the file list, and then choose Open (or OK in Windows 3.1).

4. Choose Copy Object from the Media Player Edit menu.

5. Exit Media Player.

6. Start Object Packager. Type package in the Run window in Windows 95.

7. From the Edit menu, choose Paste.

8. From the Edit menu, choose Copy Package.

9. Exit Object Packager.

10. Start Ultimate Family Tree.

11. From the Build menu, choose Multimedia Library.

12. Choose Add Media, New.

13. Select the OLE Media Type radio button.



1 5 6 SE C T I O N 7 : M U L T I M E D I A

, 

 in Ulti-
ked to 

amily 
cation 
ject into 
ject.
use 
mmand 

 are 
ee. 
14. Choose OLE in the Add New Media From group.

15. From the Edit menu, choose Paste.

16. Close the OLE edit window.

17. Type a reference name for the clip and any other information you wish.

18. Choose OK.

The Video For Windows clip has now been linked to Ultimate Family Tree. To play the video clip
double-click the name of the clip in the Media Library list in the Multimedia Library window.

Copy and paste static objects, such as text or graphics, into Object Packager and embed them
mate Family Tree using similar steps. The embedded objects can then be used in slide shows and lin
individuals.

Paste Special
Use the Paste Special menu option to link or embed an OLE object on the clipboard to the Ultimate F
Tree Multimedia Library. The object retains the formatting and other characteristics it had in the appli
that created it. For example, you can copy part of a Microsoft Excel spreadsheet and paste it as an ob
Ultimate Family Tree. You can then double-click the object to open it in Excel, and edit or print the ob

The Paste Special menu option is not available until you copy the object you want to paste. To 
Paste Special, select information from the source document or application, and then use the Copy co
from the Edit menu to place it on the clipboard.

The Paste Special dialog contains the following options:

• Source area — Displays the application, directory, and file you are pasting from.

• Data Type list — Displays the available formats for the object. Select the format for the object you
pasting according to what you want to be able to do with the stored object in Ultimate Family Tr

Figure 7-8: Multimedia Library Window
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Use Object format to edit the object by opening its source application from Ultimate Family Tree
Choose picture or bitmap formats to display the object and minimize the space it occupies in Ul
Family Tree. If you plan to change the size of the object, choose the Picture format. If an object
picture or bitmap format, you cannot edit it from Ultimate Family Tree.

• Paste — Embeds the object from the clipboard into the OLE Edit window.

• Paste Link — Links the object to Ultimate Family Tree as the destination so you can modify the lin
object in Ultimate Family Tree.

• Cancel — Exits the dialog without taking action.

To use Paste Special, follow these steps:

1. Copy to the clipboard the information from the server you want to embed or link.

2. Return to or open Ultimate Family Tree.

3. Choose New in the Multimedia Library window.

4. Select OLE in the Media Type list.

5. Choose OLE in the Add New Media From group.

6. From the Edit menu, choose Paste Special. The Paste Special dialog box appears.

7. From the Data Type list, select the format you want to use.

8. Choose the Paste button to embed the object or the Paste Link button to link it.

Note Depending on the application used to create the object, or whether the object is in a sav
ument, the Paste Link button may not be available.

9. Close the OLE window.

Figure 7-9: Paste Special Dialog Box
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Editing an OLE File
You can’t edit OLE objects in Ultimate Family Tree. They are edited using the software program in wh
they were originally created. Objects that are embedded cannot be edited.

1. From the Build menu, choose Multimedia Library.

2. Select the OLE object you want to edit from the Media Library list.

3. Choose Edit in the Image Group. The OLE window opens.

4. From the Edit menu, choose Object.

Note If you choose Clear from the Edit menu, you clear the OLE object from the window and 
remove it. Choose Convert to Static to break the link between an object and its server

5. The program in which the OLE object was created opens, and you can edit the object.

6. To exit that program, choose Exit and Return from the File menu.

Editing an Existing Digitized Image
Images can be edited in various ways. You can rotate the image and change brightness, contrast and
ness. You can convert an image to gray or negative, and crop it. Additionally, you can add narrative fo
image. If you want, you can save the edited image to a new file, and export it to any compatible imag
In Ultimate Family Tree you can compress 24-bit images and set image quality level.

1. From the Build menu, choose Multimedia Library.

2. Select the digitized image you want to edit from the Media Library list.

3. Choose Edit in the Image Group.

Figure 7-10: Edit Window

Use to crop image
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4. Choose any of the options listed in the Image field.

Note Image options are not available for all image types. Sharpness can be used for gray sca
images, but not for color images or line drawings. If you choose an image function that does not
to the current image, you’ll see a message stating, “Format not allowed.”

5. Choose Zoom In to magnify or crop the image.

6. Choose Zoom Out to shrink the image.

Note The zoomed view is saved when you close the window by choosing OK. Use Zoom and 
scroll bars to crop the image.

7. Choose Full to view the entire image.

8. Choose Undo to return the image to its original appearance.

9. Choose Record Narrative to open the Windows Sound Recorder where you can record a narra
this image.

10. Choose OK to close the window. In the Save window choose Cancel if you do not want to save
changes, or choose OK to save the changes. To confirm, choose Proceed to continue, or Canc
return to the Save window to make the name changes.

Note If you want to save the original image and at the same time save the newly edited image, 
these steps:

1. Enter a different Reference Name for the newly edited image.

2. Enter a different Descriptive Name (optional). The descriptive name is limited to approxim
35 characters.

3. Choose Caption and/or Description (optional) to edit or enter a new caption or description
the image.

4. Choose OK to save the changes in a file with the new file name.

The edited image title will appear in the Media Library list.

Adding Narrative
The narrative can be heard in various view windows, preview windows, slide shows, and the Individu
Record Media window. Before you can use Sound Recorder, you must use the Windows Control Pan
install and configure the appropriate device driver and sound hardware. See your Windows manual fo
information.

1. To record a narrative for a selected image, from the Build menu, choose Multimedia Library.

2. Select the digitized image for which you want to add narrative from the Media Library list.

3. Choose Edit in the Image Group.
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4. Choose Record Narrative to open the Windows Sound Recorder where you can record a narra
this image.

Note To use an existing .WAV file rather than recording a new narrative, choose Insert File from
Sound Recorder’s Edit menu. Select the file you want as the narrative and choose Open. Choo
& Return from the File menu.

5. Choose OK to close the window.

Note If you minimize rather than close Sound Recorder (or click the mouse anywhere on the d
top), the Image Edit window will not be active. Press Escape to close Sound Recorder and activ
Image Edit window.

Deleting Media
1. From the Build menu, choose Multimedia Library.

2. Select the media you want to delete from the Library list on the left.

3. Choose the Selected button in the Delete Media group to delete the selected media or choose 
button to delete all media from the Multimedia Library.

4. Choose Proceed to delete the selected media or Cancel to return to the Multimedia window.

Note After deleting media, choose Project, Pack from the Utilities menu to permanently remov
deleted records and reduce the disk space used.

Figure 7-11: Multimedia Library Window

Delete selected media

Delete all media
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Displaying Images and Screen Resolutions
The resolution of your computer display adapter and monitor directly affects the quality of the images
display. Resolution is determined by the number of pixels (picture elements) on the monitor and the n
of colors per pixel. A SVGA monitor, having 480 ´ 640 pixels and 256 colors is the minimum recommend
configuration for displaying images. Image quality improves dramatically as the number of pixels and
depth increase.

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to use the
dows Colors option. See page 196 for more information.

Displaying a Digitized Image
1. From the Build menu, choose Multimedia Library.

2. Select the digitized image you want to view from the Media Library list.

3. Choose Display in the Image group.

4. Use the Zoom In/Out and Full buttons to view the image.

5. Play any audio attached to this image by clicking the Narrative button.

6. Add a caption for the image, or any descriptive text, in the appropriate fields.

7. If you want to export the image to an External file, choose Export.

8. Choose Close to return to the Multimedia Library window.

Figure 7-12: Display Window

Export image

Play any audio
attached to this
image



1 6 2 SE C T I O N 7 : M U L T I M E D I A

m the 

pati-
 saved 
Exporting a Digitized Image
You can export a digitized image to use in other programs. Follow these steps to export an image fro
Multimedia Library window:

1. From the Build menu, choose Multimedia Library.

2. Select the digitized image to be exported from the Media Library list.

3. Choose Display in the Image group.

4. Choose Export.

5. Select the file type of the image you wish to export. File types include:

• BMP — Microsoft, up to 16.7 million colors (24-bit)

• GEM IMG — Digital Research, 16 colors (4-bit)

• GIF — CompuServe, 256 colors (8-bit)

• JPG — Joint Photographic Experts Group, 16.7 million colors (24-bit)

• MAC — Apple Computer MacPaint, 2 colors (1-bit)

• MSP — Microsoft, Microsoft Paint, 2 colors (1-bit)

• PCT — Apple Computer, PICT, 16.7 million colors (24-bit)

• PCX — ZSoft, 16.7 million colors (24-bit)

• TGA — Truevision, TARGA, 16.7 million colors (24-bit)

• TIF — Aldus TIFF, 16.7 million colors (24-bit)

Note Valid file types are in the File Type list. If a type is dim, it is because the file type is incom
ble with the Ultimate Family Tree image. For example, a 24-bit format, such as .BMP, cannot be
in an 8-bit format such as .GIF.

6. Choose Save.

7. Enter a file name in the Save As window. Ultimate Family Tree adds the file extension.

8. Change to the drive and directory into which you wish to export the image.

9. Choose Save, or Cancel if you do not want to save changes.

10. Choose Close to close the Display window.

Playing an Audio Recording
1. From the Build menu, choose Multimedia Library.

2. Select the audio (.WAV) recording you want to hear from the Library list.

3. Choose Audio in the Play group.
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Previewing the Multimedia Library
The Preview window displays media stored in the Multimedia Library. The media files are displayed i
slide format, up to eight at one time, with their control names.

1. From the Build menu, choose Multimedia Library, and then choose Preview in the Library group
view all media stored in the Multimedia library.

2. Choose More, and then Media in the Individual Record window, and then Preview in the Multim
Link window to view all media linked to the individual.

3. Click the name under the slide in order to view the image in a larger format or play the recordin
OLE object.

4. Choose the More>> button to view any additional media.

5. Choose the <<More button to return to the previous Preview window.

6. Choose Close to return to the Multimedia Link or Multimedia Library window.

Linking Media
You can link an unlimited number of images, audio recordings, or object to an individual.

1. Choose the More button in the Individual Record window, and then Media to open the Multimed
Link window.

2. Make sure the name of the desired individual appears at the top of the window and choose Exi
Media from the Add Media Link box.

3. Choose Proceed (if a Note window appears) to open the Media Select window.

Figure 7-13: Multimedia Link Window

List of linked media

Link existing media

Link new media

Click to select
preferred image

View selected image

Play selected audio
or OLE file
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4. Choose Multimedia Library in the Media Source group to add existing media found in the Multim
Library.

Note If you wish to add media which is linked to another individual or an existing slide show, 
choose the appropriate option in the Media Source group. A list of individuals or slide shows will
depending on your choice. Select the individual or slide show from the list and choose OK.

5. Select the media you want from the Media Library list.

6. Choose the Add button or double-click the media to move the selected media to the Linked Me

7. Choose Add All to add all media to the Linked Media list.

8. Choose Remove to remove selected media from the Linked Media List or Remove All to remov
linked media from the list.

Note A description of the media is displayed in the Description box if a description was entere
the Multimedia Library window.

9. Choose OK to save and close the window.

Note The Insert button is active only when adding media to a slide show.

Selecting a Preferred Image for Display
You can link more than one image to an individual. Ultimate Family Tree gives you the option of selec
one of these images as the preferred one that will appear in the Media Tree, Family Tree, Family, an
Descendant windows (and will be included in an Instant Web Page Report). From the Multimedia Lin
dow, highlight the image you want as the preferred image and check the Preferred Image box. Choos
and then Media in an Individual Record window to open the Multimedia Link window.

Note NOTE OLE images and audio files cannot be Preferred images.

Adding New Media to an Individual
1. Choose More, and then Media in the Individual Record of the person to whom you want to add 

2. In the Multimedia Link window, choose New Media to open a New media window.

3. Select Digitized Image or Audio (.WAV) in the Media Type group.

4. Choose File in the Add New Media From group.

5. Select the drive and directory where you placed the image or audio recording file. A list of imag
audio files appears in the Add Image File box, depending on the media type you selected in the
media window.

6. Select the image or audio recording you want to add to the library and choose Open. If you cho
image, a preview window opens where you can view the image you are adding. Choose OK to 
to the Multimedia window or Cancel if you change your mind.
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7. In the Multimedia window, enter a unique name (up to 20 characters) in the Ref Name field, und
Media Details group. The Ref Name (Reference) appears in the Media List boxes. This referen
required.

8. Enter a descriptive name for the media in the Name field. This becomes the title name. The des
name is limited to 25 characters (optional).

9. Enter the free-form date for the image (up to 30 characters) in the date field (optional).

10. Enter the physical location of the media, for example, the hard drive location for a digitized ima
the album number for a photograph. Use any description you wish, up to 33 characters (optiona

11. Enter the condition of the media, such as poor, fair, good, or excellent. Use any description you
up to 33 characters (optional).

12. Choose Caption to open a text window where you can enter a caption that is included below a d
image when it’s printed. The caption should be limited to 50 characters or less (optional).

13. Choose Description to open an Edit Text window where you can enter up to 65,000 characters
describing the image. The description can include the names of the people in the image, the loca
the image, or any other information. Choose Import to take you to an Open dialog box where yo
select external text to copy and paste into the Description text window (optional).

14. Choose OK to close the New Media window.

15. Choose OK to close the Multimedia Link window.

Unlinking Media from an Individual
1. Choose the More button, and then Media in the Individual Record of the person from whom you

to unlink media.

2. Make sure the name of the individual appears at the top of the window, and from the Multimedia
list, select the media you want to unlink.

3. Choose Selected in the Delete Media group to unlink the selected media or choose All to unlink
media from the individual.

Note The Delete Media buttons do not delete the media from the Multimedia library. These bu
merely unlink the media from the selected individual.

4. Choose Proceed to unlink the media.

Viewing Images Linked to a Selected Individual
1. Choose the More button, and then Media in the Individual Record to open the Multimedia Link 

dow.

2. Select the image you want to view in the Multimedia Links list.

3. Choose Image in the Play group.
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Playing Audio/OLE Recordings Linked to a Selected Individual
1. Choose More, and then Media in the Individual Record to open the Multimedia Link window.

2. Highlight the Audio or OLE recording in the Multimedia Links list.

3. Choose Audio/OLE in the Play group.

Viewing All Media Linked to a Selected Individual
1. Choose More, and then Media in the Individual Record to open the Multimedia Link window.

2. Choose Preview to view all media linked to the individual in a slide show style. Each image or s
icon is displayed with its control name.

3. Select the name on the slide to view the image or play the recording or OLE object.

4. Choose the More>> button to view any additional media.

5. Choose the <<More button to return to the previous Preview window.

6. Choose Close to return to the Multimedia Link window.

Slide Shows
One of the most exciting features of Ultimate Family Tree is the ability to create a slide show present
using the image and audio files stored in the Multimedia Library. You can also add a voice-over narra
each slide.

To better understand how to set up a multimedia slide show, note the following:

• Slides can contain digitized images, audio files, or OLE objects. The slides are shown sequenti
during a slide show. Digitized images are shown for a length of time that is set for each slide. B
ground music from a MIDI OLE server can also be included with the slide show, depending on t
server.

• Voice-over narrations are played with their associated digitized image. Slides following a digitize
image that contain audio files are then played while the digitized image is displayed. To adapt n
tions to the current slide show, arrange slides in the proper order.

Note OLE images do not play in the slide show without activating the server.

Creating a New Slide Show
1. From the Build menu, choose Slide Show.

2. Choose New in the Add Show group.

3. Enter a name in the Show Name field. This required name appears in the Slide Show list.
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4. To add slides, choose Existing or New in the Add Slide group. If you choose Existing, continue 
step 5. If you choose New, see “Adding a Digitized Image or Audio (.WAV) File” on page 151.

5. Choose Multimedia Library in the Media Source group. (Use the Selected Individual option to s
media items linked to an individual. Use Slide Show to create a new slide show from an existing
show.)

6. In the Media List, highlight the media you want to include.

Figure 7-14: Slide Show Window

Type name for
new slide show

List of slide shows
in project

Media type of
selected image

Set time for
image or audio

Figure 7-15: Media Select Window

Media list
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7. Choose Add or Add All.

8. Repeat steps 6 and 7 until all media you want to add to the slide show has been linked.

Note Use the Remove and Insert buttons to arrange the slides in the order in which you want th
be displayed. The Remove button unlinks a selected file from the slide show. The Insert button 
a selected file above a highlighted item in the Linked Media list.

9. Choose OK to return to the Slide Show window.

10. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

To view or hear any of the slides or view the complete slide show, choose any of the following bu
in the Play group:

• Image — Displays the selected image

• Audio/OLE — Plays the selected audio (.WAV) or OLE file

• Slide Show — Displays the entire slide show

• Preview — Displays all linked slides (up to 8 at one time) for the selected slide show

Editing an Existing Slide Show
1. From the Build menu, choose Slide Show.

2. Highlight the slide show you wish to edit and choose any of the buttons in the Add Slide, Move 
or Delete Slide boxes to add new slides, to change the order that the slides display, or to remov
from the Slide Show.

3. Choose OK to save changes and close the window.

Adding all Media Linked to an Individual to a Slide Show
You can create slide shows about several different people by adding all media linked to an individual
new or existing slide show.

1. From the Build menu, choose Slide Show. (To create a new slide show, follow the steps in “Crea
New Slide Show” on page 166.)

2. Highlight the slide show to which you want to link an individual’s linked media and choose Existin
the Add Media group.

3. In the Media Select window, choose Selected Individual from the Media Source group. A Candi
Individuals window opens listing all individuals within the project with linked media.

4. Select the individual whose linked media list you want to use and choose OK to open the Media
window. The media linked to the selected individual is listed in the Media list.

5. In the Media List, highlight the media you want to include.
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6. Choose Add, or Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Note Use the Remove and Insert buttons to arrange the slides in the order in which you want th
be displayed. The Remove button unlinks a selected file from the slide show. The Insert button 
a selected file above a highlighted item in the Linked Media list.

8. Choose OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

10. Choose OK to close the Slide Show window.

Adding an Existing Slide Show to a Slide Show
1. From the Build menu, choose Slide Show.

Note To create a new slide show, follow the steps in “Creating a New Slide Show” on page 16

2. Highlight the slide show into which you want to link another slide show and choose Existing in t
Add Media group.

3. In the Media Select window, choose Slide Show from the Media Source group. A Candidate Sli
Show window opens listing all existing slide shows for the current project.

4. Highlight a slide show and choose OK to open the Media Select window with the list of media li
to the selected slide show displayed.

5. In the Media List, highlight the media you want to include.

6. Choose Add.

Note To add all listed media to the slide show, choose Add All.

7. Repeat steps 5 and 6 until all media you want to add to the slide show has been linked.

Figure 7-16: Candidate Individuals Window
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Note Use the Remove and Insert button to arrange the slides in the order in which you want th
be displayed. The Remove button unlinks a selected file from the slide show. The Insert button 
a selected file above a highlighted item in the Linked Media list.

8. Choose OK to return to the Slide Show window.

9. Highlight a slide in the Selected Show list and set the time (in seconds) that you wish the slide t
Repeat this for each slide.

10. Choose OK to close the Slide Show window.

Slide Shows and OLE
OLE objects can be used in Ultimate Family Tree slide shows. For example, you can link and play a 
For Windows clip as part of a slide show. One interesting source of video clips is Microsoft Encarta, w
includes many historical video clips. Copy the .AVI files you want to use from the Encarta CD-ROM to
hard disk. The CD-ROM need not be present when you want to play the slide show. Be aware that vi
clips can be very large, and consume a significant amount of space on your hard disk. Use Object Pa
to integrate video clips with Ultimate Family Tree because of conflicts some video servers create.

Note Some OLE servers (such as Windows Media Player) interfere with Ultimate Family Tree.
Windows locks (freezes) when you exit, use Ctrl-Alt-Del to reset your system. To prevent this pr
lem, use Object Packager to link OLE objects. See “Using Microsoft Object Packager with Ultim
Family Tree” on page 155.

If you want to use a static object in a slide show, such as a drawing created with PC Paintbrush, 
Convert to Static option (active when editing an OLE object in the Multimedia Library window) on the
mate Family Tree Edit menu. Convert to Static breaks the link between an object and its server. Whe
object is then played in a slide show, the server is not activated.

You might want to activate the server during a slide show. For example, you can display a docu
produced in a word processing program, or a presentation from another source (such as Lotus Freela
part of a slide show. To keep the server active (rather than being closed by Ultimate Family Tree), se
Seconds to 999 for that slide in the Build Slide Show window. The slide will then be shown until you c
the server.

With a few exceptions, only one OLE object and server can be active at one time in Ultimate Fa
Tree. This restriction is important if you wish to play music as the background of a show. MIDI music 
objects can be linked to Ultimate Family Tree and played in a slide show, but if a new server is activa
while the music is playing, the new server overrides the one playing the music, and the music stops.

Play MIDI music in the background for a slide show that consists of digitized images that do not
narratives. Be sure to turn off the sound effects option. Narratives and sound effects are OLE objects
they will stop the music.



Section 8:

Managing Your Data
indows 
In this section you will learn how to:

✓ Merge two projects

✓ Import data from another program (GEDCOM or ROOTS III)

✓ Export data from Ultimate Family Tree to another program

✓ Save a Project

✓ Backup (Archive) a project

✓ Restore an Archived file

✓ Open files

✓ Delete an Individual from a project

✓ Delete a place from the Place Library

✓ Delete a source from the Source Library

✓ Use the Project Info window

✓ Exit Ultimate Family Tree

✓ Set Desktop Preferences (clock, messages, date format, toolbar, image quality, name format, W
colors, and wallpaper)
1 7 1
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✓ Pack a project

✓ Use Check and Repair

✓ Reindex a project

✓ View a GEDCOM Exception List

Merging Projects
At some point you may want to combine one project with another.

Note You cannot merge two projects that use different library files. To combine two projects tha
different library files, use GEDCOM. If you’re using Visual ROOTS or ROOTS IV, see “Using 
ROOTS IV and Ultimate Family Tree Together” on page 216.

1. Open the project into which you want to merge a second project.

2. Choose Open from the File menu to open the second project.

3. Select Ultimate Family Tree Project from the File Type drop-down list.

4. Select the drive and directory where the second project is located. Select the project name from
list. Choose OK to open the specified project. The Project Merge Options window opens.

5. Enter the starting individual record number for the merged records. It can be the next available 
number, which appears automatically, or any higher number you choose. (The Next Available R
Number displayed in the Project Merge window is the highest record number used in the origin
project, plus 1.) Note that gaps will occur in the numbering of the merged records if gaps are pre
the records of the project that is being merged.

6. Choose Proceed to merge the two projects. (If you change your mind, choose No Merge. Choos
Merge closes the first project and opens the second one.)

Figure 8-1: Project Merge Options Window

Close original project
and open second

Proceed with merge

Enter starting individual
record number
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7. A message appears stating, “The two projects you have specified will be merged if you proceed
original project will contain records from both projects. The second project will not be changed.
Choose Proceed to continue or Cancel if you do not want to merge the two projects.

Note If you merge two projects, duplicate individuals are not combined. Manually combine any
duplicates. See “Combining Individuals” on page 191.

Data from Another Program
Ultimate Family Tree can import GEDCOM data from any another software program that is also GED
compatible.

Important Note about GEDCOM The GEDCOM (GEnealogical Data Communications) standa
provides a set of rules that allow software designers to create programs for exchanging genealo
information. The GEDCOM standard has been changed considerably since it was first introduc
1984, and continues to evolve. Prior versions of the GEDCOM standard were released in Octob
1987 (3.0) and August 1989 (4.0). Version 1 and 2 were drafts for public discussion and were n
established as a standard. The Family History Department of the LDS Church released the lates
COM standard draft proposal, version 5.5, in December 1995. It addressed improvements in th
ment of sources and user-defined events.

Ultimate Family Tree GEDCOM is designed to conform as closely as possible to Version 5.
except where incompatibilities exist with version 4.0.

The GEDCOM standard, while providing an excellent starting point, can be interpreted diffe
ently by two designers, resulting in potential incompatibilities. For these reasons, the export and
import of GEDCOM information to and from Ultimate Family Tree must be approached with cau
You might need to edit or update the information that is not converted correctly. While tools are 
vided in Ultimate Family Tree to help with this process, it is extremely important to check all info
tion imported to Ultimate Family Tree for error or omissions. It is also important to alert those 
receiving a GEDCOM file from Ultimate Family Tree (or any other advanced genealogy softwar
the possibility of these problems.

Importing a GEDCOM File
Ultimate Family Tree imports GEDCOM files that use either the ANSEL or IBM-PC character sets. Be
of the disk space used during the conversion, copy the GEDCOM file to your hard disk before attempt
conversion.

Note If you want to import a GEDCOM file from multiple floppy disks, copy the files from the 
floppy disks to your hard disk. When all the files are on the hard disk, use the DOS COPY comm
combine the separate files into the .GED file. Example:

Copy SMITH.GED + SMITH.G00 + SMITH.G01 JONES.GED [Press Enter]

Once the files are combined in the JONES.GED file, you can import the GEDCOM file into Ultim
Family Tree.
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1. From the File menu, choose Open.

2. In the File Type drop-down list, select GEDCOM Import.

3. Select the drive and directory where the .GED file can be found.

4. Select the GEDCOM file to be imported and choose OK. The Import from GEDCOM Options win
will open. See page 178 for additional information on the Options window.

The following options are unique to the Import From GEDCOM Options window. See page
for options common to GEDCOM and ROOTS III imports.

Figure 8-2: Open File Window

Choose GEDCOM Import
from drop-down file list

Path to file

Figure 8-3: Import from GEDCOM Options Window

Convert dates to
format selected

Build footnotes

Convert upper case
to upper/lower case

Reverse surname/
given to given/
surname
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Text Destination: Individual

• Biographical Text — Converts text notes attached to individuals to the Individual Biographical Te
window of the Individual Record window.

• Footnote — Converts text notes attached to individuals to the Individual Footnote Text field of th
Individual Record window.

• Research Notes — Converts text notes attached to individuals to the Individual Text Research No
window of the Individual Record window.

Text Destination: Event

• Research Notes — Converts text notes attached to events to the Event Text Research Notes wind
the Individual Record window.

• Text — Converts text notes attached to events to the Event Text window of the Individual Record
dow.

• Footnote — Converts text notes attached to events to the Event Text Footnote window of the Ind
ual Record window.

Other Group

• Assume Marriage When Family (PAF) — Select this option if your previous genealogy program do
not distinguish between family records and marriage records, but instead uses a FAM tag as in t
of the PAF (Personal Ancestral File) program. If selected, Ultimate Family Tree creates a marria
record for all couples with a FAM tag.

• Remove Carriage Returns from Text — Select this option to remove carriage returns from text note
and allow Ultimate Family Tree to correctly wrap text.

• Retain Original Record Numbers — Select this option if your GEDCOM file supports the NUMB ta
for individual record numbers. This option retains the record number from the previous program
Ultimate Family Tree. If the conversion finds an individual without a NUMB tag, a message warn
that if you proceed, record numbers will be unreliable. If you choose Proceed, any individuals w
NUMB tags receive the original record number, and those without a NUMB tag receive the next
able record number. Choose Cancel to abort the conversion.

5. Choose OK when you have made your option choices.

6. In the Save As Dialog Box, enter a file name for the project, with the extension .PRO.

7. Select a different drive and directory if you want. Use the PROJECTS subdirectory or a subdire
other than the FG directory.

8. Choose OK to start the conversion. When the GEDCOM conversion is complete, a message sh
conversion time in minutes and the number of exceptions. (An exception is data that did not con
from the GEDCOM file to the Ultimate Family Tree project.) See “Viewing GEDCOM Exceptions
on page 200.

9. Press any key on the keyboard or move the mouse to remove this message.
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10. Enter the appropriate data in the Project Information window. See page 193 for more informatio
the Project Information window.

11. Choose OK to close the Project Information window.

Note If you import an Event 1.0 GEDCOM file that includes media, any OLE or .WAV files beco
referenced media. Only digitized images are imported in their true form and can be viewed in Ult
Family Tree.

Importing From ROOTS III
You can easily convert ROOTS III databases (familyname.edb) for use in Ultimate Family Tree. Beca
the size of temporary files created during the conversion, the .EDB file should be located on the hard
before attempting the conversion.

1. From the File menu, choose Open.

2. In the File Type drop-down list, select ROOTS III Basefile.

3. Select the drive and directory where the .EDB file can be found.

4. Select the .EDB file to be converted and choose Open. The Import from ROOTS III Options win
opens. See page 173 for additional information on the Options window.

Figure 8-4: Save As Window

Enter file name with
extension .pro

Choose Ultimate Family
Tree from drop-down list

Figure 8-5: Import from ROOTS III Options Window

Convert upper case
to upper/lower case

Reverse surname/
given to given/
surname
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5. Choose the options you want. The following options are unique to the Import from ROOTS III Op
window. See page 178 for options common to GEDCOM and ROOTS III imports.

• Translate Text Formatting — Select this option to convert ROOTS III dot commands to Ultimate Fa
ily Tree formatting commands. The following commands are not supported in Ultimate Family T

.. Remarks

.i Print line and set temporary indent

.# Set blank space

.e Blank page

.n Normal left margin

.s Superscript

• Translate Address Labels — Select this option if you created mailing labels in the Resides field in 
ROOTS III and you want them directed to the Ultimate Family Tree mailing label fields. The care
must be present in the ROOTS III Resides Detail Footnote for the address to be redirected to th
mate Family Tree Mail Label window.

• Ignore Blank Events I3–6 & M2,3 — Select this option if you have events that are defined but not u
in lines 3, 4, 5, or 6 of Individual Edit Records and lines 2 and 3 of Marriage Records in ROOTS
ROOTS III individual records have six fields for events, while marriages have three. If these field
not used, they are considered blank events. To prevent them from being imported into Ultimate Fa
Tree, select Ignore Blank Events. This prevents Ultimate Family Tree from creating events for an in
ual when they did not occur. An event is not considered blank if it has at least a date, place, or foo

• Include “Ref” Text Files — Include text files that are named using the reference field.

See page 178 for import options common to GEDCOM and ROOTS III.

6. Choose OK.

7. In the Save As Dialog Box, enter a file name for the new project, with a .PRO extension.

8. Choose OK to start the conversion.

9. When the conversion is complete, enter the appropriate data in the Project Information window

10. Choose OK to close the Project Information window.

For more technical information on how data in ROOTS III converts to Ultimate Family Tree, see
Appendix, “Notes for ROOTS III Users,” page 220.

Importing GEDCOM from Family Tree Maker for Windows
If your family's data has been stored in Family Tree Maker for Windows (version 2 or 3), here’s how to
fer it to Ultimate Family Tree:  

1. In Family Tree Maker, from the File menu select Copy/Export Family File.

2. In the File Format pulldown list, select GEDCOM (*.GED).  Make a note of the file name you are
ing to. Click the OK button.
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Note If you receive an error message that the file already exists, press OK, type an unused file
in the File Name box and press OK again.

3. In the Export to GEDCOM dialog box, make the following selections:
Destination: ROOTS
GEDCOM: Version 4
Character set: ANSEL

then click OK.

Note If you want to export data from the Title, Alias or Address entries in your database, or ha
used the Facts feature of Family Tree for Windows, before clicking OK you must first click Field
Export and follow the procedures for GEDCOM export in the Family Tree Maker manual.

4. When Family Tree Maker has finished writing the file, close Family Tree Maker and start Ultima
Family Tree.

5. From the File menu, select File Open.

Follow the steps starting on page 174 to convert the GEDCOM file.

Common GEDCOM and ROOTS III Import Options
Names

• Convert AL SMITH to Al Smith — Select this option if your GEDCOM file has names in all upperca
and you want to convert the names to upper/lowercase.

• Smith, Al to Al Smith — Select this option if your GEDCOM file has names entered as surname, g
name, and you want to reverse them to given name, surname.

Note Additional editing may be required if you choose either of these options. If you use the c
conversion option, MCLEAN is converted to Mclean, whereas you may want it to be McLean. If
reverse surname option is used, Smith, Al Jr. is converted to Al Jr. Smith.

Free Date Format Select one of the four free-form date options. This converts dates in the G
COM file to the format selected and places them in the free-form date field of the Individual Record wi
The free-form date prints on unstructured reports such as the Genealogy Reports.
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You can edit free-form dates in the Individual Record window at any time. Free-form date option
include:

• Month, day, year March 3, 1908

• Day, month, year 3 March 1908

• Day, abbreviated month, year 3 Mar 1908

• Day, abbreviated all caps month, year 3 MAR 1908

Note It is important to select the appropriate date format to ensure that Ultimate Family Tree a
matically enters dates correctly. If you do not choose the correct date format now, you must ma
change dates later.

Other

• Build Footnotes — Select this option if you want Ultimate Family Tree to automatically create the
footnote text that is to print on reports, such as the Genealogy Format Report.

Note The Build Footnote process increases the time required to convert a file, depending on t
number of footnotes in your GEDCOM or ROOTS III database. If you do not choose to build foo
notes, evidence and sources are imported and can be converted to footnote text later. You can 
rebuild footnotes using the Check window opened from the Utilities, Project menu.

Figure 8-6: GEDCOM and ROOTS III Import Options Windows

Common options

Common options
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• Include Last Changed Date — Select this option if your GEDCOM file supports the CHAN tag for th
Last Edit Date for individual records. This date is placed in the Research Note text window in the
vidual Record window.

• Add to Open Project — Select this option to merge the GEDCOM file into the current Ultimate Fam
Tree project. If no Ultimate Family Tree project is open, the Add to Open Project button is unava
(dim). Cancel the options windows and open the project with which you want to merge the new
project.

Importing Unrecognized Events
Events in ROOTS III, for which you either created your own legend (for example, identifying name) or
the Extra event legend, transfer into Ultimate Family Tree with the characters #R3 directly in front of the 
event name (for example, #R3Name). Events from other genealogy programs that are not recognized by 
mate Family Tree transfer with the # character in front of the event name.

When transferred these events do not have role text or GEDCOM tags. They will not print in tex
reports and will not be included in GEDCOM exports. To transform them into fully recognized and us
event records within Ultimate Family Tree, you must first find the event and individuals connected to 

1. From Search menu, choose Events.

2. Select the # event from the Possible Events list.

3. Select Use Selected Event below the Possible Events list.

4. Do not check the Selected Places check box.

5. Enter today’s date in the Before Date field (leave the After Date field blank).

6. Select the option, Replace the list with those found.

7. Choose the Search button. The Results list opens.

Figure 8-7: Events Search Window

GEDCOM and ROOTS III
events import like this
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8. Select the first name in the list, and double-click the left mouse button or press F5 to open the I
ual Record for that person.

9. Create a new event for that person using either an Ultimate Family Tree event type or a New E
type you create. See “Adding Events” on page 3 and “Creating a New Event Type” on page 33.

10. Delete the original # event by highlighting the event name on the Individual Record and pressin
Del (delete) key on the keyboard.

11. Save the record by clicking the Save button on the Toolbar or pressing F9.

12. Press F4 or choose the next button on the Toolbar to move to the next person in the Events Se

13. Repeat Steps 1–12 for any other # event types.

Exporting Data to Another Program using GEDCOM
The GEDCOM standard was developed to provide a flexible format for exchanging genealogical data
program that reads and writes GEDCOM data can exchange data with other GEDCOM-compatible p
grams.

Ultimate Family Tree provides four GEDCOM export options: Basic, ROOTS III, Family GEDCO
Version 5.3, and Event GEDCOM Version 1.0. The first three GEDCOM options have been approved 
Family History Department of the LDS Church for submitting GEDCOM format data to the LDS Ance
File. Approval of Event GEDCOM is pending.

The Ultimate Family Tree GEDCOM files compatible with GEDCOM Version 5.5 and earlier con
individuals through families. In this sense, GEDCOM 5.5 and its ancestors are family-oriented.

Creating a GEDCOM File
1. From the File menu, choose Save As.

Figure 8-8: Save As Window

Choose GEDCOM
from drop-down list
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2. Select GEDCOM from the Save As File Type drop-down list. Type the name in the File name fie
Choose OK. The Save As GEDCOM Options window opens, providing selections that determin
format and content of Ultimate Family Tree GEDCOM files.

3. Use Grouping to create a GEDCOM export with only part of your project. To export a selected f
line, use the Relationship Search window to define the family, and then add the results to the Gr
list. Check Use List under Individuals in the Grouping field to export only the individuals found in
Grouping List.

4. Choose a GEDCOM type from the GEDCOM Format Group:

• Basic — Creates a GEDCOM file that contains information about the basic events of birth, marr
death and burial in addition to family links. Basic GEDCOM export is useful for sending minimal 
to programs, such as special purpose utilities used for creating genealogical charts.

• ROOTS III — Creates a GEDCOM file similar to those created by ROOTS III. This GEDCOM form
uses the GEDCOM 4.1 specifications and exports events accepted by ROOTS III.

• Family 5.3 — Uses the GEDCOM 5.3 specification. Use this option if you are transferring informa
to another genealogy program that currently supports the GEDCOM 5.3 specification.

Miscellaneous and Medical information, except for Flags and Ancestor and Descendant Int
is not exported. On the Individual Record window, Individual Text Footnote, Event Text Footnote
Research Notes information is not exported. Media files are not included.

• Event 1.0 — Provides the most complete information transfer. It is an extension of Family Version
that incorporates features for transferring events, roles, sources, and images. Event GEDCOM 
designed to be compatible with lineage-linked systems, while providing extensive support for ev
oriented systems, such as ROOTS IV. At the current time, only Ultimate Family Tree, Visual RO
and ROOTS IV support Event GEDCOM.

Figure 8-9: Save As GEDCOM Options Window

Export only those
in Grouping List

Check if GEDCOM
is to be submitted
to LDS Church
Ancestral File

Options for
Event GEDCOM 1.0
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Note Photo files are created for all linked images and are located in the directory in which the 
COM file was saved. They normally have an extension that includes their format, such as .PCX
Ultimate Family Tree finds a file of the same name, it converts the extension to a number from 1 t

Creating an Event GEDCOM

The Event GEDCOM group is unavailable unless you select Event 1.0 in the GEDCOM Format g
The Event GEDCOM file can contain a dictionary of event and source types. Use Event/Source
radio buttons to determine how much event/source type information is included in the file.

The Data selection options provide a way to tailor the data content of the GEDCOM file and cre
special files. For example, it is possible to create a GEDCOM file containing places for New Eng
or sources useful for California research before 1900.

• Individual — Includes information about individuals

• Family — Includes lineage-linked family information. This option is required to maintain compat
ity with lineage-linked family systems. It is not required when communicating with other Event V
sion 1.0 programs such as ROOTS IV.

• Event — Includes information about events

• Place — Includes information for places

• Source — Includes information for sources

• Image — Includes information about images

Note If you have created a media library in Ultimate Family Tree, linked media are exported to
external files that can be sent with the Event 1.0 file. These media are given a name that starts
followed by a linking number, and an extension that shows the type of media (for example, .PCX
etc.). Keep these media files with the GEDCOM file.

Figure 8-10: GEDCOM Options Window

Do not include event and source
types in Event 1.0 header

Include event and source types
used in the Event 1.0 transmission

Include all event and source types
in the Ultimate Family Tree libraries



1 8 4 SE C T I O N 8 : M A N A G I N G  Y O U R D A T A

ubmit 
ED-
reat-
step 6.

idual.

 and 

ss you 
l 

, 

he 
rive, 
 disk 
5. In the Destination group, choose Ancestral File, and then the Submitter button if you intend to s
a GEDCOM file to the Family History Center of the LDS Church. This option indicates that the G
COM transmission is intended for submission to the LDS Church Ancestral File. If you are not c
ing a GEDCOM file to be submitted to the LDS Church do not check Ancestral File and skip to 

An LDS submission requires these steps in order:

• Select the appropriate radio button to choose the ancestors or descendants of the starting indiv

• Enter the record number of the starting ancestor or descendant.

• Choose the Submitter button.

• Enter the submitter name, address and phone number.

• Enter any comments concerning the GEDCOM file in the Comments field.

• Choose OK to close the window and save changes.

• Prepare a label for the disk(s) with the title, “Ancestral File,” and the submitter’s name, address,
phone number. Mail the disk(s) to:

Family History Data Control
50 East North Temple
Salt Lake City, UT 84150

6. Choose Indented to create a GEDCOM file in an indented format.

Note Not all genealogy programs can read the indented format. Do not choose this option unle
know that you are preparing a GEDCOM file for a program, such as Ultimate Family Tree, Visua
ROOTS, and ROOTS IV, that can read the indented format.

7. Choose OK.

8. Enter a file name with a maximum of 8 characters in the Name field with the extension .GED.

9. Change the Drive and Directory to the location you want to send the GEDCOM file, for example
\UFT\GEDCOM.

Note Do not export GEDCOM files to floppy disks. Be sure you have sufficient disk space on t
hard drive before starting the GEDCOM export. After creating the GEDCOM file on your hard d
use the Windows File Manager to copy the file to a floppy disk. If the file is larger than one floppy
can hold, use the DOS BACKUP command (or MSBACKUP) to copy the file to multiple disks.

10. Choose Save to start the GEDCOM export.
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Saving and/or Backing up Data
Always make copies of your Ultimate Family Tree project files and library files to protect against disk
ruption and hardware failure. These copies are called backups. Without backup files, you might lose 
days, or even years of work.

To minimize losses due to power failure and machine failure, Ultimate Family Tree provides you
backup features. These features, however, do not ensure against lost work due to damaged or worn 

The Save As window allows you to save the current project as an archive. It is important to back
data regularly to prevent loss of information if there is an unexpected problem with your computer sy
You should back up both project and library files, because they are connected. You do not need to ba
media files if you have not modified the Multimedia Library. If it is ever necessary to restore project, li
or media files, you will have to reenter data entered since the most recent backup. Back up your data often.

Backing up a Project
1. With the project open, choose Save As from the File Menu.

2. Select Backup from the Save file as type drop-down list.

3. Enter the file name, with the extension .SQZ, for the archive you are creating in the file name fi
Remember, enter a different file name for each backup if saving the project, library, and multim
files separately.

4. Select the location in which the backup file is to be saved. This file can be saved to your hard dis
one or more floppies. If you save to a floppy, Ultimate Family Tree will request new disks as the
required to complete the backup.

5. Choose OK. The Save As Backup Options window opens.

6. Select Project to back up the project files.

Figure 8-11: Save As Window

Enter file name

Path to file

Choose Backup from
drop-down list
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7. Select Library to back up the library files.

Note Back up project, library and media files separately with different file names, especially if 
have more than one project. Complete the backup procedure during one editing session. The L
and Multimedia files are common to all projects and need only be archived once for all projects

8. Select Multimedia only if you have modified the Multimedia Library. (The Multimedia files greatl
increase the size of your backup.)

9. Choose OK.

If you save the backup to your hard disk, use the Windows File Manager to copy the archived fi
floppy disk to protect it. If the file is larger than one floppy disk can hold, use the DOS BACKUP comm
(or MSBACKUP) to copy the file to multiple disks. Archive files have the extension .SQZ.

See your Windows and DOS manuals for further instructions on using the COPY and/or BACKU
commands.

Restoring a Backup
A project need not be open to restore projects, but you must be in Ultimate Family Tree. If you restore a
with another project open, Ultimate Family Tree first closes the open project and then restores the old p
When complete, the backup project you have restored will be open. To restore a project, follow these s

1. Choose File on the menu bar.

2. Choose Open.

3. Select Backup from the drop-down list.

4. Select the drive and directory where you placed the backup. If the backup is on a floppy disk, se
drive that contains the floppy disk. The current directory name is displayed above the directory 
box.

5. Highlight the backup file to be restored. Backups have the extension .SQZ, such as FILENAME

6. Choose Open. A warning message will appear, “Note: Restore Project and/or Library files. War
Existing project of same name and/or library will be erased.”

7. Choose Proceed. A message at the top right of the window will state, “processing compressed 

Figure 8-12: Save As Backup Options Window

Back up project files

Back up library files
Back up media files
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Note Restoring the project overwrites all existing files for the project and library being restored
Make sure this is what you want to do before you proceed. If you change your mind, choose Ca
rather than Proceed.

When processing is complete, the restored project opens.

Save As Ultimate Family Tree Project
Use the Save As window to save the current project as an Ultimate Family Tree project with a new na
This option is handy when you want to split part of the project, to create a working copy in another dire
using the same name, or to keep a working copy of the project using another name.

1. With a project open, choose Save As from the File menu.

2. Select Ultimate Family Tree from the Save file as type drop-down list.

3. Enter a new file name for the new project, with the extension .PRO in the Name field.

4. Select the directory for saving the new project. Use a different project name to avoid confusion.
are saving the project using the same file name, place the new project in a directory different fro
occupied by the current project

5. Choose OK. The Save As Ultimate Family Tree Options window opens if there are individuals in
Grouping list.

Note Use the Grouping options if you want to split part of your project into a new project. For 
detailed steps on how to split a project, see “Splitting a Project” on page 188.

6. Choose OK. When the new project is created, it is the open project. The original project is close
procedure does not change the original project file in any way.

7. Choose Cancel if you want to close the Save As window and return to the current project witho
ing changes.

Note Do not save to a floppy disk. Because the Save As Ultimate Family Tree feature creates 
project, you must have sufficient disk space on the hard drive before saving the project. Allow a
2.5 MB of free disk space for every 1,000 individuals.

Figure 8-13: Save As Familiy Gathering Options Window

Check to split part of project
into a new project
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Splitting a Project
The following procedure shows how to split a portion of an existing project into a new project. For exa
you can create a new project containing your spouse’s ancestors from an existing project. The three 
steps are finding the individuals, moving those found into the Grouping list, and creating the new pro
Later you can remove the individuals in the newly created project from the original project. Modify the
instructions to fit your specific needs.

To find the individuals you want to use in a new project, follow these steps:

1. Choose Relationship from the Search menu.

2. Press F10 or click the Find button on the Toolbar to find the starting person for the search.

3. Select Ancestors Plus Their Descendants in the Relationship Options list.

4. Set the Generation and Descendant Limits options to 999.

5. Check the Add Other Spouses box to add spouses not already included to the Search List.

6. Choose the option, Replace the list with those found, from the drop-down list.

7. To check the search without committing the results to the permanent search list, choose Preview
Escape to return to the Search window.

8. Choose Search to create the Search list.

9. Choose Group to move the contents of the search to the Grouping list.

To create the new project, follow these steps:

1. From the File Menu, choose Save As.

2. Select Ultimate Family Tree from the Save file as type drop-down list.

3. Enter a new file name with the extension .PRO for the new project in the Name field.

4. Select the directory for saving the new project. Use a different project name to avoid confusion,
wise, you must place the new project in a directory different from that occupied by the current p

5. Choose OK. The Save As Ultimate Family Tree Options window opens. The number of individu
the Grouping List will be displayed.

6. Check Use List.

7. Choose OK.

Note The new project becomes the open project, and the original project is closed. This proce
does not change the original project file in any way. The description name you entered for the o
project will transfer to the new project. Open the Project Information window from the File menu
enter a new name on the Description line.

8. Choose Cancel if you want to close the Save As window and return to the current project witho
ing changes.
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Note Because the Save As Ultimate Family Tree feature creates a new project, be sure you ha
ficient disk space on the hard drive before saving the project. Allow at least 2.5 MB of free disk 
for every 1,000 individuals. Do not save to a floppy disk.

You might want to remove the records in the new project from the original project. If you have n
completed a new relationship search or created a new grouping list, continue with the steps below. If
have created another relationship search and/or grouping list, you will need to repeat steps you took
ously to find the individuals for the new project.

1. Open the original project.

2. Choose Grouping from the Search menu.

3. Select Invert Selected.

4. Repeat the steps to create a new project.

When you complete these procedures, you will have two new projects from the original project,
the original project intact. After checking the contents of the two new projects, you may want to delet
original project. Make a backup of the original on a floppy disk and then delete it from the hard drive.
page 191 for information on deleting projects.

Deleting Data

Deleting an Individual from the Project
1. To Delete an individual from the project, choose the Find button on the Toolbar or find the name

Individual List accessed from the View menu. Double-click the name to open that person’s Indiv
Record window.

2. Choose Delete Record from the File menu or press SHIFT+F9. An “Are You Sure?” message ap
Choose OK to continue. Another message appears stating, “(this individual) and all references 
her will be removed from this project. This person is linked to ## events.”

3. Choose OK to delete the individual or Cancel if you want to keep the individual.

Deleting Text
Select the text to be deleted and press the Del key on the keyboard. See page 37 for instructions on 
text.

Deleting an Event
To delete an event, select the event in the Individual Record window and press F8 or choose the num
button to the left of the event field to open the Events window. Choose the Delete button below the O
Cancel button on the right. The Events window closes and a message appears asking if you want to d
event. Choose OK.
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Another option is to select the event name, such as Birth, in the Individual Record window and 
the Del key on the keyboard. To respond to the message, “Delete existing event?” choose OK to dele
event or Cancel if you want to keep it.

If you delete an event that is connected to another individual, for example, a marriage event, the
is still connected to the other individual. Open the Individual Record for that other person to delete the
or connect a new individual.

Deleting a Place from an Event
To delete a place from an event in the Individual Record window, highlight the place and press the D
(Delete) key, or choose Cut from the Edit menu. This procedure removes the place from the event, b
from the Place Library. If you change your mind, choose Undo from the Edit menu.

Deleting a Place from the Place Library
1. In the Individual Record window, select a place field and choose the Find button.

2. Highlight the place to delete.

3. Choose the Delete button in the Places window. A message appears stating whether or not this
used in the current project.

4. Choose OK.

Because the Place Library is common to all projects, do not delete a place that is used in another 
project.

Deleting a Source from the Sources List in the Evidence Window
1. Open the Evidence window that includes the source you want to remove.

2. Select the source to remove from the Source List.

3. Choose Selected in the Delete group.

4. Choose Proceed to delete the source and footnote reference (if present) or Cancel to return to 
dence window without deleting the source.

This procedure removes the source from the Evidence window, but not from the Source Library

Delete a Source from the Source Library
1. From the View menu, choose Source List.

2. Scroll the list and highlight the source you want to delete.

3. Double-click the left mouse button or choose Source Record from the Build menu. The selected 
is displayed.

4. From the File menu, choose Delete Record.
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This procedure permanently erases a selected source from the project and library. Because the
Library is common to all projects, do not delete a source that is used in another project.

Deleting a Slide Show
1. From the Build menu, choose Slide Show to open the Slide Show window.

2. Select the Slide Show you want to delete from the Slide Show list.

3. Choose the Selected button in the Delete Show box to delete the selected Slide Show.

4. To delete all slide shows, choose All in the Delete Show box.

Deleting a Project
1. Choose Delete Project from the File menu. A warning window opens with this message, “ARE Y

SURE? ### records will be PERMANENTLY deleted if you choose OK.”

2. Choose OK.

3. Another window appears with this message, “ARE YOU SURE? This project will be PERMA-
NENTLY erased if you choose OK.” Choose OK.

Combining Individuals
The Combine Individuals feature is helpful when an individual is entered more than once in your proje
you want to remove the duplicate person but retain that person’s links.

1. Select the name field and choose the Find button in the Individual Record window.

2. Select the person you want to keep.

3. Choose Identify. A note appears showing the name you selected as the surviving person and w
do.

4. Choose OK.

5. Select the individual to be merged from the Individual list.

6. Close the list by choosing the Close box or by pressing Escape.

Note If the two individuals you are attempting to combine are of a different sex or the sex is ma
as Unknown, you will be prompted to choose OK or Cancel.

7. Leave the Candidate Individual list as is (do not select another name) and choose Merge to com
the two individuals.

8. A message appears showing the name and record number of the individual who will be merged 
name and record number of the surviving individual. Choose OK or Cancel.
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9. If you proceed, another message appears asking if you would like to erase the individual who w
merged from the project. Choose OK or Cancel. In most cases, you choose OK.

10. When you finish the procedure, return to the surviving person’s Individual Record and delete an
duplicate events.

The parents and birth record for the surviving individual remain intact. Ultimate Family Tree dele
parent links for the merged individual. Events and Event Evidence for the merged individual link to th
viving individual. Delete duplicate events. Individual Evidence for the merged individual transfers to th
viving individual. Choose the Individual Evidence button and press the Save/Build Footnote button to
rebuild the footnote.

Note If you started the combine feature at the main name field (not a Parent field) and then de
that person during the combine, a blank individual record will open. If you don’t want to create a
record, choose Undo from the Edit menu.

Combining Places
This feature is helpful when you have entered a place more than once and you want to merge all links
place before removing the duplicates. To combine places, complete the following steps:

1. Select any place field in the Individual Record window and choose the Find button.

2. Select the place you want to keep.

3. Choose Identify. A note appears showing the name you selected as the surviving place and wh

4. Choose OK.

5. Select the place to be merged from the Places list.

6. Close the list by choosing the Close box or by pressing Escape.

7. Choose Merge in the Places window.

Figure 8-14: Candidate Individuals Window

Select the person
you want to keep

Choose Identify
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8. Confirm the place names and choose OK to merge. Do not delete the place if it is used in other 
projects.

A message appears asking if you want to erase the merged place from the Place Library. The pl
choose as the surviving place remains in the Place Library and the duplicate place is deleted. Do not delete 
the merged place if the place you want to combine (not the surviving place) is used in other projects.

Viewing Information About your Project
The Project Information window provides a summary of an open project.

1. From the File menu, choose Project Info.

Figure 8-15: Candidate Places Window

Select the place
you want to keep

Figure 8-16: Project Info Window
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2. The following information is provided:

• Project Control — The name and path of the selected project control file.

• Last Changed — The date the selected project was last edited and saved.

• Project Version — The version number of the current project. In each session where the project 
saved, the version number is increased by one.

• Project Title — The short name for the project.

• Program Version — The Ultimate Family Tree version number.

• Individuals — The number of individuals in the project.

• Description — A short description of the project on the Description line. This description appears
the Title Bar when the project is active.

• Researcher — The name of the principal researcher for the project in the Researcher field. This fe
is optional. You can choose to have this name appear in the footer on printed reports.

• Researcher # — The Researcher’s record number in the Researcher # field if you want the relatio
to the husband or wife to show in Family Group Sheets. If you do not want the relationship to sh
enter 0 in the Researcher # field.

• Address, etc. — The address and phone number of the researcher, using the Address 1 and Add
City, State, Zip and Phone fields. This information can also be included in the footer on printed 
reports.

• Key Families — A Read Only list of surnames found in this project, arranged in order of frequenc
occurrence. The number of times each surname is encountered is shown to the right of the nam
the scroll bar on the right side of the Key Families box to see more.

• Update — Updates the Key Families list shown in the Project Info window. If you’ve entered new 
in a project and return to the Project Info window, choose Update to get a new count of surname
the last edit.

• Comments — The Comments box displays the source of the data used in this project, including 
import method, date, and time. Enter and edit general information in this box. Use the scroll bar 
right side of the Comments box to see more.

Desktop Preferences
You can customize Ultimate Family Tree in several ways.

1. From the Utilities menu, choose Desktop Preferences, and then Miscellaneous.
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Select any of the following options:

• Clock — Displays a clock in the lower-right corner of the Ultimate Family Tree window. Select ON
the Clock field and select the 12-hour or 24-hour clock setting.

• Messages — Provides three levels of context-sensitive messages that require a response from y
before continuing. Choose one of the following options:

Critical — Have Ultimate Family Tree ignore inconsistent data and information messages. 
cal messages alert you to an inconsistency or error that may affect the integrity of the data in a 

Plus Inconsistent Data — Have Ultimate Family Tree display critical and inconsistent data m
sages. An inconsistent data message is used when data entry is inconsistent with rules for such 
age, but underlying data is not at risk.

Plus Information — Have Ultimate Family Tree display all critical, inconsistent data and info
mation messages. Information messages provide a reminder that changes are about to be mad

• Image Quality — Sets image compression quality. JPEG compression is applied to 24-bit image
imported into Ultimate Family Tree. Compressing an image reduces the storage space required
also reduces image quality. Experiment with the Image Quality setting to see its effect on the im
setting of 100 provides the highest quality and the least compression.

• Date Format — Specifies the date format in the free-form date field. The date displays and print
this format in all text reports. You can set your preference to have dates display and print exactl
you’ve entered them (as entered) or you can set a date format default (such as 12 JUL 1943). S
through the date options and select the format you want. If you select any option other than as e
modifiers will be converted to full words in the free-form date field, such as ABT to about.

Note Changes to the way dates display and print affect dates entered or changed after you’ve
selected a preference. Dates entered before selecting a date preference remain unchanged.

If you set the date preference to MM/DD/YYYY (for example, 07/12/1943) and enter a date 
as 14/10/1955 for October 14, 1955, the first number will be dropped and the date will convert to
1955 (April 10, 1955).

Figure 8-17: Desktop Preferences Window
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• Toolbar — Controls balloon and bottom line help (visible when the mouse cursor is on an Ultima
Family Tree Toolbar button or a Descendant Box Chart Toolbar button. However, help on the Bo
Chart takes effect after you leave and return to Ultimate Family Tree. The Box Chart Toolbar is 
when Ultimate Family Tree starts. Note that there are two menu bars, long and short, in Ultimate
ily Tree. The Toolbar is not active when the short menu bar is displayed.

• Ultimate Family Tree provides two styles for desktop display, Graphics and Windows Colors.
Use Windows Colors — Sets Ultimate Family Tree to Windows colors selected in the Window

Control Panel.
Wallpaper — Displays a wallpaper as the Ultimate Family Tree desktop background.

The graphics mode can reduce the performance of the program. If you suspect that Ultimate Fa
Tree is running more slowly than it should, switch to the Windows color mode.

When you open certain window while in the graphics mode, the message, “Picture colors m
incorrect. Do you wish to use Windows Colors?” may appear. Choose No to ignore the messag
open the window. Choose Yes to change the desktop display to Windows Colors. Exit and then 
Ultimate Family Tree to change to Windows colors. This message will appear if your graphics mo
is set to 256 colors. If you monitor is set to 16 colors, the Windows Colors will be used.

2. Choose OK to close the Miscellaneous Desktop Preference window.

3. Exit and restart Ultimate Family Tree if you changed the Windows Colors or Wallpaper settings.

Modifying the Name Format
To further customize Ultimate Family Tree, you can modify names in windows. Names can appear al
with additional information such as dates of birth and death.

These options do not affect how names appear in lists or in the editable name fields in the Indiv
Record window.

1. From the Utilities menu, choose Desktop Preferences, and then Name Format.

Figure 8-18: Name Format Window
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2. Select any of the following options from the Add to Name group:

• Nothing — Only the name.

• Years — Names plus Birth and Death years.

• Record Number — The name plus record number.

• Image Info — The name, plus the word Image if an image is linked to the individual.

• Indiv. Flag — The list of flags on the right side of the window that is activated when the radio butt
selected. Select the flag you want from the list. The name appears plus the selected individual 
attached to that name).

3. Check Use Upper Case to display surnames in all uppercase letters.

4. Check Hide Slash ( / ) to display surnames without slash marks. Checking also removes the bra
from titles. This setting does not affect the Individual Record window.

Note After changing the name format, click any open window to display the new name format.

Project Utilities
Ultimate Family Tree offers several features to help you manage your project files. They are found un
Project option in the Utilities menu.

Pack
Packing an Ultimate Family Tree project permanently removes records that have been deleted from yo
project or from a library. This is an important feature to use after deleting a number of records because 
reduces the total disk space used. Ultimate Family Tree also rebuilds all index files associated with the

The Pack process replaces your original project files. Make a backup copy of your project files 
starting Pack.

Figure 8-19: Pack Message Window
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From the Utilities menu, choose Project, and then Pack. To interrupt the Pack process, press E
This stops the Pack and leaves the original file unchanged.

Note Ultimate Family Tree creates large work files during the packing process. If Ultimate Fam
Tree runs out of disk space during a pack, it automatically recovers the original project.

Reindex
Reindexing rebuilds any index files that are associated with an open Ultimate Family Tree project. Yo
should reindex in the unlikely event an error message indicates that an index file is corrupted. From t
ities menu, choose Project, and then Reindex. Ultimate Family Tree informs you when the reindexing
complete. See page 207 for information on error messages.

Check Window
The Check feature tests the files in an Ultimate Family Tree Project and Library. Inconsistent links ar
repaired if possible, and unlinked events removed (for example, birth events remaining after an indivi
has been deleted). An option is provided to rebuild footnotes.

1. From the Utilities menu, choose Project, and then Check.

2. Check any of the following options in the Project box:

• Events and Event Links — Removes events to which no individuals are linked. This option also che
place links to make sure an associated place is in the Place Library. If an associated place is no
(it may have been deleted while in a different project), the place is restored and given the name
ing Place no. nn. The nn will be replaced by the place record number. Edit the place name in th
vidual Record window to change Missing Place to the correct place name. See page 32 for mo
information.

• Add Birth/Death Events — Checks all individuals for birth events. If one is not found, a new event
added and parents are linked. If the Living status flag for an individual is N, Ultimate Family Tre
looks for a corresponding death event. If one is not found, a death event for that person is adde

Figure 8-20: Check Window
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• Find Duplicate Record Numbers — Checks individual record numbers to make sure they are uniq
and reports any duplicates found. Use the Individual Record window to assign unique numbers
“Deleting Duplicate Record Numbers” below.

• Check Parent Links — Checks links to parents.

• Source Links —  Checks source links to make sure an associated source is in the source library.
associated source is not found, the source is restored to the Source Library when the Repair op
chosen. The new source is replaced with a ROOTS III source type and given the name, Unknow
source nn. The nn will be replaced by the source record number. Edit the source in the Source 
window to change Unknown Source to the correct source information.

3. Choose Rebuild Footnotes if you want to rebuild all footnotes. This option is useful if you did no
choose to build footnotes during a GEDCOM or ROOTS III conversion.

The Rebuild Footnotes procedure overwrites any text you have typed directly into the Foot
text field of an Evidence window. If you do not want this text overwritten, do not choose this opt

When you select any of the Project options, the Repair button is activated. You have two ways to
your data.

• Choose OK to check items selected on the left side of the window and prepare a report telling y
what’s wrong. Choose OK to see the list of data that will be fixed when you choose Repair or th
can choose to edit yourself.

• Choose Repair to check the data and repair if possible.

A text file named CHECK.TXT is created when either OK or Repair is chosen. This text file lists 
lems found and changes and repairs that have been made to a project and library. If you want to save
for later use, be sure to rename it before running a new Check option.

Note Running a complete set of tests on a project may take from several minutes to many hou
complete, depending on the size of the project. To stop the Check routine, press the Escape ke

Deleting or Renumbering Duplicate Record Numbers
If the Check routine reports that you have duplicate record numbers, you must delete or renumber on
them. To find duplicate record numbers, from the Utilities menu, choose Project, then Check. Select 
option to check for duplicate record numbers. Choose OK. When the Check routine is complete, a 
CHECK.TXT file displays showing any duplicate records. If no duplicates are found, the file will not b
played.

To delete duplicate record numbers, follow these steps:

1. Press F5 or click the Edit Individual button on the Toolbar to open the Individual Record window
Press F10 and enter the record number, for example, 150. Press Enter, and then OK.

2. In the Individual Record window, change to a record number not being used, for example, chan
record # 150 to 10150. Press F9 to save.

3. Press F10, enter the record number for the duplicate, for example, 150. Press Enter and then O
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4. Choose Delete Record from the File menu or press Shift + F9 to delete this record.

5. Once deleted, press F10, enter the changed record number (10150), press Enter and then cho
Change record number 10150 back to the original number (150). Choose Save from the File m
press F9 to save.

Viewing GEDCOM Exceptions
Ultimate Family Tree maintains a list of the information that did not convert into a project from a GEDC
file. The GEDCOM Exceptions window appears with the GEDCOM file behind it as a read-only file. T
top left corner of the GEDCOM Exceptions window indicates the path and name of the GEDCOM file
are viewing.

1. From the Utilities menu, choose Project, and then GEDCOM Exceptions.

Note If you have deleted or moved the GEDCOM file from the directory from which it was 
imported, and then try to open the GEDCOM Exception window, the message, “GEDCOM file n
found,” is displayed in the upper right corner of the Ultimate Family Tree window.

2. View the contents of the GEDCOM Exceptions list.

• Individual — Indicates the individual to whom the exception belongs.

• Event — Indicates the event to which the exception belongs.

• Exception Number — Indicates the exception you are viewing.

Figure 8-21: GEDCOM File Window
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• Total Exceptions — Indicates the total number of items that did not convert to the Ultimate Family
Tree project.

• GEDCOM Tag — Indicates the GEDCOM tag that was not imported.

• Exception Note Box — Shows the text that was attached to the selected tag, followed by the word
ignored or not fully converted or unrecognized or ignored to indicate the text was left out of the 
project. To update your data more easily, you can copy this text into a text file or field using the 
and Paste commands from the Edit menu.

Note The words, unrecognized or ignored, indicate that Ultimate Family Tree correctly interpre
the GEDCOM information but did not use it (usually because a conversion option, such as Inclu
Last Changed Date, was not selected). The words ignored or not fully converted, indicate that Ul
Family Tree could not interpret the information correctly.

3. Choose the Next and Previous buttons to scroll through the Exception List in the GEDCOM Exc
tions window.

4. Choose Show to activate a copy of the original GEDCOM file and view where the exception is lo
in the GEDCOM file.

5. Choose the Close box or press Escape to close the GEDCOM file and return to the GEDCOM 
tion window.

6. Choose Remove to remove the GEDCOM exception displayed in the Exception Note box from 
GEDCOM Exceptions list.

7. Choose Remove All Like to remove the GEDCOM exception displayed in the Exception Note bo
all GEDCOM exceptions like it from the GEDCOM Exceptions list.

8. Choose Close to close the GEDCOM Exceptions window.

Opening an External Text File
1. To open an external text file, from the File menu, choose Open.

2. Select Text from the File Type drop-down list.

3. Change to the drive and directory that contains the text file you want to open.

4. Select the file, and choose Open.

Saving An Open External Text File Under a New Name
1. From the File menu, choose Save As.

2. Select Text from the File Type list and choose OK.
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3. Select the drive and directory in which you want to save the file.

4. In the Text File box, enter a name for the file with a .TXT extension.

5. Choose OK.

Exiting Ultimate Family Tree
You can exit Ultimate Family Tree two ways:

• Press Alt + F4 to cancel Ultimate Family Tree and quickly returns you to the Windows desktop.

• From the File menu, choose Exit, or choose the Close box.

Note It is not necessary to close a project before exiting Ultimate Family Tree. If you close Ultim
Family Tree with a project open, that project will be open the next time you start Ultimate Family
Tree. If you close the project before exiting, the next time you start Ultimate Family Tree you wi
need to choose Open from the File menu to open a project. See page 12 for more information o
ing an existing project.
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This appendix provides answers to questions users commonly ask, and solutions to problems somet
encountered in Ultimate Family Tree. See “Did You Know?” on page 23 for more information.

Installation Troubleshooting
If the installation takes more than a few minutes, the directory specified by the TEMP environment va
may be full of files. The Ultimate Family Tree install program stores temporary files in the directory sp
fied by the TEMP environment variable. To determine whether your computer has a directory designa
temporary files, type SET at the DOS prompt, and check the text that is displayed for the TEMP variable
example, TEMP=C:\TEMP.

Check for the directory specified by the TEMP environment variable. If it does not exist, create i
does exist, check the contents of the directory, and delete all temporary files with the extension .TMP
avoid deleting temporary files that are in use, quit all applications, including Windows, before deleting
files. If the TEMP directory is C:\DOS, edit the AUTOEXEC.BAT file and change the TEMP variable to
point to another directory, such as C:\TEMP or C:\WINDOWS\TEMP. If you specify a directory that d
not exist, create it.

Consult your Windows and MS-DOS manuals for more information on deleting files, creating dir
ries, and editing the AUTOEXEC.BAT file.
2 0 3
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Frequently Asked Questions
How can I make Ultimate Family Tree run more quickly?

Ultimate Family Tree stores and displays the facts in your family history with sophisticated data
software that requires considerable computing power. Depending on your machine, you may want to
Ultimate Family Tree and your system to increase the program’s speed.

A number of techniques to accomplish this are listed below. Some are easy; others are best do
someone with experience in configuring computer systems. The only way to find out which ones may
effective on your computer system is to try the ones you are comfortable with, and see what helps.

Caution Before changing your system’s configuration, be sure to note the original configuratio
that you can restore it if necessary. Save copies of any configuration files you edit.

• Configure Ultimate Family Tree to use the standard Windows colors in the screen display. Depend
your video card and driver, this may speed the program up considerably. See page 196 for instruc

• Configure your video driver to use fewer colors. If your video driver is set to a 16-bit (65536 color
32-bit (16.7 million colors) mode, you will speed the program up by switching to 256 colors.

• Do not use disk compression software. Use of programs such as Doublespace or Stacker can sl
system down.

• Your system’s hardware speed affects the performance of Ultimate Family Tree. All other things 
equal, a system with more memory, or a faster hard drive and video card, will perform faster. Yo
also speed your hard drive up by unfragmenting it periodically, using the DEFRAG command in
DOS 6, the Defrag tool in Windows 95, or a utility such as Norton’s SpeedDisk.

The remaining techniques are useful for Windows 3.x only, and do not apply to Windows 95:

• Use a disk caching program such as SMARTDRV or a third-party program. This program will be
ified in your CONFIG.SYS file. Also, if your system has less than 16 megabytes of RAM, do not 
cache size of more than 512K.

• Configure Windows 3.x to use 32 bit disk access. In the Windows 3.x Control Panel, select Enh
click on Virtual Memory, then Change. Select the Use 32 Bit Disk Access and File Access check
boxes.
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Can I merge a Visual ROOTS or ROOTS IV project with an Ultimate Family Tree project?

Although Ultimate Family Tree, Visual ROOTS, and ROOTS IV projects use the same basic file 
ture, you can’t merge a Visual ROOTS or ROOTS IV project into an Ultimate Family Tree project unles
two projects are using the same library files. When you attempt to merge a Visual ROOTS or ROOTS
project into an Ultimate Family Tree project, Ultimate Family Tree checks to make sure both projects
using the same library files. If they are not, the merge feature is disabled and you must use GEDCOM
merge the two projects. Print a Project Summary report for each project. In the file list, look for files th
being used for both projects.

Can I Open a Visual ROOTS or ROOTS IV Project in Ultimate Family Tree?

Yes. From the File menu choose Open. Select Ultimate Family Tree, Visual ROOTS, or ROOTS
Project from the drop-down list. Change to the drive and directory that contains the Visual ROOTS or
ROOTS IV project you want to open. See “Using Visual ROOTS, ROOTS IV, and Ultimate Family Tre
Together” on page 219.

How do I split my project?

See page 188.

Why can’t I change the fonts for some reports?

Ultimate Family Tree automatically determines the font size and style in some structured report
as Lists and the Box style Calendar. The font style can be changed in Pedigree reports, but the font 
fixed. If you wish to use a different font style or size, print the report to a file and use a word processor
and print the report.

Why is the Find button sometimes dim on the Individual Record?

The Find button is available only when the cursor is on a name or place field.

How do I get events without dates to print in the proper order?

Ultimate Family Tree places all events in chronological order by the date entered in the Sort Date
Events without dates will print first, followed by those with dates. When you know the order in which e
took place, but do not have dates, enter a date in the Sort Date field for each undated event to place th
in the proper order. For example, if you know the birth order of the children in a family, but do not kno
birth dates, enter an approximate date for each child in the Sort Date fields for their births, making su
oldest child has the earliest Sort Date. The Sort Date will not print in the report, but Ultimate Family T
uses it to place events in chronological order. To edit the sort date, press F8 on an event or choose t
bered button to the left of the event name in the Individual Record window to open the Events window
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How do I edit place names in Ultimate Family Tree?

You can edit the spelling of place names in the Place field on the Individual Record or Events w
dows. See page 25.

How do I add a sibling when I don’t know the parents for an individual?

To use the New Sibling button on the Individual Record, you must enter a parent in either the M
and Father fields. If you do not know the parents for a group of siblings, enter a name for the father o
mother in the one of the parent fields. For example, for an individual named John Smith, you could e
mother or father named Unknown /Smith/, or (-----) /Smith/, etc. With at least one parent named, you can 
enter siblings.

How can I turn off the note messages?

Ultimate Family Tree provides three levels of context-sensitive messages that require a respons
you before continuing. To turn off all but the most critical messages, from the Utilities menu, choose 
top Preferences, and then Miscellaneous. In the Messages group, select Critical. Choose OK to clos
Desktop Preferences window.

How do I turn off graphics and wallpaper?

Ultimate Family Tree runs faster without the default graphics and wallpaper. To turn them off, fro
the Utilities menu choose Desktop Preference and then Miscellaneous. Select Use Windows Colors 
Wallpaper, None.

What should I do when I get the message “At least one other source has the same first abbreviation”
when creating new sources?

Abbreviation 1 is used to identify the source in lists. If possible, change Abbreviation 1 to somet
unique so that the source is easily identifiable in lists. If not possible, leave the duplicate, but be aware
duplication when adding sources to evidence windows.

How does Ultimate Family Tree store data?

Ultimate Family Tree organizes family history information into projects. If you are researching y
own family, keep all your research data in one project. If you are a professional genealogist, you will 
bly have at least one project for each client.

When you begin a family history project, Ultimate Family Tree asks you to give your project a n
If, for example, you call your project “SMITH,” Ultimate Family Tree creates two project control files: 
SMITH.PRO and SMITH.FPT. The information Ultimate Family Tree needs to manage your project fi
stored in these two files.

Specific information about individuals and events in their lives is stored in several files managed 
project control files. Approximately 25 to 30 numbered files belong to each project, and begin with the
two or three numbers. Each numbered file has two or three different extensions: .DBF (database files
(memo files), and .CDX (index files). You can print a Project Summary report to show how each num
file is used and the drive and directory that contains the file.
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Some of the information you enter can be used in more than one family history project. Ultimate
ily Tree stores this information in special libraries that can be accessed by any project you’re working
Ultimate Family Tree maintains libraries for places, sources and source types, event and role types, a
timedia. These common libraries save you time and increase the consistency and reliability of your d

Note Because the library files are common to all projects, do not delete places, sources, or m
dia that might be used in other projects. Deleting an item from a library will remove the links to 
item in the current project, but will not remove links in unopened projects. If you ever need to rei
Ultimate Family Tree, be sure to back up your library and multimedia libraries before you reinsta
install only the program files.

Troubleshooting
This section lists error messages and possible problems you might experience in Ultimate Family Tre
what you can do if you encounter them.

General Errors

Error 15: Not a database file

The file which Ultimate Family Tree is trying to open may be corrupted. Restore the most recen
backup of your data.

Error 26: Database is not ordered

This message usually means there is a problem with an index file. From the Utilities menu, cho
Project, and then Reindex to rebuild the index files. If reindexing does not correct the problem, rebuil
project files by creating a duplicate project. See “Save As Ultimate Family Tree” on page 187 for step
create a duplicate project. When you are certain the project has been fixed, you can delete the origin
project. If creating a duplicate project does not correct the problem, try reinstalling the program files o
(not a full installation). See “Reinstalling Ultimate Family Tree” on page 6.

Error 41: Memo file is missing/invalid

A file which Ultimate Family Tree is trying to open is either missing or corrupted. Rebuild all pro
files by creating a duplicate project. See “Save As Ultimate Family Tree” on page 187 for steps to cre
duplicate project. When you are certain the project has been fixed, you can delete the original projec
ating a duplicate project does not correct the problem, try reinstalling the program files only (not a ful
installation). See “Reinstalling Ultimate Family Tree” on page 6 for instructions.

Error 43: Insufficient memory

Refer to your Windows manual for information on freeing additional memory.
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Error 56: Not enough disk space

Ultimate Family Tree needs approximately 2.5 MB free disk work space for every 1000 individua
the open project. Delete any programs or files that you do not use to free additional hard disk space.
save a project or file to another drive or floppy disk, make sure the disk has sufficient space. This err
also occur if you have duplicate record numbers or an individual is linked as his or her own ancestor.
for duplicate record numbers using the Check routine found in the Utilities, Project menus. Check you
for incorrect links.

Error 202: Invalid path or file name

Make sure the name in the File Name field is a valid DOS file name. The name must be eight c
ters or less, no asterisk (*) or slash (/) characters. See your DOS manual for more information on val
names. Ultimate Family Tree adds the extension for the file type being created.

Error 1707: Structural CDX file not found

This message indicates that an index file is either missing or corrupted. Reindex the project by 
ing Project, and then Reindex from the Utilities menu. A file that Ultimate Family Tree is trying to ope
either missing or corrupted. Rebuild all project files by creating a duplicate project. See “Save As Ulti
Family Tree” on page 187 for steps to create a duplicate project. When you are certain the project ha
fixed, you can delete the original project. If creating a duplicate project does not correct the problem,
reinstalling the program files only (not a full installation). See “Reinstalling Ultimate Family Tree” on p
6 for more information.

General Protection Faults

A GP fault signifies that something unexpected has happened in the Windows environment, usu
improper memory access. In other words, something running in the Windows environment is trying to 
memory in a location that it did not have access to. All memory management in Windows is handled b
dows. When applications and Windows components directly access memory, the result is often a GP

Certain video cards may cause a conflict. Set your monitor to Standard VGA in the Windows Se
temporarily resolve the conflict. Contact the video card manufacturer for a new driver. For a list of vid
cards, screen savers and third party desktops that have been identified as causing possible conflicts,
bleshooting in the online help.

Event Type not found

The event type you selected from the event list is not in the library. This is usually caused when
use a ROOTS IV library in which the event type has been deleted. It also occurs when you start a pro
using a library different from the one used when a new event type was defined. If you wish to use this
type, create a new one by choosing New, and give the new event type a distinctive name.



T R O U B L E S H O O T I N G 2 0 9

 Ulti-

vent, a 
ry 
the 

 page 
nd then 
he new 
ce name 
the 
t. 
he name 

 that 
cord.

eds, 
ll pro-
 “Rein-

eld.

auses 
 
bject 
Format not allowed

The image file you are trying to open is either corrupted or the image format is not supported by
mate Family Tree.

Error creating OLE object

The file you are attempting to add to the Multimedia Library is not a valid OLE file.

Some place names say Place missing from Library

Each place in the Place Library uses an internal record number. When a place is added to an e
link from the event to that place record number is created. If that place is missing from the place libra
because you deleted the place in a different project, you deleted the Place Library, or you overwrote 
Library files by reinstalling the entire program, the link to a valid place is broken.

To restore the missing place, backup your Project an Library files. See “Backing up a Project” on
185. Choose Project from the Utilities menu, and then Check. Select all options in the Project group a
choose Repair. Any places used in the current project that are missing from the library are restored. T
place is given the name, Missing Place no. nn. The nn represents a place number. To change this pla
to the correct name, return to the Individual Record window that contained the missing place. Tab to 
place field, Missing Place no. nn, and overwrite Missing Place with the correct place name for that even
Press F9 to save it. A message appears stating that the place was Missing Place no. nn and is now t
that you just typed. Choose Yes to change the spelling to the new name.

Be sure to enter the correct place name. The new place name will now be attached to all events
originally used this missing place in the current project and to all other projects that use this place re

File does not exist (upon opening Ultimate Family Tree)

If you have intentionally or accidentally deleted a program file that Ultimate Family Tree later ne
you might see this message. You might need to reinstall the program files only. Do not reinstall the fu
gram or data entered in the Library files (places, sources, and/or media information) will be lost. See
stalling Ultimate Family Tree” on page 6.

File too large for Ultimate Family Tree

The external text file you are attempting to import is too large for the Ultimate Family Tree text fi

Computer locks when leaving Windows

Some OLE servers (such as Windows Media Player) interfere with Ultimate Family Tree. This c
Windows to lock (freeze) when exiting, requiring that you use Ctrl-Alt-Del to reset your system. Using
Object Packager to link OLE objects prevents this problem. See page 155 for information on using O
Packager.
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Display Errors

Individual, Marriage or Place Lists contain strange names in the column titles

If the View lists contain strange names (for example, INO instead of numbers) in the column titl
pack the project using Pack from the Utilities, Project menus.

Individual, Marriage or Place Lists contain strange characters

Ultimate Family Tree uses the Arial font in View lists. If the Arial font is not installed in Windows,
strange characters can appear in View lists. Use the Windows Control Panel to install the Arial font. Se
Windows manual for further help. Other fonts used by Ultimate Family Tree windows are Sans Serif, 
rier New and Times New Roman.

When A Descendant Box Chart opens, List windows (Individual, Marriage and Source) close

Ultimate Family Tree closes all browse windows before opening a new Box Chart window. This is no

No names are displayed in the Candidate Individuals list

There are two possibilities: Ultimate Family Tree has not found any matching individuals, or the
project needs to be thoroughly indexed using the Check routine (with no options selected) from the U
Project menus.

Event details are displayed twice when viewing an Individual Summary

This is normal. Because the Individual Summary shows a summary of all the information entere
an event, it displays the text that will be printed in the report as well as the basic data entered in the d
field. For this reason, you can view the more extensive event information that can be entered into ROO
and then accessed in Ultimate Family Tree. What you see as a duplicate detail on the computer scre
not print in your report.

The windows are non-proportional, out-of-sync, or words overlap

Ultimate Family Tree uses the Arial, Sans Serif, and Courier New fonts in various windows and 
If these fonts are not installed in Windows, strange characters and distortion can occur. Use the Wind
Control Panel to install the missing font. See the Windows manual for further help.

Displaying Images and Screen Resolutions
The resolution of your computer display adapter and monitor directly affects the quality of the images
display. Resolution is determined by the number of pixels (picture elements) on the monitor and the n
of colors per pixel. A SVGA monitor, having 480 x 640 pixels and 256 colors is the minimum recomme
configuration for displaying images. Image quality improves dramatically as pixels and color depth inc

If you are using a system that is limited to 256 colors, configure Ultimate Family Tree to use the
dows Colors option. See page 196 for more information.
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Media Troubleshooting

Problem with a server program or media device

If you run into problems with any server, sound card, or scanner, make sure you are using the l
version of the software and drivers. Contact the manufacturer for advice and information.

Error creating OLE

The file you selected to add is not an OLE file. Copy it to the clipboard and paste it into the OLE
dow.

Image Edit window appears inactive when adding narrative

If you minimize rather than close Sound Recorder (or click the mouse anywhere on the desktop
Image Edit window will not be active. Press Escape to close Sound Recorder and activate the Image
window.

Link to OLE server not found appears when you try to play an OLE file

The file you selected is not on the hard drive or the file has been moved from the directory in w
originally was found when linked to the Ultimate Family Tree Multimedia library. This message will als
appear if the OLE file has been converted to static.

Slide Show Troubleshooting

The server is activated during a slide show

Convert the slide to static (break its link with its server). See “Editing an OLE File” on page 158

MIDI file will not play during slide show

Use digitized images for the slide show without narratives. Turn off sound effects when playing 
show. To test whether your MIDI server can play while another server is active, start the MIDI slide fro
Multimedia window. After it starts, play a digitized image that has a narrative. If the music stops, it’s be
two servers cannot be active at one time. See “Slide Shows and OLE” on page 170.

This device is being used by another application when viewing a Slide Show

This message appears when no sound board is installed. Uncheck the Sound Effects option in th
Show window.

First slide flashes before each slide

Preview and Play Slide Shows flash the first image before displaying the next image. This is no
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Printing Errors
If you have trouble printing reports or report formatting, be sure you have the latest printer driver inst
for your printer. Contact the manufacturer of your printer for the latest driver. Consult the Windows m
for instructions on installing printer drivers.

Cannot print an index

Before printing an index, the index must be collected using the Print window. You must enter a ch
title for reports before the Collect Index option is available. See page 118.

The indexing starts on the wrong page number

Collect the index immediately before printing the report. Check the starting page number for the 
to be indexed in the Print window before collecting the index. If the index has been collected properly
the starting page number for the report is still incorrect in the index, make sure you are using the late
sion of the printer driver used to collect the index.

The index is slightly off

Because of differences in the way printers process fonts and movement commands, the index c
accumulate error. To review and correct the index before printing, choose Edit on the Index Report w
See page 119.

Window says, “Now exporting” when I’m collecting an index

The index is printed to a file during the collection process. It is stored in the Index report window
where it can be viewed or printed using your default printer.

The Image, Endnotes, Index, and Calendar Report menu selections are dim

If you chose the Print to Rich Text Format (RTF) file option in the Print Setup window, these rep
cannot be sent to an RTF file. Choose a printer instead.

The Index and/or End Notes print options are dim

Make sure you have printed a report with Include Index selected and you have built footnotes. I
End Notes report option is dim, a report which includes footnotes has not yet been printed. See “Cre
Footnotes” on page 44.

The report Use Grouping options are dim

No individuals have been found in the Grouping list. See “Grouping” on page 78.

Box Chart printing problems

If you experience problems when trying to print a large box chart (over 50 pages), check the Ab
Help topic in the Ultimate Family Tree Help menu (Press F1). The percentage of system resources a
is shown. To print a large chart, this figure may need to be at least 70–75%. Consult your Windows m
for information on freeing additional memory.
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Before printing a large report, be aware of the amount of available space on your hard drive. Du
the printing process, special temporary files are created (spooler files), which can consume a consid
amount of hard drive space. A 200-page report will use approximately 9MB. Once the printing is comp
these files are automatically deleted.

Data is Cut Off in Structured Reports

The font size is too large. Use Page Setup in Ultimate Family Tree File menu to reduce the font

Duplicate Chapter title found

Another report has been printed using the same chapter title entered for the current report. If a 
title has not been entered, another report without a chapter title was previously printed. If you procee
footnotes for the previous report with the same chapter title will be overwritten with the footnotes for t
current report. Choose the Reset buttons in the Print window to clear all previous chapters, footnotes
indexes.

Footnotes do not appear at the bottom of a Family Group Sheet

Make sure you have checked the Footnotes check box in the Family Group Report window and
you have built the footnotes. See “Creating Footnotes” on page 44.

<FROOTS> or <F font name> appears in printed reports or print preview

Ultimate Family Tree cannot find the ROOTS or font name font. The ROOTS font is supplied with 
mate Family Tree. If you have just installed Ultimate Family Tree, be sure to restart Windows so Window
recognize and use this font. Make sure that font is installed by checking the font list using the Windows C
Panel. Reinstall the font if necessary. See your Windows manual for information on installing fonts.

Place names are shortened or abbreviated in reports

Some structured reports, such as the Pedigree Chart, are designed with a 30-character limit to 
names. Ultimate Family Tree shortens these names, if required.

Print Preview is dim

The Report window is closed or the report is set (in the Print Setup window) to print to a file.

Starting person not in individual grouping list

Grouping is checked and the selected person for the report is not in the Grouping List. Either ad
individual to the Grouping list, or uncheck Use List in the report window.

Portrait and Gallery reports will not print

Make sure the Ready indicator is on next to each image position. Although you do not need to e
image, you must choose Edit and Crop for each image to turn on the ready indicator before attemptin
print the report.
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Appendix B:

Using ROOTS, and Ultimate 
Family Tree Together
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Even though Ultimate Family Tree and ROOTS share the same databases and underlying design, th
not the same program. ROOTS IV and ROOTS V provide more control and flexibility for storing and m
ulating genealogical data. Some data from a ROOTS IV or ROOTS V project is hidden when the proj
opened by Ultimate Family Tree. Most hidden data can be viewed in the Individual Summary and inc
in printed reports but it cannot be edited in Ultimate Family Tree. To modify this hidden data, open th
project from ROOTS IV or ROOTS V and make any appropriate changes.

ROOTS IV and ROOTS V data that cannot be edited in Ultimate Family Tree includes:

• Links connecting individuals to events other than through principal roles

• Sure levels

• Evidence except for the overall event and individuals

• Most event details

• Event flags

• Place levels

• Source details
2 1 5
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It is important to note that no data is lost when opening a project from any of these five program
data entered in Ultimate Family Tree can be edited in ROOTS IV, ROOTS V, Visual ROOTS, and Fam
Gathering (except for multimedia data in ROOTS IV) even though the reverse is not true.

If ROOTS IV, ROOTS V, Visual ROOTS, Family Gathering, and Ultimate Family Tree are installe
your hard disk, projects can be opened and used by all five programs. The following sections provide
lines for the coordinated use of the three programs.

Using ROOTS and Ultimate Family Tree Together

Installing Ultimate Family Tree When ROOTS
or Family Gathering Is Already Installed
The Visual ROOTS and ROOTS IV installation programs usually install ROOTS IV in the ROOTS4 su
rectory and Visual ROOTS in the VROOTS subdirectory. Family Gathering is usually installed in the F
directory. ROOTS V is normally installed in the ROOTS5 directory. Do not install Ultimate Family Tree
ROOTS IV in the same subdirectory because important control files will be overwritten. Ultimate Fam
Tree can be installed in the same directory as Visual ROOTS or Family Gathering. If you install Ultim
Family Tree in the same directory as Visual ROOTS or Family Gathering, it will update that program a
delete the VROOTS.EXE or FAMGATH.EXE file. Since Visual ROOTS or Family Gathering has been
removed, be sure to delete your Visual ROOTS or Family Gathering icon. In Windows 3.x, select the icon 
and choose Delete from the Program Manager File menu. In Windows 95, drag the icon to the Recyc

Managing Libraries when Using Ultimate Family Tree, 
Family Gathering and ROOTS
Genealogical data is stored in an Ultimate Family Tree, Family Gathering, or ROOTS project. The proje
trol file (extension .PRO) keeps track of the files used by the project. The files managed by the project c
file include those containing data unique to the project, such as names and family links, and those cont
data shared with other projects, such as places and sources. The latter files are referred to as library fil

Under normal operation, new projects opened by Ultimate Family Tree, Family Gathering, or RO
use the library files associated with their respective program. If you open a new project with ROOTS 
ROOTS V, Visual ROOTS or Family Gathering, and then open a second new project with Ultimate Fa
Tree, the two projects will have different library files. Once a project is created, you can’t convert its li
files to another set unless you export the project via GEDCOM and then import it into another projec
has the desired library files.

Maintaining a single set of library files when using ROOTS, Family Gathering, and Ultimate Fam
Tree together has the following advantages:

• Data Consistency — Items such as event definitions, GEDCOM tags, event sentences used in re
locations, and source data are identical for all projects.

• Merge Flexibility — Library files must be identical to merge two projects.

• Storage Efficiency — Multiple libraries can consume considerable disk space.
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Using ROOTS IV Library Files
in new Ultimate Family Tree projects
Ultimate Family Tree and ROOTS IV have separate library files but you can use the ROOTS IV librar
with Ultimate Family Tree, if you wish.

The following procedure uses a ROOTS IV library. To use your ROOTS IV library files in a new 
mate Family Tree project:

1. Choose New from the Ultimate Family Tree File Menu.

2. Choose ROOTS IV in the New File window. The ROOTS IV library files are located in the 
ROOTS4\LIBRARY subdirectory

Note To import a GEDCOM or a ROOTS III file using the ROOTS IV library files, open the GE
COM file and import with ROOTS IV. Then, open the project from Ultimate Family Tree.

Opening a ROOTS or Family Gathering Project
from Ultimate Family Tree
From the File menu, choose Open. Change to the directory that contains your project. Note that existin
projects can be opened by choosing Ultimate Family Tree, Family Gathering, Visual ROOTS, or ROOTS
The first time you open a ROOTS IV project in Ultimate Family Tree, the project is updated to include s
fields required by Ultimate Family Tree. This one-time procedure can take a long time depending on the
your file.

Before a ROOTS IV project can be opened in Ultimate Family Tree, you must open it at least on
using Version 1.1 of ROOTS IV.

Opening an Ultimate Family Tree Project from
ROOTS or Family Gathering
Ultimate Family Tree projects can be opened from ROOTS or Family Gathering. Choose Open from th
Menu, and then choose Family Gathering, ROOTS IV, or Visual ROOTS.

Warning While in ROOTS IV, do not merge an Ultimate Family Tree project with a ROOTS IV 
project unless they use the same library files. To see what library files are being used by a projec
a File List from the Project Summary Report window while you are in the project. Check the pat
file names of the library files. The ROOTS IV library files are usually in the ROOTS4\LIBRARY 
directory and named X_??BOOK.*. The Ultimate Family Tree library files are named V_??BOO
Ultimate Family Tree has safety checks to ensure that two projects using different library files c
be merged. ROOTS IV Versions 1.0 and 1.1 do not have these checks. ROOTS IV Version 1.2 an
include the safety checks.
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Restoring a ROOTS or Family Gathering
Archive Project from Ultimate Family Tree
If your ROOTS IV backup files have the extension .ZIP, use PKUNZIP to restore the files from DOS. V
ROOTS, ROOTS IV Version 1.2, Family Gathering, and Ultimate Family Tree backup files have a .SQ
extension. You can restore .SQZ backup files from Family Gathering, Ultimate Family Tree, Visual RO
or ROOTS IV Version 1.2. See page 186 for steps on restoring backup (SQZ) files.

Events and Roles
ROOTS IV and ROOTS V can link an unlimited number of individuals to events through roles. A marr
event might have the bride, groom, best man, maid of honor, and minister linked as participants. Ultim
Family Tree provides linking for only the principal role players (for example, the bride and groom in a
riage). Before opening a ROOTS IV or ROOTS V project from Ultimate Family Tree, mark at least one
cipal for each event. When accessed from Ultimate Family Tree, those ROOTS IV and ROOTS V eve
without a designated principal role are hidden (not displayed).

If an event from ROOTS IV or ROOTS V does not appear in Ultimate Family Tree, make sure at
one principal is marked in ROOTS IV for that event. The event will then be included in that individual’
event list in Ultimate Family Tree. If you have marked all roles as principal in ROOTS IV or ROOTS V
event will be included in all participants’ Individual Records in Ultimate Family Tree. Select the event 
view the bottom line help to see what role the individual plays in that event. See “Searching for Non-P
pal Events in ROOTS IV” in the online Help.

You can create new event types in all five programs, but in Visual ROOTS, Family Gathering, an
mate Family Tree, just one principal role player is assigned. You can assign additional roles in ROOT
and ROOTS V. Events are included in the Ultimate Family Tree event list if the individual is marked a
principal for that event in ROOTS IV.

Principals for user-defined event types added in ROOTS IV and ROOTS V appear in Individual 
Records in Ultimate Family Tree, but the events are not included in the Ultimate Family Tree Add Eve
list. Event types added in Ultimate Family Tree are included in all ROOTS IV and ROOTS V event list
Event types that have been deleted from a ROOTS IV or ROOTS V library used in a project are not av
in Ultimate Family Tree.

Ultimate Family Tree does not require a birth event. If you delete a birth event in Ultimate Family
and attempt to view that birth in ROOTS IV, an Undefined Event will appear. To restore birth events th
have been deleted, run Check and Repair in either Ultimate Family Tree or ROOTS IV. See page 198

Note Some role names were changed in Ultimate Family Tree to accommodate single role eve

Event Details
ROOTS IV and ROOTS V provide two detail fields per event. Ultimate Family Tree provides one detai
for the following events:

Event Detail

burial cemetery

graduation and education events institution or school
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Places
The ROOTS IV and ROOTS V Place Edit window accepts comprehensive information about places. 
mate Family Tree places (up to 60 characters) are entered in the Event Place field of the Individual R
window or in the Events window accessed by choosing the numbered button to the left of the event n
Ultimate Family Tree creates the short place in ROOTS IV and ROOTS V terminology. If you wish to 
additional information about places, open the project in ROOTS IV or ROOTS V and use the Place Edit w

GEDCOM and ROOTS III Import
Except for differences in options, Ultimate Family Tree, Family Gathering, and ROOTS projects creat
importing a GEDCOM or ROOTS III file will have identical data when they use the same library files. S
imported data will be hidden in Ultimate Family Tree. In other words, it doesn’t matter whether you im
data into Ultimate Family Tree, Family Gathering, Visual ROOTS, ROOTS IV, or ROOTS V, except for
options you have chosen. If you want to use the Family Gathering or ROOTS library files, be sure to 
using that program.

GEDCOM Export
Except for additional export options provided in ROOTS IV and ROOTS V, GEDCOM files created by e
program will be identical.

Multimedia
ROOTS IV does not support audio recordings, OLE, or slide shows. Digitized images stored by eithe
gram are compatible. Audio and OLE data stored by Ultimate Family Tree is hidden in ROOTS IV.

Note In Ultimate Family Tree, if you open a ROOTS IV project where the Image Library has no
been accessed, the Open Dialog box will ask for the location of the Image Library. Access the I
Library in Ultimate Family Tree to make full use of the multimedia features available in Ultimate
Family Tree. In the Open Dialog box, change to the UFT\IMAGES directory, select 
V_PHBOOK.DBF, and choose Open. If you prefer to access the Image Library in ROOTS IV, ch
to the ROOTS4\IMAGES directory, select X_PHBOOK.DBF, and choose Open.

resides street address

resided street address

employment occupation

emigration point of origin

immigration destination

baptism religion

LDS events temple code

Event Detail
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Source Types
Source type editing is not supported in Ultimate Family Tree. However, changes and additions made
source types in ROOTS IV and ROOTS V are accepted by Ultimate Family Tree.

Citations and Sure Levels
Sure levels from ROOTS IV and ROOTS V or imported from a GEDCOM or ROOTS III file are hidden
Ultimate Family Tree. New citations added in Ultimate Family Tree are assigned a sure level of 1. Cit
added to Ultimate Family Tree events are the same as the those in the ROOTS IV and ROOTS V ove
event citation field. Citations created in ROOTS IV and ROOTS V that are hidden in Ultimate Family T
are included in Ultimate Family Tree reports.

Free-Form Text Indexing, Footnotes, and Citations
Ultimate Family Tree does not directly support index and footnote entry in free-form text. Citations ar
supported in Ultimate Family Tree free-form text, although citations created using ROOTS IV and 
ROOTS V are used and processed.

Notes for ROOTS III Users

Converting ROOTS III Text Files
ROOTS III text files are converted to Ultimate Family Tree text files as follows. In the following list, bb rep-
resents the first two letters of the ROOTS III basefile name and nnnnn represents the record number of the
individual to whom the text is attached.

• bbRnnnnn.TXT — Converts as biography text in the Individual Text window of the Individual Reco
If you also have a #E.TXT file, this file is appended to it. Files of this type print as text in the Ge
ogy reports.

• bbRnnnnn.SRC — Converts as footnote text in the Individual Text window of the Individual Recor
Files of this type print as footnotes in the Genealogy reports and as text on the Family Group S

• bbEnnnnn.TXT — Converts as biography text in the Individual Text window of the Individual Reco
Files of this type print as text in the Genealogy reports.

• bbFnnnnn.TXT — Converts as research notes in the Individual Text window of the Individual Rec
Files of this type print as text in the Family Group Sheets.

• [ref].TXT — Converts as biography text in the Individual Text window of the Individual Record. If y
also have a #R.TXT file, this file is appended to it. Files of this type print as text in the Genealog
reports. [ref] is the contents of the ROOTS III Individual Edit reference field. It is used primarily 
ROOTS II to link text files.
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• [ref].SRC — Converts as footnote text in the Individual Text window of the Individual Record. File
this type print as footnotes in the Genealogy reports and as text on Family Group Sheets. If you
have a #F.TXT file, this file is appended to it.

Converting Footnotes from ROOTS III to Ultimate Family Tree
Major Footnotes in ROOTS III are converted into the Ultimate Family Tree Source Library using the 
ROOTS III source type. If there is an #R.SRC file attached to a Major Footnote, it is placed in the ROO
source type note field in Ultimate Family Tree.

Text on the Detail and Record footnote lines of each record in ROOTS III is converted to Free No
the Evidence window.

The Major Footnote is listed in the Source List by the Abbreviation 1 name, and the text is listed
Free Note. Any text preceding or following a Major Footnote becomes a separate Free Note. If you ha
Major Footnotes with text attached, two Free Notes are created. If you did not use the Abbreviation fi
the ROOTS III Major Footnote, Ultimate Family Tree enters R3 import #nnnnnnnn in the Abbreviation 1 
field instead. Use the Source Record window to replace R3 import #nnnnnnnn with a unique abbreviation for 
the source.

What to Check After Converting a ROOTS III .EDB File
1. To take advantage of the longer name fields available in Ultimate Family Tree, or add aliases o

gious names, press F2 to open the Individual List and double-click the left mouse button on any
that you’d like to edit. The Individual Record for that individual opens. Enter long names, comm
names, aliases, and religious names in the Miscellaneous window (choose the More button, an
Miscellaneous).

2. Edit place names that appear next to events on the Individual Record to remove any unnecess
mas that ROOTS III may have required. Edit places from the Place field on the Individual Recor
Events window. See “Did You Know?” on page 23 and “Combining Places” on page 192 for mor
information.

3. Choose View, and then Source List to check for ROOTS III type sources and those that did not h
abbreviation in ROOTS III. Those without abbreviations are shown as R3 import #nnnnnnnn in the 
Abbreviation field. Edit the sources to take advantage of the source templates provided in Ultim
Family Tree. Double-click the left mouse button on the name of any source you’d like to edit to o
the Source Record window for that source.

4. Review any text in the Ultimate Family Tree text windows and edit, move, or format if needed.
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Where to Find ROOTS III Data in Ultimate Family Tree

ROOTS III Ultimate Family Tree

Individual Record Individual Record

Record Number Record Number

Name Name

Sex Sex

Parent Code N/A

Birth Code Birth, Miscellaneous window

Ancestor Interest Ancestor Interest, Miscellaneous window

Descendant Interest Descendant Interest, Miscellaneous window

Occupation Employment event

Events (lines 1–6)* Appear as separate events

Event Date Event Date field

Event Sure Level Hidden**

Event Place Event Place field

Event Detail Footnote Event Evidence window

Flags Flags, Miscellaneous window

Father’s Name Father field

Mother’s Name Mother field

Revision Date Last Edit Date, Miscellaneous window

Record Footnote Individual Evidence window

#R.TXT Files Individual Text, Biography

#R.SRC File sIndividual Text, Footnote

#F.TXT Files Individual Text, Research

@.TXT Files Individual Text, Biography

@.SRC Files Individual Text, Footnote

Marriage Record Individual Record

Record Number N/A

Husband’s Name Spouse, Marriage event

Wife’s Name Spouse, Marriage event

Event Type* Events
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* User defined events transfer with #R3 before the event name. These events should be deleted and reentered using U
mate Family Tree events (or a new event type you create) before they will print or export via GEDCOM. See “Importing
Unrecognized Events” on page 180.

** Hidden means converted by Ultimate Family Tree and present in the project but not used by Ultimate Family Tree.

Event Date Event Date

Event Sure Level N/A

Event Place Event Place

Event Detail Footnote Event Evidence window

Record Footnote Event Evidence window

Revision Date N/A

Marriage Flags Hidden

Major Footnotes ROOTS III Type Source

Record Number N/A

Title Title component

Reference Reference component

Library Call Number Call number component

Abbreviation Abbreviation 1 field

Publisher Info Publisher component

Author Author component

Repository Repository component

ROOTS III Ultimate Family Tree
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IMPORTANT—READ CAREFULLY BEFORE USING THIS PRODUCT

LICENSE AGREEMENT AND LIMITED WARRANTY

BY USING THE SOFTWARE INCLUDED WITH THIS AGREEMENT (“PROGRAM”) YOU ACCEPT THE TERMS OF THIS LICENSE WITH PAL
LADIUM INTERACTIVE™ INC.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,  AND YOU ARE ALSO THE ORIGINAL 
PURCHASER OF THIS PROGRAM LICENSE (“ORIGINAL PURCHASER”), PROMPTLY RETURN THE SOFTWARE TOGETHER WITH ALL 
ACCOMPANYING ITEMS TO YOUR DEALER FOR A FULL REFUND.

LIMITED USE LICENSE.  Palladium Interactive and its suppliers grant you the right to use one copy of the Program for your personal use only.
rights not expressly granted are reserved by Palladium Interactive or its suppliers.  You must treat the Program and associated materials and any elements 
thereof like any other copyrighted material (e.g., a book or musical recording).  This Agreement is governed by the internal substantive laws of the State of 
California.

YOU MAY NOT:

• Use the program, or permit use of the program, on more than one computer, computer terminal, or workstation at the same time.

• Make copies of the materials accompanying the Program, or make copies of the Program or any part thereof.

• Copy the Program onto a hard drive or other device and you must run the Program from the CD-ROM (although the Program itself may copy a 
portion of the Program onto your hard drive during installation in order to run more efficiently).

• Use the Program, or permit use of the Program, in a network or other multi-user arrangement or on an electronic bulletin board system or other 
remote access arrangement.

• Rent, lease, license or otherwise transfer this Program without the express written consent of Palladium Interactive except that you may transfer 
the complete Program copy and accompanying materials on a permanent basis, provided that no copies are retained and the recipient agrees to the 
terms of this Agreement.  

• Reverse engineer, decompile, disassemble, or create derivative works of, the Program.

LIMITED WARRANTY. Palladium Interactive warrants to the Original Purchaser only, that the Program shall perform substantially in accordanc
the accompanying written materials for ninety (90) days from the date of purchase.

EXCLUSIVE REMEDY.   The original Purchaser’s exclusive remedy for the breach of this license shall be, at Palladium Interactive’s option, eithe(a) the 
repair or replacement of the Program that does not meet Palladium Interactive’s Limited Warranty and which is returned to Palladium Interactive with a 
copy of your receipt; or (b) a refund of the price, if any, which you paid for the Program and associated materials.  This Limited Warranty is void if the fail-
ure of the Program has resulted form accident, abuse, misapplication, or use of the Program with incompatible hardware.

NO OTHER WARRANTIES. PALLADIUM INTERACTIVE AND ITS SUPPLIERS, IF ANY, DISCLAIM ALL WARRANTIES WITH RESPECT TO 
THE PROGRAM AND ACCOMPANYING MATERIALS, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED 
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, AND FITNESS FOR A PARTICULAR PURPOSE.
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  DEPENDING UPON WHERE YOU LIVE, YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE/COUNTRY TO STATE/COUNTRY.

LIMITATIONS ON DAMAGES.  IN NO EVENT SHALL PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, BE LIABLE FOR ANY CON-
SEQUENTIAL OR INCIDENTAL DAMAGES WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM OR PRO
GRAM PACKAGE, EVEN IF PALLADIUM INTERACTIVE OR ITS SUPPLIERS, IF ANY, HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. PALLADIUM INTERACTIVE’S LIABILITY SHALL NOT EXCEED THE ACTUAL PRICE PAID FOR THE LICENSE TO USE 
THE PROGRAM.  BECAUSE SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSE-
QUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

US. GOVERNMENT RESTRICTED RIGHTS. The Program and documentation are provided with restricted rights.  Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CF 52.227-19, as applicable.  The Contractor/
Manufacturer is Palladium Interactive, Inc., 900 Larkspur Landing Circle, Suite 295, Larkspur, CA 94939.

SAVE THIS LICENSE FOR FUTURE REFERENCE
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UFT Supplement: Version 1.1
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Introduction
Ultimate Family Tree Version 1.1 contains exciting new features to assist you in presenting the inform
you have gathered on your family. The new features include:

• Ultimate Family Tree Editor (FGE) — Use this powerful new What-You-See-Is-What-You-Get 
(WYSIWYG) word processing program for Ultimate Family Tree charts and reports.

• Images in reports — Include preferred images in Family Journal reports sent to FGE or another w
processing program to produce beautiful books complete with pictures.

• Direct access to your word processor — Start FGE or your favorite word processing program direct
from Ultimate Family Tree.

• Instant Web Page Box Chart — Create multigeneration Descendant Box Charts for the World Wid
Web, including an Indented Descendant Chart, a Family Tree style Box Chart, and an index.

• Multiple Web page capability — Publish multiple Web pages on Palladium Interactive’s Ultimate 
Family Tree web site.

• Web page privacy — Protect the privacy of living family members included in your Instant Web pa
with this new option.

This manual is a supplement to the Ultimate Family Tree User’s Guide. It contains detailed informa-
tion about the new features in Ultimate Family Tree Version 1.1.
2 2 7
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Ultimate Family Tree Editor
Ultimate Family Tree Editor (FGE) is a powerful Windows word processor for many reports created w
Ultimate Family Tree. In WYSIWIG format, reports such as the Family Journal can be viewed, edited
enhanced, and printed with FGE. FGE also preserves end notes and individual index information from
mate Family Tree, automatically creating separate sections for each.

FGE can be used directly from Ultimate Family Tree, or it can be used as a stand-alone word p
ing program. The reports created in Ultimate Family Tree can be saved for later editing and printing. S
reports can be merged into a single document to create a comprehensive family history book comple
table of contents, end notes, and index.

Note FGE, the internal Ultimate Family Tree report writer, or an external word processing prog
can all be used to create and print reports. While the internal report writer creates excellent rep
FGE permits you to edit and modify your work before printing. It also provides a way to add and
tion images and OLE objects. Menu selections for reports that cannot be edited with FGE or an
nal word processor are dimmed.

Features
FGE provides many of the functions of a full-featured word processing program. Documents created
editor are automatically saved in Rich Text Format (RTF) which can be exported to most popular wor
cessing programs for further editing. The features of FGE include the following:

• Character formatting and styles — The editor allows for multiple fonts and point sizes within a doc
ment. Character styles include bold, underline, and italic.

• Paragraph formatting — Paragraphs can be left, right, or center justified. Hanging indents and do
spacing are additional options.

• Tab support — Left, right, center, and decimal tab positions are available.

• Embedded pictures — Pictures can be imported from a disk file or from the Windows clipboard. T
editor supports the standard Windows bitmap (BMP) and clip art (WMF) formats. Drag-and-drop
also be used to move BMP images into a document.

• Cut and Paste — Cut and Paste to the Windows clipboard is supported to and from other applica
Text formatting is preserved when you move text to or from another word processing application
the clipboard.

• Editing — Editing options include text selection, editing, formatting, and search and replace.

• Multiple documents — A number of documents can be open simultaneously in FGE. The docume
windows can be tiled or cascaded.

• Footnotes — Footnotes can be added and edited. Footnotes are numbered sequentially and app
the end of the document as end notes.
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• Index — Index entries for individuals can be added and edited. A two-column index appears at th
of the document after the end notes.

• Headers and footers — Headers and footers can be added and edited. Page numbering is autom

Desktop Overview
This overview will introduce you to FGE’s user interface.

Menu Bar — The Menu Bar contains a list of menu options extending across the top of the main
window. It provides easy access to all aspects of FGE.

To view a menu, click once on its name. The menu appears under the name. You can also use 
strokes to display menus using one of two techniques:

• Press the Alt key followed by the underlined letter in the menu name.

• Press the Alt key to activate the menu bar and then use the right or left arrow keys to move acro
bar to the name you want. Press the down arrow key to open the menu.

Toolbars — The toolbars contain icons representing the tools available in FGE. From the View m
check Toolbar to view the main toolbar. You can also check Font Toolbar to view that selection.

Status Bar — FGE uses the status bar, located at the bottom of the FGE window, to display mes
information prompts and status information. For example, a short message in the status bar explains
pose of the menu name or command you have selected. To activate the Status Bar, check its name i
View menu.

The following list shows sample information that can appear in the status bar as you are workin
document:

• Pg 1 Page 1 of the document is currently displayed.

• Ln 15 The cursor lies in the fifteenth line of the current page.

Figure 1: Family Gathering Editor Desktop
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• Col 29 There are 29 characters between the cursor and the left margin.

• INS Characters typed will be inserted.

• OVR Characters typed will overwrite existing characters.

Ruler — You can specify formatting features such as margins and tab settings by using the rule
access the ruler, choose the Ruler command from the View menu. The ruler appears above the docu
window.

Opening an Existing Document
The bottom of the File menu displays a list of recently used documents. To open a recently used doc
from the File menu, click the name of the document you want. If the name is not displayed in this sho
proceed as follows:

1. From the File menu, choose Open.

2. In the File Name box, type the name of the document you want to open or select it from the list

Note If you do not see the name of the file you want, select a new drive or directory, or select 
ferent type of file from the List Files of Type drop-down list. FGE can use Rich Text Format files
ing the extension .RTF, or plain text files, usually having the extension .TXT.

3. Click OK.

Opening Multiple Documents
To compare your work, you can open several documents simultaneously, each in a separate docume
dow. To open multiple documents, leave the current document open and follow the steps above for o
an existing document.

You can view these documents in various ways. From the Window menu, choose one of the foll
commands:

• Cascade — Causes the windows to overlap so that the title bar for each document is visible.

• Tile — Arranges the open windows in smaller sizes to fit next to each other.

• Arrange Icons — If you have minimized several documents to icons, these icons will be arranged
along the lower edge of the FGE desktop.

Changing the Size of a Document Window
You can change the size and position of a document window so you can view the contents of two or 
documents simultaneously.

• Maximizing a document — To enlarge a document window to its maximum size, click the Control-
menu box on the Document Title Bar and choose Maximize or click the Maximize button in the u
right corner of the document window. If the document has been minimized to an icon, click once
the icon to activate the Control menu and choose Maximize, or double-click the icon to maximiz
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• Minimizing a document — Click once on the Control-menu box to the left of the Menu bar (if the d
ument is maximized) to open the Control menu for the active document. Choose Minimize to re
the document to an icon. Another method is to choose the Minimize button in the upper-right cor
the document window.

Setting up Ultimate Family Tree to Use Ultimate Family Tree Editor
Ultimate Family Tree can preview and print reports directly or through an external word processing p
gram. Using the Ultimate Family Tree Print Setup window, you can designate FGE, Microsoft Word fo
Windows, or another word processor as your primary word processing application.

To designate which word processor you want to use:

1. Choose Print Setup from the Ultimate Family Tree File menu.

2. Check the Print to File box.

3. Select the Rich Text Format (RTF) radio button in File Contents.

4. Check the Launch Editor box in the Editor (RTF) Options group.

Figure 2: Control-Menu Box and Minimize/Maximize Buttons

Figure 3: Print Setup Window



2 3 2 U L T I M A T E  FA M I L Y  T R E E ED I T O R

he 

it does 
 are dis-

cally 

. Ulti-

 
inser-
g the 

 the 

aste 
 the 

enu, 
e you 
Toolbar, 

o 

 using 
5. Select the word processing application you want to use from the Editor Choice drop-down list. T
three options are Ultimate Family Tree Editor, Microsoft Word, and Other.

6. Click the Browse button to locate the executable file for the word processor you have chosen if 
not appear in the path to the Editor field. The path to the word processor and the executable file
played in the Path to Editor field. For example, \UFT\FTEDITOR.EXE.

Note If you select Ultimate Family Tree Editor, the correct path and file name appear automati
in the Path to Editor field. 

7. Select Include Index if you want to include index codes with the RTF file. 

8. Use the drop-down list to select a footnote style.

9. Choose Close.

FTE opens (launches) automatically after you create a report.

Creating a New Document
To create a new document in FTE, choose New from the File menu. FTE displays a blank document
mate Family Tree gives the new document a temporary name, for example, Profil1. You give the document a 
new name when you save it.

Editing Text
Here is a review of some basic text editing techniques.

Selecting text — Before you can change text, you must select it. To select text, move the mouse
pointer to the beginning of the text you want to select, hold down the left mouse button and drag the 
tion point to the end of the section. You can also select text by holding down the Shift key and pressin
arrow buttons on the keyboard. To select a single word, double-click the word. To select all text, from
Edit menu, choose Select All or press Ctrl+A.

Cut, Copy, and Paste — Once you’ve selected text, you can cut or copy it to the Clipboard and p
it elsewhere in the document. To copy text, select the text and choose Copy from the Edit menu, click
Copy icon on the main Toolbar, or press Ctrl+C. To cut text, select it and choose Cut from the Edit m
click the Cut icon on the main Toolbar, or press Ctrl+X. To paste text, position the insertion point wher
want to place the cut or copied text and choose Paste from the Edit menu, click the Paste icon on the 
or press Ctrl+V.

Undo — If you make a mistake or change your mind while you are working in FTE, choose Und
from the Edit menu or press Ctrl+Z. This will undo your last change.

Setting Fonts
Fonts and point sizes establish the basic look of characters in your document. Fonts can be changed
various methods. 
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Using the Fonts Toolbar — With the Fonts Toolbar, you can change the font or size of the text. Y
can also format the text as bold, italic, underlined, or superscript. Buttons are available for paragraph 
stop alignments. Select the text you wish to format and choose a font and font size from the drop-dow

Using the Format Font window — To use the Format Font window:

1. Select the text you wish to format. 

2. Click the right mouse button, or from the Format menu, choose Font to open the Format Font w

3. Select a font from the list of those available. 

4. Select a style from the Style list. 

5. Select a size from the Size (pts) list. 

6. Select Underline, Superscript, or Hidden in the Effects box. 

7. Click OK to close the window.

Paragraph Formatting
Change the formatting of a paragraph by first selecting the paragraph and then applying the formattin
want. When Ultimate Family Tree formats a report, default settings are automatically applied. Change
by choosing Paragraph from the Format menu.

Paragraph Marks
To display the marks which define the end of a paragraph, select the Paragraph Marks button on the
Toolbar or choose Paragraph Marks from the View menu.

Figure 4: Format Font Window
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Aligning Paragraphs
When you align paragraphs, you specify how you want to position the lines of text.

1. Select the paragraph to be aligned and choose Paragraph from the Format menu.

2. Select the Left, Center, Right, or Justify radio buttons to align the selected paragraph.

3. Click OK to close the window.

Alternatively, you can select the paragraph and choose the appropriate paragraph alignment bu
the Fonts toolbar.

Indenting Paragraphs
When you indent a paragraph, you specify how far from the margin you want the text to print. You ca
choose from three types of paragraph alignment:

• Left — Sets the left margin indent for the selected paragraph.

• Right  — Sets the right margin indent for the selected paragraph.

• Left, First line  — Sets the hanging indent for the first line in a paragraph.

Adjusting Line Spacing within Paragraphs
You can adjust the spacing between the lines in one, several, or all of the paragraphs in your docume

1. Select the paragraph(s) you want to adjust.

2. From the Format window, choose Format Paragraph.

3. Enter a point size in the Before box in the Para Spacing group to increase the spacing before a 
paragraph.

4. Enter a point size in the After box to increase the spacing after a selected paragraph.

Figure 5: Format Paragraph Window
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5. In the Line Spacing box, select one of the following:

• Single — Sets the selected paragraph to single spaces.

• Double — Sets the paragraph to double spaces.

• At Least — A minimum line spacing that FGE can increase.

• Exactly — Fixed line spacing that FGE does not adjust.

Note If you select At Least or Exactly, enter a number in the Points box.

6. Click OK to close the window.

Adjusting Text Flow
You can specify that certain lines or paragraphs be kept together or that certain paragraphs start a p
keep lines together on a page,

1. Select the lines you want to keep together.

2. From the Format menu, choose Paragraph.

3. Under Text Flow, select Keep Together.

4. Click OK to close the window.

To keep paragraphs together on a page,

1. Position the insertion point anywhere in the paragraph you want to keep with the next paragrap

2. From the Format menu, choose Paragraph.

3. Under Text Flow, select Keep with Next.

4. Click OK to close the window.

Tabs
You can insert, remove, or move tab stops using the ruler. To set tab stops,

1. Select the line or paragraphs where you want to add tab stops or position the insertion point in t
where you want the formatting to start.

2. Click a tab stop style from the Tab buttons on the Toolbar or, from the Format menu, choose Ins
Mode and select Left, Center, Decimal, or Right.

Note The Left Tab button is used to left align text, the Center Tab button is used to center text,
the Right Tab button right aligns text. The Decimal Tab button sets a decimal tab.

3. Click the ruler where you want the tab stop to be set.
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To remove tab stops,

1. From the Format menu, choose Tab Clear to open the Clear Tab window.

2. Select the tab position you want to clear and click Clear Tab.

3. Repeat steps 1 and 2 for other tab stops you want to clear.

Note To remove all tab stops from a selected paragraph, choose All Tab Clear from the Format m

Page Breaks
You can insert page breaks anywhere in a document. A page break appears as a solid line in the doc
Physical page breaks are shown as dotted lines and are determined by the size of the page you are p
page break forces the text below the solid line to the next page. To insert a page break, position the i
point where you want the page break, and choose Page Break from the Insert menu. To delete a pag
select the page break you want to delete, and choose Cut from the Edit menu, or press the Delete key
keyboard.

End Notes
When you create a Family Journal or Family Group Sheet, FGE automatically includes its footnotes a
A section titled Notes and References is added after the last page of the body of the report.

Viewing end notes — FGE automatically numbers end notes and places them in the Notes and 
ences section at the end of the current document. Notes are edited in a special window provided for 
pose. To view the End Note window, drag the window split bar, located at the bottom of the documen
window, to the top. You can also choose End Notes from the View menu.

End notes (and the index) can be viewed by scrolling to the bottom of the document. End notes
also be edited and viewed through the End Note window.

Figure 6: Clear Tab Window
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Editing end notes — End notes are viewed and edited through the End Note window. The End N
window can be opened in several ways:

• Double-click the footnote number for the footnote you wish to view. The Footnote window open
showing that end note.

• Drag the End Note window bar up and use the scroll bar to scroll through the end notes.

• Choose End Notes from the View menu.

Inserting end notes

1. Move the insertion point to the position in the text where you wish to insert an end note. The End
window opens.

2. Add any text you want for the new end note.

Deleting end notes — End notes are deleted from the main text window, not the End Note windo

1. From the main text window, select the end note number.

2. Press the delete key to delete the end note.

Renumbering end notes — Choose Renumber End Notes from the Tools Menu to renumber end
notes.

Figure 7: End Notes
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Names of individuals can be included in an index for reports created by FGE. A two-column index lis
individuals by surname and then given name, is automatically generated at the end of the report. Inde
mation can be imported directly from Ultimate Family Tree, plus you can edit and add index informat
any document.

Marking an index entry

1. Place the insertion point after the name you wish to add to the index.

2. Choose Mark Index Entry from the Insert menu. The Add Index Mark window opens.

3. In the Entry field type the surname, and in the Sub-entry field type the given name for the indivi
you are indexing.

4. Click OK.

Editing index marks — Index marks are made visible by choosing Hidden Text from the View me
Index marks are surrounded by curly brace characters {}. A typical index mark appears as follows:

{XE “Kennedy:John Fitzgerald”}

The name of the individual is enclosed in quotation marks. The surname appears first, followed
colon, followed by the given name. The surname and/or given name can be edited as you wish.

Removing an index entry

1. To view index entries, choose Hidden Text from the View menu.

2. Select the index entry you wish to delete and press the delete key.

Note You cannot see or edit index marks unless you activate the Hidden Text option.

Updating the index — To update an index with added or deleted index entries, choose Rebuild In
Notes from the Tools menu.

Headers and Footers
You can edit headers and footers in the same way you edit any other text in your document. All techn
for selecting, inserting, deleting, and overwriting text apply here. You can use the Cut, Copy, and Pas
mands in the headers and footers just as you do in the document. When you edit a header or footer 
section of your document, your changes will also affect any subsequent headers or footers linked to 
document.

Viewing and modifying headers and footers

1. From the View menu, check Header/Footer or choose the View Head/Foot button on the Toolba
header on the first page is displayed allowing you to make changes.

2. From the Edit menu, choose Edit Header/Footer to activate the Edit mode.
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Adding headers

1. Choose Header/Footer from the View menu. 

2. Choose Edit Header/Footer from the Edit menu. 

3. Add the text you want to appear in the header. 

4. To add a page number, place the insertion point in the header or footer where you want the pag
ber to appear and choose Page Number from the Insert menu.

Removing headers and footers

1. Choose Header/Footer from the View menu. 

2. Choose Edit Header from the Edit menu. 

3. Select the text you want to delete from the header or footer. 

4. Press the Delete key.

Removing lines and/or shading in the header or footer

1. Place the insertion point in the space between the lines. 

2. Choose Borders from the Format menu.

3. Change the shading and side options as you wish.

4. Click OK to close the Format Borders and Shading window.

Note A Text Protection Error means FGE cannot edit header text and body text at the same tim
This occurs when you attempt to edit a header or footer when not in the Edit Header/Footer mo
Select Edit Header/Footer in the Edit menu to activate the Edit mode.

Images
Inserting Photos — One of the most exciting features of FGE is the inclusion of photos in a Family Jou
report. Photos can be inserted into a document with or without a frame. When a photo is inserted in a
the frame and photo can be dragged to a new position in the document and any text that would have
covered by the photo will wrap around it. When inserted without a frame, the picture can be moved u
paragraph formatting commands, including left, center or right justify, or by inserting blank lines or sp
in front of the image.

Images can be added to an Ultimate Family Tree document in the following ways:

• Importing an image directly from Ultimate Family Tree.

• Importing from a file containing an image in the BMP or WMF format.

• Importing a BMP image by dragging and dropping.

• Pasting an image from the clipboard.
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Importing Images from Ultimate Family Tree — Pictures that have been designated as preferred 
images can be added automatically to Family Journal reports in Ultimate Family Tree. Specify an imag
wish to include by marking a linked image as the preferred image. See page 164 in the Ultimate Family Tree 
User’s Guide for more information on preferred images. The caption for the image is included in the re
centered below the image. 

Note Preferred images are imported without a frame.

Linking an image to an individual in Ultimate Family Tree

1. Open the Individual Record for the desired individual.

2. Click the More button to open the Individual More window.

3. Click Media to open the Multimedia Link window.

4. Select an existing image from the Multimedia Links list, or link a new image to the individual (se
Ultimate Family Tree User’s Guide for the steps required).

5. Make sure the Preferred Image box is checked to specify that the selected image is the preferre
for this person.

Adding images to the Family Journal report

1. Open the Family Journal report window by choosing Family Journal from the Reports menu.

2. Check the Parent Images box to have preferred images included for individuals who are parent

3. Check the Child Images box to have preferred images included for individuals who are children

Note If both Parent Images and Child Images are checked, the same image will appear in two 
in the report.

Importing an Image from a File — Images can be imported into FGE from a file. The image file 
must be in the standard Windows bitmap (BMP) or clip art (WMF) format.

1. Move the insertion point to the location in the document where you wish to insert the picture.

2. Choose Picture from the Insert menu to open the File Open window.

3. Locate the BMP image you wish to insert and choose OK.

Inserting a Picture from a File into a Frame

1. Move the insertion point to a line where you want to insert the photo.

2. From the Insert menu, choose Frame. A rectangular frame appears.

3. Select the frame by clicking the mouse anywhere on the frame. Make certain the sizing handles
frame are displayed.

4. From the Insert menu, choose Picture. The File Open dialog box appears.

5. Select an image to be inserted and click OK. 
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Note Only image files having the bitmap (.BMP) or clip art (.WMF) format can be inserted. Pho
that are inserted without a frame will displace any text that is covered by the photo. This photo c
positioned by selecting the photo and clicking the left, center or right justification push buttons.

Importing an image by copying and pasting — Images in any format compatible with a paint or 
image editing program can be copied to the Windows clipboard and pasted into a FGE document. On
image has been copied to the clipboard, follow the steps below to paste it into the document:

1. Move the insertion point to the location in the document where you wish the image to be inserte

2. Choose Paste Special from the Edit menu.

3. Choose Bitmap Image Object from the Paste Special window.

Importing an image by dragging and dropping — Images can be imported into FGE by dragging
the image name from a directory or file list to the opened document in FGE. The image will be located
document where it is dropped. The image file must be in the standard Windows bitmap (BMP).

Resizing an image

1. Select the image you wish to resize by clicking on the image. Four sizing handles are displayed
image frame.

2. Drag the handle you wish to change to a new position.

Moving an image in a frame

1. Select the image you wish to move.

2. Move the mouse pointer to a position just outside the frame. The pointer changes to a cross ha

3. Drag the image to its new location.

Changing the borders of a frame

1. Select the frame.

2. From the Format menu, choose Borders to open the Format Borders and Shading window.

3. Select the border options you want.

Figure 8: Inserting a Picture Frame
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Removing an image from a document

1. Click the image you want to remove to select it.

2. Press the Delete key on your keyboard.

Objects
Windows objects such as sound clips or video clips can be inserted in FGE documents. Once an obj
been inserted, it can be activated by double-clicking the object’s icon.

Inserting an object

1. Move the insertion point to the location in FGE document where you wish the object to appear.

2. Choose Object from the Insert menu.

3. Select the object type from the Object Type list you wish to use, such as Wave Sound. The obje
server opens, Sound Recorder for example.

4. Set up the object you wish to insert.

5. Close the object server window and return to FGE. The object is inserted at the insertion point.

Inserting a rectangle — Objects including rectangles, text boxes, and lines, can be inserted in a 
document.

1. Move the insertion point to a location in the document where you wish to draw a rectangle.

2. From the Insert menu, choose Draw Obj and then Rectangle.

3. You can select the rectangle and drag the sizing handles on any side to change the size of the r

Inserting a text box — A text box provides a way to format text within a sizable box such as a si
bar. The box can be moved to any location within the document.

1. Move the insertion point

2. From the Insert menu, choose Draw Obj and then Text Box.

Figure 9: Text Box 
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3. Select the text box and drag the sizing handles on any side to change the size of the text box.

Note Be careful where you choose to insert a text box, as it is not a frame. Underlying text wil
wrap around the box.

Inserting a line

1. Move the insertion point to a location in the document where you want to draw a line.

2. From the Insert menu, choose Draw Obj and then Line.

3. Drag the line to any location in the document, or select the line and drag the anchor at either en
change its position.

Printing Documents
Before you can print, you must have installed a printer through the Windows Control Panel. Refer to 
Windows manual for instructions on installing a printer.

Using the Page Setup window — To select various print options such as margins, paper size and
entation, use the Page Setup window.

1. From the File menu, choose Page Setup.

2. Select the Paper Size from the drop-down list.

3. Select Portrait or Landscape to select how the text will print on the page. A sample page on the
Setup window changes according to your selection.

4. To set margins, enter the size, in inches, in the appropriate field.

Note Some printers (such as the HP LaserJet series) will not print all the way to the outer edg
the page.

5. Click OK to close the window and save changes.

Using Print Preview — Print Preview shows how a report will appear when printed. From the Fil
menu, choose Print Preview or choose the Print Preview button on the Toolbar to open Print Preview
activate the Print Preview Toolbar. All page elements that appear within the printable area of the pag
displayed in Print Preview.

Figure 10: Print Preview Toolbar
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The following options are available in Print Preview:

• A zoom list to change the zoom factor for the view.

• An option to view one or two pages at a time. With two-page display, adjacent pages are shown
by-side. Use the scroll bars to move to adjacent pages. 

• Buttons to move through the report to view the first or last page, and to move ahead or back on

• A Print button to print selected text or the entire file.

• A Close button to leave Print Preview mode.

Saving Documents
FGE documents can be saved for future use. Use the Save As dialog to save the current document w
ferent name. Documents are saved in Rich Text Format as supported by Microsoft and many other s
publishers. FGE documents work best with Microsoft’s Word for Windows.

1. From the File menu, choose Save As.

2. A Save As dialog box opens.

3. Specify a target directory and a file name.

4. Click OK.

Ultimate Family Tree Editor as a Stand-Alone Program
FGE can be used as a stand-alone program or from within Ultimate Family Tree. To start FGE as a s
alone program, choose one of the following options:

• Double-click the FGE icon in the Ultimate Family Tree program group. 

• Type \UFT\FTEDITOR.EXE in the Run window. 

• Choose Editor from the Utilities menu in Ultimate Family Tree.

Note If you have chosen Microsoft Word for Windows or another word processor as your prima
word processing application in Print Setup, it will be started when you choose Editor from the Ut
menu.

Descendant Box Chart Instant Web Page
Ultimate Family Tree can create Instant Web Page family histories suitable for publishing on the World
Web (WWW or Web). The Descendant Box Chart report and Modified Register Family Journal report
available as Instant Web Pages. This section gives instructions on creating a Box Chart Instant Web 
See page 138 in the Ultimate Family Tree User’s Guide for instruction on preparing a Family Journal Instan
Web Page.
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Box Chart Instant Web Page Tutorial
The following tutorial contains the steps to create a Box Chart Instant Web Page.

1. From the Online menu, choose Instant Web Page.

2. In the Instant Web Page window, click Box Chart.

3. Click the Options button to open the Instant Web Page Options window. 

4. Select any options as described below. Options not available for the Box Chart Web Page are d

• Project Information — Include information from the Project Information window in your web page

• Link to Palladium Interactive — When checked, includes a link on the family history that connects
the Palladium home page. Visitors can find out more about genealogy, the Ultimate Family Tree
gram and Palladium Interactive.

• Left Align/Center — Controls placement of section titles. Not all browsers support centering. Som
simply ignore it.

• Single File — Creates one large family history file. Do not select this option if creating a web pag
uploading to Palladium Interactive.

• Single directory — Specifies a single directory when single file is not checked. Do not select this
option if creating a web page for uploading to Palladium Interactive.

• Files Per directory — Specifies the number of files you want in each subdirectory. Do not enter a 
ber larger than 500.

• Email Address — Provides your email address. When this field is left blank, your email address i
included in the Instant Web Page.

5. Click OK.

6. Click the Graphics button to open the Instant Web Page Graphics window. 

7. Select any field and click Browse to find an existing graphics file, or type the names of the graph
in the appropriate field. Graphic options not available for the Box Chart Web Page are dim.

8. Select .GIF files for each option you want to use and click OK.

9. Enter a GEDCOM or audio file in the appropriate field for inclusion in the Instant Web Page.

10. Select any field with a graphic entered and click Preview to view the graphic. Click OK to return 
Graphics window.

You can now generate an Instant Web Page from an existing chart or from a new chart. If you h
already created an Instant Web Page Box Chart, select the chart name, click Existing and skip to ste

1. Choose New to create a new chart.

2. Specify the starting individual for your report. Press F10 to open the Find window.
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3. Enter a name for the chart (up to 8 characters) in the Chart Name field.

4. Enter a title for the Chart in the Chart Title field.

5. Select Birth/Death Dates to include birth and death years in the report.

6. Select Hide Living Info to suppress information about living family members. Ultimate Family Tr
determines individuals who are still alive by checking the Living field on the Individual Record fo
(Y)es. The names of living individuals and the connections to their families remain intact, howev
birth and death years will not be included. The notation (still alive) prints below the name.

Note In preparing your Web page, be sensitive to the wishes of other family members who ma
want certain information to be placed on the Web. Ultimate Family Tree’s Web Page Privacy opt
(Hide Living Info) is designed to protect the privacy of living family members on your Instant We
pages.

7. Specify the generation limit for the report (up to 16 generations) in the Generation Limit field.

8. If you want to limit the report to those individuals in the Grouping list, choose Use List in the Gr
ing box. See pages 78–80 in the Ultimate Family Tree User’s Guide for information on Searches and 
Grouping.

9. Click OK. The chart is generated and opens.

10. With the selected chart open, choose Generate on the menu bar. A Save Web Page As window

11. Select from the existing list, or enter a name for the Instant Web Page. Ultimate Family Tree cre
subdirectory with the name you have chosen. The main web page file, index.htm, is saved in the subdi-
rectory you have specified.

12. Close the Chart window by clicking on the Close box in the upper right corner of the Chart wind
and choose Close.

13. Choose Close to close the Descendant Box Chart Web Page window.

Editing the Contents of a Box
See pages 111–112 in the Ultimate Family Tree User’s Guide for information on editing names, dates, and
places in a Box Chart.

Deleting a Descendant Box Chart Web Page
1. From the Online menu, choose Instant Web Page.

2. In the Instant Web Page window, click Box Chart.

3. Select the chart to delete and choose Selected in the Delete Chart group or choose All to delet
charts.

4. Click Close to close the Descendant Box Chart Web Page window.
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Previewing an Instant Web Page
1. From the Online Menu, choose Preview Instant Web Page or click the Preview Web Page button

Toolbar.

2. Select the Web Page you want to view.

3. Click OK to view the Web Page. The browser you have set up to work with Ultimate Family Tree o

4. After viewing the Web Page, exit the browser to return to Ultimate Family Tree.

5. Click Close in the Preview Instant Web Page window.

Going Online from Ultimate Family Tree
If you have a manual dialer, you must take certain steps to ensure the smooth operation of the Ultima
ily Tree online functions.

Make sure that your browser is not running before you click the Go Online button or choose Conne
to Palladiumnet from the Online menu. The Go Online button will start your browser automatically. Ustask 
switching to switch between applications. Do not click Go Online to return to your already running bro

Note Task switching is a method of changing between Windows applications that are running. 
Alt-Tab to switch between programs. In Windows 95 you can also use the taskbar to switch bet
applications.

When using a manual dialer, after you click the Go Online button or choose Connect to Palladiu
from the Online menu, Ultimate Family Tree will display a message reminding you to manually conne
the Internet. Switch to the Program Manager and run your dialer. After dialing up, activate the ADMIN
gram by task switching. The reminder message should reappear. Click OK.

Whether you dialed manually or connected through a network, Ultimate Family Tree will now start
browser and take you to the Ultimate Family Tree Web Site, available only to Ultimate Family Tree own

To go online from Ultimate Family Tree, follow these steps:

1. Quit your browser if it is running.

2. Click the Go Online button or select Connect to Palladiumnet from the Online menu.

3. Dial your Internet service provider (ISP), manually if necessary.

Note The Ultimate Family Tree Web Page has a proprietary Members Only section filled with e
ing genealogical resources. To access the Members Only section of the Ultimate Family Tree W
Page you must go online from Ultimate Family Tree.

When you quit your browser, Ultimate Family Tree will display a reminder that you may close yo
Internet connection. However, this is unnecessary if you plan to go online again soon. In any case, cl
to dismiss the reminder.
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Uploading an Instant Web Page
Before you upload your first web pages from Ultimate Family Tree, you must go online and register in
Members Only section. See page 145 in the Ultimate Family Tree manual for instructions on registerin
Palladium and uploading your web page.

After creating a Web Page and registering with Palladium, you can upload the Web page to the
dium Interactive Web site. During this process, Ultimate Family Tree will attempt to connect to the Pa
umnet server and send your Web page. While in progress, do not switch applications. If you want to 
the operation, press Escape.

Note If you are using a manual dialer, Ultimate Family Tree will display a message reminding y
manually connect to the Internet. Switch to the Program Manager and run your dialer. After dialin
activate the PDFTP program by task switching. The reminder message should reappear. Click 

Uploading Multiple Web Pages
You can upload multiple Web pages to the Ultimate Family Tree Web Site. If you upload a Web page 
has the same name as an existing Web page you have previously loaded, the existing Web page will
deleted and replaced by the new page.

Troubleshooting
If you have a slow browser or modem, you may want to disable automatic image loading (found in th
erences of most browsers). The resulting text-only pages will load quickly, and give you the same inf
tion without the accompanying graphics. Some browsers will then allow you to display graphics by cli
on their placeholders. (Consult your browser’s online help or user’s guide.)

Ultimate Family Tree will not open your browser if you change it’s name or location on your har
drive. If you do so, or want to upgrade or switch to a different browser, run the Browser Setup Wizard 
Ultimate Family Tree CD-ROM.

Note From time to time, you will see various dialog boxes informing you about the state of Ultim
Family Tree. You must dismiss these dialogs before returning online.

Ultimate Family Tree Application Notes

Changing Parents
In the course of your research, you may find that you have the wrong parent(s) attached to a child’s r
To change a parent for a person, follow these steps:

1. From the Build menu, choose Individual Record.

2. To find the individual whose parent(s) you want to change, click the Main Name field, and click 
Find button to the right of the Spouse field.
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3. Scroll through the list by pressing the first letter of the given name of the person you want to fin

4. Select the name and click OK.

5. Highlight the entire name of the parent you want to change.

6. Press the Delete key on the keyboard.

7. Choose Save from the File menu to save this record.

Note If you attempt to change the parent before saving the record, you’ll get a message statin
the person’s name was and what it is now. You are asked if this is the same person or a new ind
To avoid confusion, save the record after deleting the wrong parent and before entering the corr
ent name.

8. Enter the correct parent by following the steps on page 29 of the Ultimate Family Tree User’s Guide.

Changing a Spouse in a Marriage Event
In the course of your research, you may find that you have the wrong spouse attached to a marriage
To change a spouse, follow these steps:

1. Open the Individual Record for the person who is correctly connected to the marriage event.

2. Click the numbered button to the left of the marriage event you want to edit.

3. Highlight the incorrect name in the Spouse field and press the Delete key on your keyboard to r
the spouse.

4. Press F9 or click Save in the Events window.

5. Type the correct spouse’s name in the Spouse field. If the spouse is already in your project, ent
tial name (or simply highlight -unknown-) and click the Find button to open the Candidate Individua
list. Highlight the correct name and click OK.

Note If you enter a full name in the Spouse field for an individual that has already been entere
Ultimate Family Tree, a message appears when the Individual Record is being saved stating th
name has been entered already. If it is a different person, click New. If the person is already in t
highlight the name and click List to link the individual properly. If you want to make any changes
click Cancel to return to the Individual Record window.

Printing an Individual List
Follow these steps to print an Individual List report, sorted by surname, with the full name in the first co

1. From the Reports menu, choose Lists, and then Individual.

2. Double-click the left mouse button on all selections (if any) in the Selected list to remove them.

3. Double-click on Surname in the Field List (it should be at the top of the Selected list).

4. Double-click on Name (Short) to move it to the Selected list.
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5. Double-click on any other options in the Field List. Select a smaller font size to allow more colum
print. Click the Insert button to move the selected item in the Field list to the location above the 
lighted item in the Selected list.

6. Choose Skip 1st Column to omit the first column in the Selected list from printing on the report.

Note The surname will print with the given name in the first column. However, the report will b
sorted by surname, not given name. If you want the surname to print first, choose Surname 1st
Page Setup window.
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Abbreviation 1 The first abbreviation used to identify a source. Usually, the name of an author or co
piler is used.

Abbreviation 2 The second abbreviation used to identify a source. The identifier can be a title, or na
and is italicized in printed reports unless italics are not supported by the printer.

Acquire To digitize an image by using a scanner, frame grabber, video digitizer, or other electronic d

Active window The window affected by a current action, such as typing text or viewing a List.

Ahnentafel A German word meaning ancestor table. This report uses a text format rather than the f
tree (pedigree) form.

Ahnentafel number A unique number assigned to each position in a family tree (pedigree) whether o
you have an individual to fill that position. These numbers do not vary from chart to chart. Ahnen
numbers can tell you exactly how a particular ancestor is related to the selected individual.

Ancestral File A compilation of records submitted to the LDS Family History Center by individuals do
genealogical research.

Ancestral Ordered Book The history of an individual back to his or her distant ancestors.

ASCII Stands for American Standard Code for Information Interchange. This standard defines the 
for a character set used for information exchange between computer systems of different manu
ers. ASCII is a common coding standard used in the computer industry.

Backing up Copying data, typically the data on your hard drive, to a floppy disk.

Backup A compressed file used to back up the current project.

BBS (Bulletin Board System) A computer running communications software and connected to a tele
phone line through a modem that can be accessed by remote users

Canon law A code of law in which degrees of consanguinity are defined. In canon law, the degree in
cates the number of steps on a consanguinity chart from one individual to the closest ancestor 
in common by a second individual. This number produces the degree of consanguinity between
individuals.

Cascading menu A menu that opens from a command on another menu. A command that has a cas
menu has a right arrow next to it.

CD-ROM (Compact Disk, Read-only Memory) A data storage medium that uses laser optics rather th
magnetic means to read data. Information can be read from CD-ROM disks, but not recorded on
They are capable of storing an enormous amount of data compared to a traditional floppy disk.
2 5 1
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Check box A small square in a dialog box or window that can be selected or cleared. When the chec
is selected, an X appears in the box. A check box represents an option that you can set.

Citation Detailed information that documents a pedigree, a genealogy, or a statement of fact.

Civil Law A code of law in which degrees of consanguinity are defined. In civil law, as distinct from 
canon law, the degree depends on the number of steps on a consanguinity chart from one indiv
another.

Click To quickly press and release the left mouse button.

Clipboard A temporary storage location used to transfer data between fields, windows, and program

Close box A box found in the upper-left corner of most windows in Windows 3.x. In Windows 95, the
close box is in the upper-right corner. Choosing the close box closes the window. See also Con
menu box.

Collateral Descended from a common ancestor, but through a different line, such as a cousin, aunt,
nephew, etc.

Command A word or phrase, usually found in a menu, that you choose to initiate an action.

Consanguinity A legal description of the distance between two individuals who are related by blood
Consanguinity is defined differently under civil law and canon law.

Control menu box The Control menu box is at the left of the title bar. It opens the Control menu for 
window. This menu contains commands that you can use to manipulate the window.

Copy An Edit menu command that copies selected text to the Clipboard without removing it from th
original location.

Cut An Edit menu command that removes selected text and places it on the Clipboard. See also Pa

Descendant Ordered Book A type of book that singles out an ancestor and traces his or her children
grandchildren, and all other documented descendants to the present day.

Desktop The working area on the computer screen in which windows and other items appear.

Dialog box A window that requests information. A Dialog box is a stepping stone to initiating an acti

Digitized image A photo or picture that has been converted into an electronic (digital) format.

Direct Media Media items that are digitized and stored on your hard disk. The three types of direct m
are images, audio, and OLE.

Directory A collection of files and other directories (called subdirectories) stored under a common n
on a disk.

Double-click To rapidly press and release a mouse button twice without moving the mouse. Double
ing selects an object and carries out an action.

Double dating If you encounter dates prior to 1752, you will find that a double year might be listed, 
as 1725/26. The explanation for double dating is an alteration to the calendar. In 1582 it was fou
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the Julian calendar which had begun with Julius Caesar was off by 11 minutes and 14 seconds
according to the cycle of the sun and moon. Beginning when the Julian calendar was first used
BC, the error accumulated yearly, and in 1582 Pope Gregory XIII corrected the discrepancy. Th
endar lost ten days as the Pope decreed that October 4 would be followed by October 15.

Countries accepted the new Gregorian calendar at different times, and England and the Am
colonies did not do so until 1752. By then the discrepancy between the Julian and Gregorian ca
was 11 days. This difference was compounded by the celebration of two New Year’s days by En
and its colonies. The government celebrated New Year’s on March 25, and the masses celebra
holiday on January 1. Depending upon which calendar you used and when you celebrated New
Day, there would be a difference in dating. To satisfy both conventions—until 1752 when the Ja
New Year’s celebration was made official—double dates sometimes were recorded.

You can enter the double date year in the Free-form date field. The double date will print o
reports, such as the Genealogy report. The Structured date will display the second year in the d
date and will print on structured reports such as the Family Group Report.

Drag To move an object on the screen by selecting the item and then holding down the mouse butto
moving the mouse. For example, you can move a window to another location on the screen by 
ging its title bar.

Drop-down list box A single-line dialog box that opens to display a list of choices.

Embed To insert information (an object), that was created in one document, into another document
often the two documents were created with different applications). The embedded object can be
directly from within the second document. To embed, you must be using applications that supp
object linking and embedding.

Emigrant A person who departs from a country to settle elsewhere.

Event GEDCOM The Event GEDCOM Version 1.0 specification has been designed by COMMSOF
provide the most complete transfer of event-oriented genealogical data. It is an extension of Fa
Version 5.3 that incorporates features for transferring events, roles, sources and images. Event
COM is designed to be compatible with lineage-linked systems, while providing extensive suppo
event-oriented systems, such as ROOTS IV. At the current time, only Ultimate Family Tree and V
ROOTS and ROOTS IV programs support Event GEDCOM.

Event text footnote Free-form text that can be used to record explanatory notes or other references
an event that are best reported as a footnote rather than in the body of printed reports.

Evidence Relates to or provides proof of a claim. In genealogy, most evidence comes from records,
ments, and circumstances.

Family GEDCOM This current GEDCOM standard, version 5.5, is a family-focused, lineage-linked 
mat. It uses cross-referenced pointers to connect each child to a family and each family to its ch
It does not provide for the transfer of as much data as Event GEDCOM, version 1.0.

Family Group Sheet A genealogical form summarizing genealogical data for a single family unit. Th
Family Group Sheet contains detailed information about a family unit–husband, wife, and childr
The Family Group Sheet begins with the husband and wife, and then lists their children in birth 
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Field A specific area set aside for a given type of information, for example, a name field, date field, 
field, etc.

Find Key (F10) The F10 key brings up a window designed to find an individual in your project. See 
Function Keys.

Flags A method for keeping track of special information that can be answered true or false. Ten flag
available for each individual in your project. They can be defined differently for each person. Ex
ples of flag situations include needs more research, attendance at a certain college, or cause o

Fonts The complete set of characters including numerals, symbols, and letters in a single design, si
style (for example: 10-point, Times Roman, italic). The character set is used on the computer s
and in printed reports.

Footer Text printed at the bottom of every page for most Ultimate Family Tree reports. It can include
name and address of preparer and the date the report was printed.

Footnote Provides the evidence to support a fact. Footnotes can be either explanatory text or eviden
sented in a more structured format (such as author or title).

Format The way text appears on the pages of a report.

Free-form field Fields that allow you to enter names and dates as they appear in their original sourc
out formatting constraints.

Free-form text Text that does not conform to a structured or rigid format.

Function keys The F keys are generally located on the top or side of the computer keyboard. These
serve to help you use Ultimate Family Tree more efficiently. They assist in data entry and help y
move up or down lists, find people or places, and access context-sensitive help.

GEDCOM A standard to provide for genealogical data exchange between programs. GEDCOM sta
for GEnealogical Data COMmunications. Ultimate Family Tree supports two GEDCOM forms: F
ily and Event.

Group A cluster of related radio buttons or check boxes, located in a window, from which you can m
selections.

Grouping Grouping is a way to generate specialized lists of individuals who fulfill certain criteria. 
These lists can be manipulated or merged in a variety of different ways.

Header Descriptive text printed at the top of every page for most Ultimate Family Tree reports. It ca
include book name and page number.

Highlighted Selected object or text that will be affected by the next command or action. Highlighted
appears in black-on-white (reverse video) on monochrome displays and sometimes in color on 
displays. Highlighted objects might change color or be surrounded by a selection cursor.

Icon A small picture representing various types of applications and files (programs, groups, docum
on the desktop.

Ignore case A search criteria option that instructs Ultimate Family Tree to ignore the case of letters w
executing a search command.
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Image Photographs, movies, videos, digitized images, and any other type of image that might be us
document a family history.

Immigrant A person who comes to a country to take up permanent residence.

Import To convert a non-Ultimate Family Tree file into an Ultimate Family Tree project.

Inactive window Any open window in which you are not currently working.

Index A list of all individuals and marriages in the project with a page number reference to where th
name appears on a chart or report. The index must be collected before can be printed.

International characters Alphabetic characters with diacritical marks commonly found in languages 
such as French, Spanish, or German.

Invert selected Grouping command to exchange everyone in the grouping table for everyone previo
excluded from the grouping table project.

Link, OLE To create a reference in a destination document to an object in a source document. Wh
link an object, you are inserting a visual presentation of the object into the destination documen
When the object changes in the source document, the changes appear in the destination docum

List box Within a dialog box, a box listing available choices–for example, the list of all available files
directory. If all the choices will not fit, the list box has a vertical scroll bar.

List window List windows show information from your project in a table format, using rows and colum

Lock A check box on some windows where you can lock the starting individual in the window. The i
vidual will be in the window when it is next activated.

Long Name The Long Name is a name of up to 65,000 characters for the selected individual. The lo
name is not displayed on screen in Build or View windows, but is used in Family Journal reports.
characters (/) define the surname and curly braces { } define a title.

Maximize button The small box, containing an up arrow, at the right of the title bar. Mouse users ca
click the button to enlarge a window to its maximum size. Keyboard users can use the Maximize
mand on the Control menu.

Media A general term encompassing all types of information from text to sound, but used here to re
specifically to pictures, graphics, animation, sound recordings, and video.

Memory RAM (Random Access Memory). The memory in a computer designed to store data tempo
The data in RAM is lost when you turn off the computer. Permanent data storage is made on flo
hard disks.

Menu A list of commands you can carry out. Menu names appear in the menu bar at the top of the 
mate Family Tree main window.

Menu Bar A horizontal bar containing the names of all the menus at the top of the main window.

Message dialog box Contains information messages, warnings, and critical messages about the ope
of Ultimate Family Tree.
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MIDI files MIDI is an acronym for Musical Instrument Digital Interface, a standard protocol for comm
nication between musical instruments and computers. A MIDI file contains all the information 
required to play a sound by using a MIDI device.

Minimize button The small box containing a down arrow at the right side of the title bar. Mouse user
click the button to reduce a window to an icon. Keyboard users can use the Minimize command 
Control menu.

Modified Register A genealogy format that conforms with the style used in the National Genealogic
Society’s Quarterly. It is sometimes called the Record plan.

Mnemonic characters An alphabetic symbol that allows direct keyboard access to control functions w
preceded by the Alt key. This character is a unique and distinctive letter in the Control name tha
underlined.

Multimedia A combination of various media, such as sound, graphics, animation, and video.

Narrative Voice accompaniment to selected media items (specifically pictures) telling about an indiv
ual, his or her family, experiences, important events and people, and any interesting and signifi
details.

NEHGS New England Historic Genealogical Society, 99-101 Newbury Street, Boston, MA 02116.

NGS National Genealogical Society, 4527 17th Street, North, Arlington, VA 22207-2399.

Object Information such as a picture, chart, text or sound file, that can be linked to or embedded in
another document.

OLE (Object Linking and Embedding) Windows technology to create items in one software program
and place and/or access them in another software program. OLE objects include pictures, text, i
video clips, sound clips, and MIDI files.

Option A selection in a dialog box. An option affects the way in which a command is carried out. Di
boxes have several kinds of options including radio buttons (you can select only one) and check
(you can select as many as you wish).

Parental partner A parents who is not married or does not have a marriage record.

Paste An Edit menu command that moves text from the clipboard into a text file or Text window at th
new cursor location. See also Cut.

Preferred image The selected image that can be displayed from the Media Tree, Pedigree, Family, 
Descendant windows.

Proceed button The command to continue with the chosen action.

Radio button The small round button in a window that acts like the buttons on a car radio. In a grou
related radio buttons, only one can be on at a time.

RAM Random Access Memory. The memory in a computer designed to store data temporarily. The 
RAM is lost when you turn off the computer. Permanent data storage is made on floppy or hard

Record A collection of related data items, for example, an individual record.
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Record Footnote Free-form text that can be entered about an individual to print out as a footnote. No
ommended for formal source citations.

Record plan A genealogy format that conforms with the style used in the National Genealogical Soc
Quarterly. Also called the Modified Register.

Redo Edit menu command that repeats a cut or copy that you make.

Redundant ancestors When there is more than one line from an individual to his or her ancestor, the
ancestor is considered redundant. This normally occurs when cousins marry.

Referenced media Media of every kind that can not be transformed into a digitized format.

Register A genealogy report that conforms with the style used by the New England Historic Genealo
Society.

Replace all Substitutes new text for all text found in a Find search.

Replace and Find Again Substitute new text for text located in a Find search, and then repeat the Fin
Replace commands.

Research note Free-form text that can be entered about past, ongoing, or future research on an indi

Reserved characters A set of characters used by Ultimate Family Tree for internal processing. They 
not available for use in data entry.

Reverse Register The COMMSOFT Reverse Register is a genealogical report format that uses a nu
ing system similar to the Register or Modified Register reports, but follows ancestral rather than
descendant lines.

Rich Text Format (RTF) A standard developed by Microsoft describing a method of encoding forma
text for easy transfer between applications. With the RTF standard, documents composed unde
ent operating systems and with different software applications can be transferred between thos
ating systems and applications. Ultimate Family Tree supports this standard.

Save A File menu command used to save changes made to an active window.

Scanned image An electronic reproduction of a picture or document that is stored in a file on the com
puter. Images can be scanned directly into Ultimate Family Tree. A TWAIN-compatible scanner
required.

Scroll bars The bars at the bottom and right edge of a window whose contents are not entirely visib
Each scroll bar contains a scroll box and two scroll arrows.

Scroll box Contained in scroll bars. Dragging the scroll box up or down displays information in a list
document.

Search Criteria The choices selected in the search routines that tell Ultimate Family Tree what to loo
when searching the project.

Selection cursor The selection cursor shows where you are in a window.
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Shortcut keys The specialized key strokes (a combination of Ctrl or Alt with a letter key) that you pre
carry out a command or action. If a command has a shortcut key, the key combination is listed 
right of the command name on the menu.

Sibling Brother or sister, first-generation relationship with one or both parents the same.

Sort date The date used to establish the order of events and for calculating information such as a p
age at the time of a specific event. Normally it does not appear on reports.

SOUNDEX A code used by the United States Government to index early census records. It tries to
mize spelling variations.

Structured date A date in fixed form (dd mmm yyyy) used on fixed or structured reports such as the
igree and Family Group reports.

Structured fields Fields such as the sort date and structured date, that are used in structured report
as the Pedigree and Family Group reports.

Submitter The individual creating a Tiny-Tafel or GEDCOM file. The word submitter is also used to r
to information about this individual.

Sure level A method, used in ROOTS IV, to indicate the reliability of information included in your fam
history. The sure level can be used to cover all information concerning an individual.

Text box A box located in a window where you type information.

Tiny-Tafel Tiny-Tafel is a shortened variation of an Ahnentafel list. The Tiny-Tafel contains one line 
text for each family line, giving the surname, locations, and the time period represented by that 
line and codes to signify the degree of interest in receiving information concerning the ancestor
descendants of that line.

Title bar The horizontal bar located at the top of a window and containing the title of the window.

TWAIN The software used by scanning devices to provide a consistent interface with other program
TWAIN has become a de facto standard.

Undo An Edit menu command that reverses the last action that you performed on any text within a 
record or file. Undo deletes a new record if the record was not saved.

Unusual dates Unusual or nonstandard dates (for example, Quaker or Jewish dates). In Ultimate Fa
Tree dates that do not fall between the limits of 100 AD to 3000 AD are considered unusual date
mate Family Tree is able to accept dates in all of these categories.

Wildcard A character used to represent one or more different characters. In DOS commands, a qu
mark (?) can be used to substitute for a single unknown character. The asterisk (*) can be used
stitute for more than one consecutive character.

Window A rectangular area on the desktop in which information is entered, selections made, or info
tion viewed.

Window title The title of the window that is found at the top of the window.

Word wrap A feature that moves text from the end of a line to the beginning of the next line as you 
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# number sign 14
* wildcard 67, 71, 81
+ Husbs 58
+ Wives 58
.EDB file, ROOTS III 176, 221
.SQZ extension 218
/ slash 14, 16, 29, 68–69, 80–81, 197
<Ffontname> 213
<FROOTS> 213
? wildcard 67, 71, 81
{ } braces 14, 16, 29, 68–69, 81

 

A

 

abbreviation 41, 227
adding

children 46
events 30
evidence 19, 42
parents 17, 29
places 32
spouses 17

address list 126
adoption 47
Ahnentafel 61, 100, 131, 227
Aldus TIFF (.TIF) 149
alias names 50
Ancestor Interest (AI) 49, 131–134
Ancestor reports 98–100

Ahnentafel 98–100
Family tree (pedigree) 98–99

ancestors, viewing 21
Ancestral file 227
Ancestral-ordered book 93–94
archive project, restoring ROOTS 218
arrow buttons 14
ASCII text file 39, 83, 85
audio (.WAV) file 151–152
Audio Graphic 141
audio

adding 151–157, 159–160
deleting 160
files 150
linking 163–164
playing 161–162, 166

 

B

 

B.C. dates 31
backing up 185, 186
backup, restoring 186–187
ballooon help 14
basic events 30
biographical text 35
birth event, creating 17
birth field 49
births, estimate missing 97
bitmap (.BMP) 149
book outline 93–94
book title 87
border styles 95
box chart 103–113 

 

see also Descendant box chart

 

braces 14, 29, 68–69, 81
break child blocks 122
browser, installation 5–6, 144
Bullet Graphic 140
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calendar
box 130–131
labels 131
report 129–131
text 130–131

candidate individual list 29
candidate place list 35
Canon law 227
CD-ROM drive 149
character map 15, 36
characters

# 32–33
international 36
not to use with RTF 36

check spelling 37–38
check

duplicate record numbers 199–200
rebuild footnotes 199

check window utility 198–199
CHECK.TXT 199
Chicago Manual of Style 98
child button, new 20, 46
child, adding 20, 46–47
children, with unmarried parents 47
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citation 228
citation search 69–70
Cite Your Sources 98
Civil law 228
clock 195
collateral 228
collect index 90
combine individuals feature 191–192
combining places feature 192–193
common name 50
COMMSOFT 23, 182
CompuServe 2, 5–6
configuration 204–205
consanguinity 61, 113, 228
creating

birth event 17
marriage 17, 35
new project 10
new record 16, 28
new source 43–44
footnote 44

cross reference 119

 

D

 

d’Aboville numbering system 102
data repair 199
date

adding 30–32
double dating 31–32
format 195
free-form 31
preferences 24, 195
sort date 31
structured 31
unusual 31

default printer 84
delete button 30
delete

event 189–190
event types 33
individual 189
place 190
project 23, 191
slide show 191
source 190
text 189

Descendant box chart 103–113
chart display 110
creating 104–106
edit colors 109
edit fonts 109
edit graphics 108
editing 111–112
printing 107–108, 113
viewing multiple 112
zooming 111

Descendant Interest (DI) 49, 131–134
Descendant report 100–113

Direct Drop 103
Indented 100–101
Text 101–102

Descendant-ordered book 94
descendants window, view 59–60
desktop display 9

graphics mode 8, 25, 196
Windows colors mode 8, 25, 196

desktop preferences 194–196
diacritical marks 15, 36
digitized image 228
Direct drop descendant report 103
direct media 149–150, 228
double dating 31, 228–229
duplicate person 191
duplicate record numbers, deleting and 

renumbering 199–200

 

E

 

edit and crop 115–116
edit place 32
email address 143
Email Graphic 141
embed 229
embedded notes 96
Encarta 170
End notes report 116–117
error message 208–211
errors

display 210
general 207–209
printing 212–213
slide show 211
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event 30–33
adding 30
creating 17–18
creating new event type 33–34
delete 30
deleting event type 33
type 30
unrecognized 180–181

event button, new 30
event details 18, 33, 210, 218–219
Event GEDCOM, creating 183–184
evidence 40–46

adding 19, 42–43
adding text 19
status box 19, 24

exiting Ultimate Family Tree 202
export GEDCOM 181–184
exporting text 39–40
external text file 39

 

F

 

F10 (Find) 80
Family GEDCOM 229
family group 57–58

report 121–123, 229
viewing 21–22, 57–58

Family History Center, LDS church 184
Family journal report 96–98

Descendant order 97
Family order 97
Reverse Register order 97

family tree 56–57
blank 98–99
chart 98–99
viewing 21, 56–57

Family Tree Maker, importing from 177–178
file list 124
file type, image 162
find, 

 

see also search

 

individual 25, 80–81
key 21, 80–81

flag 49, 230
search 71–72

font
setup 87–89
size 126

footers 107

footnote
compressed 97
converting from ROOTS III 220–221
creating 42–44
customizing 44–45
rebuild 199

formatting text 37, 45
free note 44–45
free-form

date 17, 31
date format 178–179, 195
text 42

Freelance, Lotus 170
frequently asked questions 204–207
FTP address 143
function key 12–14

 

G

 

Gallery report 115
GEDCOM 34, 125, 127–129, 172–184, 230

and ROOTS III import 219
exceptions list report 127–129
exceptions, viewing 200–201
exporting 181–184, 219–220
export options 181–183
Graphic 140
grouping 182
import options 178–180
importing 173–178
tag 34

GEDCOM file
creating 181–184
submitting 184

GEDCOM type
Basic 182
Event 1.0 182–183
Family 5.3 182
ROOTS III 182

generation gauge 60
generation number 101
Go menu 23–24, 81
Go Online 141
Graphic (.GIF) files 141
graphics display 25
graphics format 149, 162
graphics mode 8, 25, 196
Gregorian Calendar 32
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grouping 78–80
GZIP 140

 

H

 

Header Graphic 140
headers 107
Help 2, 19
Henry numbering system 102
Horizontal Rule 141
HTMFILES.TXT 140
HTML files 142

 

I

 

Ibid 117
image 149, 231

adding 151–157
caption 152
deleting 160
description 152
digitized, adding 151–152
digitized, displaying 161
digitized, editing 158–159
digitized, exporting 162
displaying 161
editing 158–159
export 162
Gallery report 115
linking 163–164
preferred 164
quality 195
scanning 152–153
viewing 165–166

immigrant ancestor 49
import GEDCOM 173–178
import options common to GEDCOM and 

ROOTS III 178–180
import ROOTS III 176–177
import unrecognized events 180–181
import Family Tree Maker 177–178
Indented Descendant report 100–101
index

adding individuals and places 120
additions 87
collect 90, 118
deleting page numbers 120
edit 119–120
preview 92
report 117–120

INDEX.HTM 139
individual button, new 28
individual events search 70–71
Individual List report 125
individual record, creating 16–20
Individual Summary report 123
individual summary, view 22–23, 58–59
individual

creating 16, 28–29
finding 25
flags 49
list view 25, 63–64
miscellaneous information 48–50
more 47–53
record 28–33
summary 22–23, 58–59
text 35–36

individuals, combining 191–192
information, adding additional 47–48
Insert Object 153–154
installation 4–7

browser 5–6, 144
troubleshooting 203

Instant Web Page
connecting to Palladium 141
creating 137–145
file organization 139–140
linking files 140–141
previewing 144
registering 145
tutorial 141–144
uploading 145

interest level ranking 49, 132–133
international characters 15, 36
Internet 2, 142
Internet service provider (ISP) 145

 

J

 

Jewish dates 31
Julian Calendar 31

 

K

 

Kennedy sample project 5
key families 11, 194
kinship, view 60–61
Kodak 147, 149
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Lackey, Richard 98
language 50
last edit 49
LDS event 33
linking media 163–165
List reports

GEDCOM exceptions 127–129
individual, marriage, source 125–126
mail 126–127

living field 16, 29
lock button 60–61
long name 49, 231

 

M

 

mail label 49, 51, 127
Mail List report 126–127
mail search 72–73
mailing address 126
marriage, creating 17, 34–35
Marriage List report 125
marriage list, view 64
media 53

delete 160
direct 149
linking 163–164
new 164–165
referenced 148–149
unlinking 165
viewing 165–166

Media Player 170
media search 73
media tree display 62–63
medical history 52
medical search 73–74
menu bar 13
merge options 172–173
merge, projects 172–173
messages 195

error 207–213
Microsoft Explorer 5
Microsoft Object Packager 155–156
MIDI 166, 170, 232
miscellaneous individual information 48–50
miscellaneous search 74–75
Modified Henry numbering system 102
Modified Register 137

Modified Register report 96, 232
more window 19
multimedia library 53, 147–170

previewing 163
multimedia link 53, 163

 

N

 

name
entering 16, 29
field 16
format 87, 196–197
preferences 86–87
view name and record number 62

name search rules 67–68, 81
name.TGZ 140
narrative 63, 159–160
National Genealogical Society 96, 232
nationality 50
Netscape Navigator 5
New England Historic Genealogical Society 96, 232
new spouse button 17, 24, 34
NINDEX.HTM 140
number sign 32–33
numbering systems 102

 

O

 

Object Linking and Embedding (OLE) 150, 153–158, 
166, 170

playing 166
server 153

Object Packager 155, 170
open, existing project 12
other parent window 20, 46

 

P

 

pack utility 197–198
page

layout 87
setup 86–89

page number
deleting 120
editing 120

parent
adding 17, 29
editing 29
unmarried 47
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parental partners 58
paste link 157
paste special 156–157
patent information 117
PC Paintbrush 170
pedigree window and chart 21, 56–57
phone numbers 126
Photo CD 147, 149
photo viewing 57–58, 63
PKUNZIP 218
place

adding 32
combining 192–193
editing 25, 32
removing from an event 32

Portrait report 114–115
performance and graphics 8, 25, 196
performance and hardware speed 204
preferred image 164, 232
preparer information 11, 122
preparer name 122
Previous page icon 141
print

preparing 93
preview 91–93
preview toolbar 93
reports 89–90
setup 84
to file 85
window 90–91

printer codes 85
printer, default 84
printing, basic steps 89–90
project 205–207

backing up 185–187
control file 194, 206
creating 10–12
deleting 23
information 124
information window 11, 193–194
merging 172–173
opening 12
restoring a backup 186–187
splitting 188–189
viewing information 193–194

Project Summary report 124

 

Q

 

Quaker dates 31
quick start tutorial 15–23

 

R

 

rebuild footnotes 199
record number 29, 62
Record plan 233
redundant ancestors 61, 99
reference field 50
referenced media 148–149
Register report 96
reindex utility 198
reinstall, Ultimate Family Tree 6–7
Relationship List report 113
relationship search 75–76, 188
religion 50
research notes 36
researcher field 11, 194
researcher number 122, 194
reserved characters 233
reset Index 91
reset Notes 91
reset TOC 91
resolutions, image and screen 210
restore 33
restore button 30
restoring a backup 186–187
Reverse Register 233
Rich Text Format (RTF) 15, 36, 83, 85–86, 94, 233
ROOTS, using with Ultimate Family Tree 215–223
ROOTS III 74, 176–177, 220–223

import options 178–180
importing from 176–177

ROOTS IV 23, 172, 215–220
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save as
backup 185–186
project 187

scanned image 233
scanning 152–153
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search 66–67
citation 69–70
complex name 69
flags 71–72
grouping 78–80
individual events 70–71
individuals using F10 or Find button 80–81
mail 72–73
media 73
medical 73–74
miscellaneous 74–75
name 67–68
options 66
relationship 75–76
rules 81
SOUNDEX 68
steps for completing 66–67
surname 68–69
text 76
vital statistics 77–78
windows 66–81
windows, using 66

server 142
sex field 16, 29
SHARE 203
short cut keys 13–14
sibling button, new 20
siblings, adding 20, 47
signature 50
skip 1st column 125
slash characters 29, 68, 80–81, 197
slide show 62, 166–170

adding existing 169–170
adding slides 167
and OLE 170
creating 166–168
delete 191
editing 168

social security number 50
sort date 31
sound effects 62
Sound Recorder 159–160
SOUNDEX 68, 113, 234
source 41–43

deleting 46
editing 46
preview 42
record 41

source 
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structured 42
type list 42

source library 41
entering new evidence 43–44

Source List report 125
source list, view 64
SOURCES.HTM 140
Spell check feature 37–38
splitting project 188–189
spouse, adding 17, 34–35
Spry browser (Sprynet), installation of 5–6
start, new project 10–12
starting Ultimate Family Tree 7–8
structured date 31
submitter button 134, 184
system requirements 3
system summary 124

 

T

 

TAR (tape archive) 140
table of contents 90–91, 120–121
template 41
temple code 33
text

adding 35–36
edit 37–40
exporting 39–40
formatting 37
importing 39
opening external file 201
saving external file 201–202
search 76–77
selecting 37
status box 19, 24

text file, external
importing 39
opening 201
saving 201–202

Text report 114
Tiny-Tafel 49, 234
Tiny-Tafel report 131–135
Title page report 95
Title.Graphic 140
titles in names 29
toolbar 14, 196
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troubleshooting 203, 207–213
installation 203
media 211
slide show 211

tutorial 15–26
TWAIN 149, 152, 234

 

U

 

Ultimate Family Tree
getting familiar with 12
installing 4–5
reinstalling 6–7
starting 7–8
using with ROOTS 216–220

undo 24, 28, 46
uninstall Ultimate Family Tree 5
Universal Resource Locator (URL) 138, 142, 145
unmarried parents 47
unrecognized events, importing 180–181
unusual dates 31
utilities 197–200

 

V

 

Video for Windows 170
view

descendants 59
family group 21–22
family tree 21

view 
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individual 58–59
individual list 63–64
individual summary 22–23
kinship 60–61
marriage list 64
media tree 62–63
name 62
photo 63
record number 62
slide show 62
source list 64

Visual ROOTS 4, 6, 172, 215–220
vital statistics search 77–78

 

W

 

wall chart 107
wallpaper 8, 196
Web browser 5
Web browser

installing 6
link 50

Web link 50, 138
Web Page, Instant 137–146
wildcard 67, 71, 81
Windows Character Map 15, 36
Windows colors mode 8, 25, 196
World Wide Web 137
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